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บทที่ 1 

บทนำ 
1.1 ความเป็นมา 

กรมชลประทานมีภารกิจหลักในการพัฒนาแหล่งน้ำ และบริหารจัดการน้ำ  โดยการบริหารจัดการน้ำ
จำเป็นต้องใช้ข้อมูลพื้นฐานซึ่งมีความสำคัญอย่างมาก โดยมีข้อมูลความต้องการน้ำและปริมาณน้ำต้นทุนทีมีอยู่ใน
อ่างเก็บน้ำหรือแหล่งอื่นๆ ซึ่งจะต้องมีความสัมพันธ์กันและสอดคล้องกันตามหลักการบริหารจัดการน้ำ โดยปัจจุบัน
แม่น้ำชีมีความเสี่ยงต่อภัยแล้งและอุทกภัยบ่อยครั้ง อีกทั้งยังมีอาคารชลประทานในลำน้ำหลายแห่ง ทำให้มีความยุ่งยาก
ในการวิเคราะห์ข้อมูลและการวางแผนบริหารจัดการน้ำ อีกท้ังยังมีข้อขัดแย้งเกิดข้ึนได้ง่ายเนื่องจากมีความต้องการ
น ้ ำ ท ั ้ ง ด ้ า น เ ห น ื อ น ้ ำ แ ล ะ ท ้ า ย น ้ ำ  ร ว ม ท ั ้ ง ป ั ญ ห า ข า ด แ ค ล น น ้ ำ ใ น ช ่ ว ง ห น ้ า แ ล้ ง   
หากกรมชลประทานสามารถจัดทำเกณฑ์ความสัมพันธ์การบริหารจัดการภัยแล้ง  ลุ่มน้ำชี (Development of 
drought management criteria in Chi basin) จะ เป ็ นประ โยชน ์ อย่ า งย ิ ่ ง ต ่ อ ง านบร ิห ารจ ั ดการน้ ำ 
ให้มีความถูกต้องและแม่นยำยิ่งขึ้น สามารถจัดสรรน้ำได้ในปริมาณที่เหมาะสมตรงตามความต้องการตามช่วงเวลา
และบรรเทาภัยแล้งในช่วงฤดูน้ำแล้ง ตอบปัญหาภัยแล้งเชิงยุทธศาสตร์ และการลดผลกระทบต่อประชากรในลุ่ม
น้ำทั้งในด้านคุณภาพชีวิตและเศรษฐกิจ หน่วยงานภายใต้สังกัดกรมชลประทาน คือ สำนักงานชลประทานที่ 6 
สำนักงานชลประทานที่ 7 สำนักงานชลประทานที่ 8 และสำนักบริหารจัดการน้ำและอุทกวิทยา เป็นกำลังสำคัญใน
การดำเนินงานบริหารจัดการน้ำร่วมกับการประสานงานเพ่ือการวางแผนจัดสรรน้ำในลำน้ำชี ช่วงฤดูแล้งและฤดูฝน 
ติดตามผลการจัดสรรน้ำและการเพาะปลูกพืช การแก้ไขปัญหาภัยแล้งร่วมกับฝ่ายจัดสรรน้ำ สังกัดส่วนบริหาร
จัดการน้ำ ซึ่งกระบวนการวางแผนและทำงานร่วมกันของทั้งส่วนกลางและส่วนภูมิภาค โดยมีเกณฑ์ความสัมพันธ์
การบริหารจัดการภัยแล้ง ลุ ่มน้ำชี (Development of drought management criteria in Chi basin) เป็น
เครื่องมือและเป็นปัจจัยสำคัญที่ทำให้การดำเนินงานบริหารจัดการน้ำสำเร็จลุล่วงได้ตามวัตถุประสงค์ 

1.2 หลักการและเหตุผล 

กรมชลประทาน ภายใต้กระทรวงเกษตรและสหกรณ์ มีภารกิจในการบริหารจัดการน้ำอย่างบูรณาการให้
เพียงพอ ทั่วถึง และเป็นธรรม รวมไปถึงการป้องกันภัยอันเกิดจากน้ำ จากสถานการณ์ปัจจุบันโลกต้องเผชิญกับ
สภาพภูมิอากาศที่เปลี่ยนแปลงอย่างรวดเร็วและรุนแรง ทำให้เกิดปัญหาภัยแล้งและอุทกภัยขึ้นบ่อยครั้ง  ส่งผลให้
การบริหารจัดการน้ำมีความท้าทายเพิ่มมากข้ึน โดยเฉพาะในพ้ืนที่ลุ่มน้ำชี ที่ได้รับผลกระทบจากสภาพภูมิอากาศที่
เปลี่ยนแปลง (Climate Change) ทำให้เกิดปัญหาอุทกภัยและภัยแล้งอย่างรุนแรง ส่งผลกระทบทั้งในแง่ของ
เศรษฐกิจ สังคม และสิ่งแวดล้อม   

การบริหารจัดการน้ำในลุ่มน้ำชีที่ผ่านมา มีความคาบเกี่ยวกันหลายจังหวัด ทำให้การบริหารจัดการน้ำที่ผ่าน
มาเป ็นไปด ้วยความยากลำบาก เน ื ่องจากในแต ่ละพ ื ้นท ี ่จะให ้ความสำค ัญในการบรรเทาภ ัยแล้ ง  
ในพื้นที่ตัวเองเป็นสำคัญก่อน ทำให้เกิดผลกระทบด้านท้ายน้ำอย่างหลีกเลี่ยงไม่ได้ ทั้งยังมีหน่วยงานที่รับผิดชอบ
หรือมีส่วนได้ส่วนเสียหลากหลายหน่วยงาน ดังนั้น จึงมีความจำเป็นที่จะต้องศึกษาความสัมพันธ์ของปริมาณน้ำ
ต ้ นท ุ น  ปร ิ ม าณความต ้ อ ง ก าร ใช ้ น ้ ำ ต ามพ ื ้ นท ี ่ โ ค ร ง การชลประทานและผ ู ้ ใ ช ้ น ้ ำ ร ายอ ื ่ น  ๆ  
ในพ้ืนที่ลุ่มน้ำชี ให้สอดคล้องกับลักษณะภูมิประเทศและลักษณะกายภาพของอาคารชลประทานในลุ่มน้ำชี โดยใช้
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แบบจำลองศึกษาความสัมพันธ์ของปริมาณน้ำในลำน้ำกับความต้องการใช้น้ำในแต่ละพื้นที่  เพื่อสร้างและกำหนด
เกณฑ ์การระบายน ้ ำผ ่ านอาคารชลประทาน   ในกรณ ีท ี ่ ป ร ิ มาณน ้ ำ ในลำน ้ ำช ี ม ี จ ำนวนจำกั ด  
เพ่ือช่วยลดผลกระทบจากปัญหาภัยแล้งและการขาดแคลนน้ำทั้งในด้านอุปโภค - บริโภค หรือด้านการเกษตรในลุ่ม
น้ำชีทั้งระบบ เพ่ือลดความขัดแย้งในการใช้ทรัพยากรน้ำร่วมกันทั้งพ้ืนที่ต้นน้ำ กลางน้ำ และปลายน้ำ ซึ่งแต่ละช่วง
มีอาคารชลประทานเป็นเครื่องมือในการบริหารจัดการน้ำอยู่แล้ว ส่งผลให้เกิดความมั่นคงด้านน้ำในพื้นที่ลุ่มน้ำชี 

1.3 วัตถุประสงค์ 

1) เพื ่อศึกษาความสัมพันธ์ของปริมาณน้ำในลำน้ำกับความต้องการใช้น้ำเพื ่อการบริหารจัดการ  
ภัยแล้งในลุ่มน้ำชี 

2) เพ่ือกำหนดเกณฑ์เฝ้าระวังและเตือนภัยความแห้งแล้งในลุ่มน้ำชี 
3) เพื่อพัฒนาเกณฑ์แนะนำในการวางแผนการบริหารจัดการน้ำของกรมชลประทานสำหรับกำหนด

ปริมาณการระบายน้ำผ่านอาคารชลประทาน  ในกรณีที่ปริมาณน้ำในลำน้ำชีอยู่ในเกณฑ์น้ำน้อย 
4) เพื่อพัฒนาต้นแบบระบบการบริหารจัดการน้ำในกรณีน้ำน้อย  และแนวทางการปรับเปลี่ยน ปรับลด

การเพาะปลูกพืชตามความเหมาะสม  และการวางกรอบมาตรการการช่วยเหลือด้านอื่น ๆ 

1.4 ขอบเขตการดำเนินงาน 
1.4.1 งานรวบรวม ตรวจสอบข้อมูลพื้นฐาน  และข้อมูลประกอบการวิเคราะห์การบริหารจัดการน้ำในลุ่ม

น้ำชี ประกอบด้วย 
1 ) รวบรวม  และตรวจสอบข้อม ูลพ ื ้นฐานล ุ ่มน ้ำช ี  ได ้แก่  ข ้อม ูลด ้านกายภาพ  ข ้อมูล 

ด้านอุตุ – อุทกวิทยา ข้อมูลด้านการบริหารจัดการน้ำ และข้อมูลด้านสารสนเทศภูมิศาสตร์อื่น ๆ เป็นต้น 
2 ) ร วบ ร วมและว ิ เ ค ร า ะห ์ หน ้ า ต ั ด ล ำ น ้ ำ  ( Cross-sections) ใ นแม ่ น ้ ำ ช ี ท ี ่ ส ำ คั ญ 

ต่อการวิเคราะห์แบบจำลอง  
3 ) รวบรวมและตรวจสอบพิก ัดตำแหน ่งอาคารชลศาสตร ์ท ี ่ถ ูกต ้องในแม ่น ้ำช ี  และ 

หรือลำน้ำสาขาท่ีเกี่ยวข้อง 
4) รวบรวมและวิเคราะห์หน้าตัดตามยาวลำน้ำ (Long Profile) ในแม่น้ำชี และหรือลำน้ำสาขาที่

เกี่ยวข้อง 
5) จัดทำรายละเอียดขอบเขตงานในการจัดทำแบบจำลองการไหลในแม่น้ำชีและออกแบบระบบ

การจัดเก็บข้อมูล ประกอบด้วยขอบเขตโครงข่ายลำน้ำที่ใช้ในแบบจำลอง แผนผังระบบการทำงานในแบบจำลอง 
6) รวบรวมศึกษาข้อมูลที่จำเป็นต่อการพัฒนาระบบการไหลในแม่น้ำชี เช่น หน้าตัดการไหล รูปแบบ

อาคารชลศาสตร์ อัตราการไหล และข้อมูลเชิงสถิติอ่ืน ๆ เป็นต้น 
7 ) รวบรวมศ ึ กษาข ้ อม ู ลท ี ่ เก ี ่ ยวข ้ อง  เช ่ น  ลำน ้ ำสาขาท ี ่ เป ็ นการไหลเข ้ าแม ่น ้ ำชี   

(Tributary Inflow) สถานีตรวจวัดน้ำท่า และอาคารชลศาสตร์ เป็นต้น 
8) จัดทำรายงานผลการดำเนินงานตามข้อ 1) – 7) พร้อมข้อมูลในรูปแบบไฟล์ดิจิทัล เสนอ

คณะกรรมการตรวจรับพัสดุให้ความเห็นชอบ  
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1.4.2 งานวิเคราะห์จัดทำเกณฑ์ความสัมพันธ์การบริหารจัดการภัยแล้ง ลุ่มน้ำชี ประกอบด้วย 
1) ศึกษาความสัมพันธ์ของปริมาณน้ำในลำน้ำกับความต้องการใช้น้ำในพื้นที่ชลประทานเพื่อการ

บ ร ิ ห า ร จ ั ด ก า ร ภ ั ย แ ล ้ ง ล ุ ่ ม น ้ ำ ช ี  โ ด ย ก า ร ว ิ เ ค ร า ะห ์ ค ว า ม ส ั มพ ั น ธ ์ ข อ ง ป ร ิ ม า ณ น ้ ำ ใ นล ำน้ ำ   
กับความต้องการใช้น้ำชลประทาน 

2.) จัดทำแบบจำลองการวางแผนการบริหารจัดการน้ำ ในกรณีที่ปริมาณน้ำ อยู่ในเกณฑ์น้ำน้อย
ประกอบด้วย 

(1) จัดทำแบบจำลองทางชลศาสตร์  โดยการนำเข้าข้อมูลทางกายภาพของแม่น้ำ 
(Geometric Data) ประกอบด้วย ระบบเครือข่ายแม่น้ำ (River Network) หน้าตัดการไหล (Cross-sections) และ
โครงสร้างทางชลศาสตร์ (Hydraulic Structures) 

(2) นำเข้าข้อมูลการไหล (Flow Data) เช่น ระดับน้ำ หรือ อัตราการไหล และการ
กำหนดรูปแบบการไหล เป็นต้น 

(3) การกำหนดเงื่อนไขขอบเขต (Boundary Condition) การกำหนดรูปแบบเงื่อนไข
ขอบเขตในแบบจำลองตามลักษณะการไหลที่กำหนด 

(4) จำลองการไหลชลศาสตร์ของแม่น้ำชี 
(5) ปรับเทียบและตรวจสอบแบบจำลองการไหลชลศาสตร์ของแม่น้ำชี   
(6) วิเคราะห์สมดุลน้ำ เกณฑ์เฝ้าระวังและเตือนภัยแล้งในลุ่มน้ำชี 

1.4.3 งานวิเคราะห์และจัดทำเกณฑ์แนะนำการวางแผนการบริหารจัดการน้ำลุ่มน้ำชี สำหรับกำหนด
ปริมาณการระบายน้ำผ่านอาคารชลประทาน  ในกรณีที่ปริมาณน้ำอยู่ในเกณฑ์น้ำน้อย 

1.4.4 งานจัดทำต้นแบบระบบแสดงผลการบริหารจัดการน้ำลุ่มน้ำชี และแนวทางการปรับเปลี่ยน ปรับลด
การเพาะปลูกพืชตามความเหมาะสม  

1.4.5 งานจัดทำรายงานและคู่มือการใช้งานระบบการบริหารจัดการภัยแล้ง ลุ่มน้ำชี 
1.4.6 งานถ่ายทอดเทคโนโลยี ความรู้และการใช้งานให้แก่บุคลากรที่เกี่ยวข้องของกรมชลประทานให้สามารถ
นำไปใช้งานได้อย่างมีประสิทธิภาพ โดยมีผู้เข้ารับการถ่ายทอดจำนวนไม่น้อยกว่า 10 คน  
เป็นระยะเวลาไม่น้อยกว่า 1 วัน และต้องจัดทำรายงานการถ่ายทอดเทคโนโลยี เสนอคณะกรรมการตรวจรับพัสดุ
ให้ความเห็นชอบ 
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บทที่ 2 

ความเข้าใจโครงการ 

2.1 สภาพทั่วไปของลุ่มน้ำชี 

2.1.1 สภาพภูมิประเทศของลุ่มน้ำชี 
ลุ่มน้ำชี ตั้งอยู่ในภาคตะวันออกเฉียงเหนือของประเทศไทย มีพื้นที่ลุ่มน้ำรวมทั้งสิ้น 49 ,131.92 ตาราง

กิโลเมตร หรือ 30,707,453 ไร่ มีพื้นที่ส่วนใหญ่อยู่ในเขต 16 จังหวัด ได้แก่ ชัยภูมิ ขอนแก่น หนองบัวลำภู 
อุดรธานี มหาสารคาม นครราชสีมา เลย เพชรบูรณ์ กาฬสินธุ์ ร้อยเอ็ด ยโสธร อุบลราชธานี ศรีสะเกษ ลพบุรี 
สกลนคร และมุกดาหาร ลุ่มน้ำชีตั้งอยู่ระหว่างเส้นรุ้งที่ 15° 30' เหนือถึงเส้นรุ้งที่ 17° 30' เหนือ และอยู่ระหว่าง
เส้นแวงที่ 101° 30' ตะวันออก ถึงเส้นแวงที่ 104° 30' ตะวันออก ทิศเหนือติดกับลุ่มน้ำโขง ทิศใต้ติดกับลุ่มนำ้มูล 
ทิศตะวันออกติดกับลุ่มน้ำโขงและลุ่มน้ำมูล ทิศตะวันตกติดกับลุ่มน้ำป่าสัก สภาพโดยทั่วไปเป็นเทือกเขาสูง ทางทิศ
ตะวันออกและทิศเหนือคือเทือกเขาภูพาน ทิศตะวันตกคือเทือกเขา ดงพญาเย็น ซึ่งเป็นต้นกำเนิดของแม่น้ำชีและ
แม่น้ำสาขาที่สำคัญหลายสาย ส่วนพื้นที่ตอนกลางเป็นที่ราบถึงลูกคลื่นลอนและมีเนินเล็กน้อยทางตอนใต้ของลุ่ม
น้ำ ลุ่มน้ำสายหลัก คือ แม่น้ำชี ซึ่งมีต้นกำเนิดมาจากยอดเขาในแนวเทือกเขาเพชรบูรณ์ ในเขตอำเภอเกษตร 
สมบูรณ์ จังหวัดชัยภูมิ  

• พ้ืนที่ลุ่มน้ำรวมทั้งหมด  49,131.92 ตารางกิโลเมตร 
• พ้ืนที่ลุ่มน้ำทั้งหมด 30,707,453 ไร่ 
• ความยาวลุ่มน้ำ  765   กิโลเมตร 
• อัตราการไหลเฉลี่ย 250  ลูกบาศก์เมตรต่อวินาที  
• อัตราการไหลสูงสุด 3,960  ลูกบาศก์เมตรต่อวินาที 

ลุ่มน้ำชี ประกอบด้วยลุ่มน้ำสาขา 20 สาขา ดังนี้  
1). ลุ่มน้ำสาขาลุ่มน้ำชีตอนบน มีพื้นที่ลุ่มน้ำ 2,551 ตารางกิโลเมตรหรือ 1,594,250 ไร่ ขอบเขต

พื้นที่ทิศตะวันตก อำเภอเมือง และอำเภอหนองไผ่ จังหวัดเพชรบูรณ์ ด้านทิศเหนือติดเขตลุ่มน้ำสาขาลุ่มสะพุง และ
ด้านทิศใต้ติดเขตลุ่ม น้ำสาขาลุ่มกระจวน การไหลของน้ำในลุ่มน้ำสาขาลุ่มน้ำชีตอนบนนี้จะไหลจากที่สูงด้านทิศ
ตะวันตก ซึ่งเป็นสันเขามีป่า ไม้หนาแน่น เอียงเทสู่ทิศตะวันออก จากระดับความสูงประมาณ 800 เมตรเทียบกับ
ระดับน้ำทะเลปานกลางบริเวณต้นน้ำ ลดระดับลงไปประมาณ 200 เมตรเทียบกับระดับน้ำทะเลปานกลางบริเวณ
ปลายลุ่มน้ำ 

2). ล ุ ่มน้ำสาขาลุ ่มสะพุง มีพื ้นที ่ล ุ ่มน้ำ 742 ตารางกิโลเมตรหรือ 463,944 ไร ่ สภาพพื ้นที่ 
เป็นเทือกเขายกตัวสูงมีพื้นที่ราบตรงกลางรอบๆ สันปันน้ำยกตัวสูงทำให้ทุ่งกระมังเป็นแอ่งอยู่ตรงกลาง พื้นที่ส่วน
ใหญ่เป็นป่าสงวน มีป่าไม้ หนาแน่น และเป็นพ้ืนที่ต้นน้ำชี  

3). ลุ่มน้ำสาขาลุ่มกระจวน มีพื้นที่ลุ่มน้ำ 893 ตารางกิโลเมตรหรือ 558,556 ไร่ ขอบเขตของพื้นที่
ด้านทิศเหนือติด กับขอบเขตสันปันน้ำของลุ่มน้ำสาขาลุ่มน้ำชีตอนบน ด้านทิศใต้ติดสันปันน้ำของลุ่มน้ำ สาขาลุ่ม
คันฉูและลุ่มน้ำชีส่วนที่ 2 ลักษณะภูมิประเทศด้านทิศตะวันตกอ้อมไปด้านทิศเหนือเป็นแนวสันปันน้ำ ซึ่งเป็นสันเขา
พังเหย มีป่าไม้หนาแน่น ส่วน ด้านทิศใต้เป็นพื้นที่เนินรอนลาด  
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4). ลุ่มน้ำสาขาลุ่มคันฉู มีพื้นที่ลุ่มน้ำ 1,733 ตารางกิโลเมตรหรือ 1,082,906 ไร่ ขอบเขตของพื้นที่
ด้านทิศตะวันตก กั้นด้วยแนวสันเขาสูงของเทือกเขาพังเหยติดกับลุ่มน้ำป่าสัก เขตอำเภอวิเชียรบุรี จังหวัด
เพชรบูรณ์ และอำเภอชัย บาดาล จังหวัดลพบุรี จากสันเขาด้านทิศใต้ ไปสันเขาด้านทิศเหนือ แล้วลาดต่ำลงในแนว
ทิศตะวันออกสู่กลางลุ่มน้ำบริเวณอำเภอจัตุรัส 

5). ลุ่มน้ำสาขาลุ่มน้ำชีส่วนที่ 2 มีพ้ืนที่ลุ่มน้ำ 3,795 ตารางกิโลเมตรหรือ 2,372,100 ไร่ขอบเขตของ
พ้ืนที่ด้านทิศ ตะวันตกเฉียงเหนือติดลุ่มน้ำสาขาน้ำพรม ทิศตะวันออกติดลุ่มน้ำสาขาห้วยสามหมอและลุ่มน้ำชีส่วน
ที่ 3 ด้านทิศใต้ติดลุ่มน้ำมูล พื้นที่ลุ่มน้ำส่วนใหญ่เป็นที่ราบน้ำท่วมถึงในฤดูฝน มีพื้นที่ชุ่มน้ำหลายจุดโดยเฉพาะ
ห น อ ง น ้ ำ ข น า ด ใ ห ญ ่ บ ร ิ เ ว ณ  ส อ ง ฝ ั ่ ง ข อ ง แ ม ่ น ้ ำ ช ี บ ร ิ เ ว ณ ส ั น ป ั น น ้ ำ จ ะ เ ป็ น  
ที่เนินลอนลาด ซึ่งพ้ืนที่ส่วนใหญ่เป็นพื้นที่เกษตรกรรม  

6). ลุ่มน้ำสาขาห้วยสามหมอ มีพื้นที่ลุ่มน้ำ765 ตารางกิโลเมตรหรือ 478,056 ไร่ ขอบเขตของพื้นที่
ด้านทิศ ตะวันตกและทิศใต้ติดกับลุ่มน้ำสาขาลุ่มน้ำชีส่วนที่ 2 ด้านทิศเหนือติดกับลุ่มน้ำสาขาลุ่มน้ำเชิญ และทิศ
ตะวันออกติด กับลุ่มน้ำสาขาลุ่มน้ำชีส่วนที่ 3 ลักษณะลุ่มน้ำเป็นรูปสี่เหลี่ยมจัตุรัส พื้นที่สันปันน้ำด้านทิศตะวันตก 
ด้านทิศใต้ และทิศ ตะวันออกเป็นสันเขาสูงของเทือกเขา บริเวณภูเขียว ด้านทิศตะวันตกจะอ้อมไปทางทิศใต้และ
ทิศตะวันออกของ เทือกเขาภูเม็ง แล้วลาดต่ำลงสู่ที่ราบลุ่มน้ำตรงกลางบริเวณอำเภอแก้งคร้อ  

7). ลุ่มน้ำสาขาลุ่มน้ำชีส่วนที่ 3 มีพื้นที่ลุ่มน้ำ3,3276 ตารางกิโลเมตรหรือ 2,047,650 ไร่ ขอบเขต
ของพื้นที่ด้านทิศตะวันตก จะเป็นแนวสันเขาภูเม็งที่เป็นสันปันน้ำ ตามแนวสันเขื่อนอุบลรัตน์ ความสูงของสันเขา
ประมาณ 400 เมตรเทียบกับระดับน้ำทะเลปานกลางจากด้านทิศใต้ไปจนถึงประมาณ 600 เมตรเทียบกับ
ระด ับน ้ ำทะ เลปานกลางท ี ่ ด ้ านท ิ ศ เหน ือ  ด ้ านท ิ ศตะว ั นออกของพ ื ้ นท ี ่ บ ร ิ เ วณอำ เภอบ ้ านแฮ  
อำเภอบ้านไผ่ และอำเภอเมืองขอนแก่น จ ังหว ัดขอนแก่น เป ็นพื ้นที ่ เน ินลอนลาด ความสูงประมาณ  
230 เมตรเทียบกับระดับน้ำทะเลปานกลางแล้วลาดต่ำงสู่แม่น้ำชี  

8). ลุ่มน้ำสาขาลุ่มน้ำพองตอนบน มีพ้ืนที่ลุ่มน้ำ4,130 ตารางกิโลเมตรหรือ 2,581,094 ไร่ บริเวณลุ่ม
น้ำสาขาลุ่มน้ำ พองตอนบนนี้ มีแอ่งภูเวียงอยู่ตรงกลาง ลักษณะเป็นแอ่งรูปไข่มีเขาสองเขาเหนือใต้ ขอบเขตของ
พ ื ้ น ท ี ่ ด ้ า นท ิ ศตะว ั น ต ก  เ ป ็ น ล ุ ่ ม น ้ ำ ย า ว ออก ไปจนจ รด อำ เภอหล ่ ม ส ั ก  จ ั ง ห ว ั ด เ พช รบ ู ร ณ์   
มียอดภูกระดึงเป็นบริเวณที่ราบยอดเขาสูงสุด ลาดต่ำลง มาที่บริเวณอ่างเก็บน้ำเขื่อนอุบลรัตน์ บริเวณลุ่มน้ำด้านทิศ
เหนือยื่นยาวขึ้นไปถึงตัวอำเภอเมืองจังหวัดหนองบัวลำภู เป็นพื้นที่ลูกคลื่นลอนลาด  

9). ลุ่มน้ำสาขาน้ำพวย มีพื้นที่ลุ่มน้ำ 922 ตารางกิโลเมตรหรือ 576,469 ไร่ เป็นลุ่มน้ำเล็กๆ อยู่
บริเวณด้านทิศ เหนือของลุ่มน้ำสาขาลุ่มน้ำพองตอนบน ลักษณะภูมิประเทศเป็นเนินเขาสูงประมาณ 700 เมตรเทียบ
ก ับระด ับน ้ำทะเลปานกลาง แล ้วลดระด ับความ ส ูงลงมาส ู ่บร ิ เวณพื ้นท ี ่อ ่างเก ็บน้ำเข ื ่อนอ ุบลร ัตน์  
ที่ระดับความสูง ประมาณ 300 เมตรเทียบกับระดับน้ำทะเลปานกลาง 

10). ลุ ่มน้ำสาขาลุ ่มพะเนียง มีพื ้นที ่ลุ ่มน้ำ 1,890 ตารางกิโลเมตรหรือ 1,181,513 ไร่ เริ ่มจาก
เทือกเขาในจังหวัด เลยบริเวณภูข้าวที่อยู่ทางตะวันออกของจังหวัดเลย แล้วไหลลงในแนวตะวันออกเฉียงใต้ผ่านตัว
จังหวัดหนองบัวลำภู และไหลลงสู่อ่างเก็บน้ำเขื่อนน้ำพอง บริเวณอำเภอศรีบุญเรือง จังหวัดหนองบัวลำภู บริเวณ
ต้นน้ำในจังหวัดเลย ลักษณะลุ่มน้ำเป็นลุ่มน้ำแคบ ๆ รูปคล้ายตัวเอส (S) สองฝั่งแม่น้ำเป็นเทือกเขา มีพ้ืนที่น้ำท่วมน้อย  

11). ลุ่มน้ำสาขาน้ำพรหม มีพื้นที่ลุ่มน้ำ 2,211 ตารางกิโลเมตรหรือ 1,382,163 ไร่ ขอบเขตพื้นที่
ด้านทิศใต้ติดลุ ่มน้ำสาขาลุ่มสะพุงและลุ่มน้ำชีตอนบน ด้านทิศเหนือติดลุ่มน้ำสาขาลุ่มน้ำเชิญ ส่วนด้านทิศ
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ตะวันออกติดลุ่มน้ำลุ่มน้ำเชิญ และลุ่มน้ำชีส่วนที่ 2 พื้นที่ช่วงลุ่มน้ำพรมตอนบนเหนือเขื่อนจุฬาภรณ์เป็นพื้นที่ป่า
อนุรักษ์น้ำทั้งหมดจะไหลลงมาสู่อ่าง เก็บน้ำของเขื่อนจุฬาภรณ์ ลงมาถึงเขื่อนห้วยกุ่ม ลักษณะของพื้นที่ลุ่มน้ำจะ
บานออกลุ่มน้ำรูปพัดเป็นที่ราบลอนลาด สลับเนินเขาเตี้ยๆ จนถึงแนวสันปันน้ำ 

12). ลุ่มน้ำสาขาลุ่มน้ำเชิญ มีพื้นที่ 2,904 ตารางกิโลเมตรหรือ 1,814,719 ไร่ พื้นที่ลุ่มน้ำเริ่มจาก
บริเวณด้านทิศ ตะวันออกของอุทยานแห่งชาติน้ำหนาว อำเภอหล่มสัก จังหวัดเพชรบูรณ์ แล้วไหลจากแนวทิศ
ตะวันตกสู่ทิศตะวันออก ไปยังอ่างเก็บน้ำเขื่อนอุบลรัตน์ พื้นที่ลุ่มน้ำมากกว่าร้อยละ 50 อยู่บริเวณเทือกเขาสูงชัน
และป่าไม้หนาทึบสลับเนินเขา เตี้ยๆ ส่วนบริเวณด้านทำยของลุ่มน้ำเป็นพื้นที่อ่างเก็บน้ำเขื่อนอุบลรัตน์  

13). ลุ่มน้ำสาขาลุ่มน้ำพองตอนล่าง มีพ้ืนที่ 2,316 ตารางกิโลเมตรหรือ 1,447,644 ไร่ ลักษณะพ้ืนที่
เป็นลูกคลื ่น ลอนลาด มีเทือกเขาสูงบริเวณเขาสวนกวางและภูเม็ง มีความสูงประมาณ 300 เมตรเทียบกับ
ระดับน้ำทะเลปานกลางและ 500 เมตรเทียบกับระดับน้ำทะเลปานกลางตามลุ่มดับ และต่ำสุดบริเวณฝายคุยเชือก 
อำเภอโกสุมพิสัย จังหวัดมหาสารคาม  

14). ลุ ่มน้ำสาขาห้วยสายบาตร มีพื ้นที ่ 678 ตารางกิโลเมตรหรือ 423,519 ไร่ ลักษณะพื ้นที่ 
เป็นลุ่มน้ำเล็ก ๆ เริ่มจากบริเวณบ้านหนองทุ่งใหญ่เทือกเขาภูเค็ง เขตติดต่อระหว่างจังหวัดขอนแก่นและจังหวัด
กาฬสินธุ์ บริเวณตะวันออกเฉียงเหนือของอำเภอกระนวน มีความสูงประมาณ 500 เมตรเทียบกับระดับน้ำทะเลปาน
ก ล า ง แ ล ้ ว ไ ห ล จ า ก แ น ว ท ิ ศ เ ห น ื อ ส ู ่ ท ิ ศ ใ ต ้  ผ ่ า น อ ำ เ ภ อ ก ร ะ น ว น  จ ั ง ห ว ั ด ข อ น แ ก่ น  
แล้วไหลลงสู่น้ำพองที่บริเวณก่อนถึงฝายคุยเชือก 

15). ลุ่มน้ำสาขาลุ่มน้ำชีส่วนที่ 4 มีพื้นที่ 5,093 ตารางกิโลเมตรหรือ 3,182,819 ไร่ เป็นลุ่มน้ำสาขา
ขนาดใหญ่สุด และยาวสุดเมื่อเทียบกับลุ่มน้ำสาขาอื่นๆ ที่อยู่ในลุ่มน้ำชี โดยจุดเริ่มต้นของลุ่มน้ำสาขาเริ่มตั้งแต่
จังหวัดขอนแก่น ไปจนสุดจังหวัดร้อยเอ็ดที่อำเภอเสลภูมิ พ้ืนที่ส่วนใหญ่เป็นที่ราบน้ำท่วมถึง ความสูงบริเวณต้นน้ำ
ที่จังหวัดขอนแก่น ประมาณ 150 เมตรเทียบกับระดับน้ำทะเลปานกลางลาดลงไปเป็นระดับประมาณ 130 เมตร
เทียบกับระดับน้ำทะเลปานกลางบริเวณอำเภอเสลภูมิ จังหวัดร้อยเอ็ด บริเวณแนวขอบสันปันน้ำด้านทิศเหนือและ
ตะวันออกบริเวณจังหวัดกาฬสินธุ์จะเป็นจุดสูงสุดของสันปันน้ำสูงประมาณ 360 เมตรเทียบกับระดับน้ำทะเลปาน
กลางและแนวสันปันน้ำด้านใต้ความสูงประมาณ 200 เมตรเทียบกับระดับน้ำทะเลปานกลาง 

16). ลุ่มน้ำสาขาลุ่มปาวตอนบน มีพื้นที่ 3,265 ตารางกิโลเมตรหรือ 2,040,781 ไร่ พื้นที่ลุ ่มน้ำ
ทางด้านทิศ ตะวันตกอยู ่บร ิเวณเทือกเขาภูบังอีใกล้ๆ อำเภอหนองวัวซอ ไปถึงภูผาสิงห์และภูกุ ้มข้าว  
ซึ่งมีความสูงประมาณ 600 เมตรเทียบกับระดับน้ำทะเลปานกลางด้านทิศเหนืออยู่บริเวณบ้านหนองตะไกล้ อำเภอ
ประจักษ์ศิลปาคม อำเภอหนองหาน จังหวัดอุดรธานี จนไปถึง อาณาเขตของลุ่มน้ำสาขาลุ่มพันชาดบริเวณอำเภอ
สว่างแดนดิน จังหวัดสกลนคร ส่วนด้านตะวันออกเฉียงใต้เป็นสันเขา ภูกระแต มีความสูงประมาณ 300 เมตรเทียบ
กับระดับน้ำทะเลปานกลางบริเวณปากลุ่มน้ำเป็นลุ่มน้ำแคบบริเวณอ่างเก็บน้ำลุ่มปาว  

17). ลุ่มน้ำลุ่มพันชาด มีพื้นที่ 698 ตารางกิโลเมตรหรือ 435,956 ไร่ เป็นลุ่มน้ำเล็กๆ อยู่ระหว่างลุ่ม
น้ำสาขาลุ่มปาว ตอนบน และลุ่มน้ำสาขาลุ่มปาวตอนล่าง ซึ่งขนาบทางทิศตะวันตกและทิศตะวันออกตามลุ่มดับ 
ด้านทิศเหนือติดลุ่มน้ำสงคราม โดยมีเทือกเขาภูพาน บริเวณอำเภอน้ำอูน จังหวัดสกลนคร เป็นพื้นที่ต้นน้ำ 
ลักษณะลุ่มน้ำเป็นลุ่มน้ำแคบ ๆ ไหลในแนวเกือบเหนือใต้ลงสู่อ่างเก็บน้ำลุ่มปาว  

18). ลุ่มน้ำสาขาลุ่มปาวตอนล่าง มีพื้นที่ 4,345 ตารางกิโลเมตรหรือ 2,715,531 ไร่ พื้นที่ลุ่มน้ำด้าน
ทิศตะวันตกติด กับลุ่มน้ำสาขาห้วยสายบาตรและลุ่มน้ำสาขาลุ่มน้ำชีส่วนที่ 4 ส่วนด้านทิศเหนือติดกับลุ่มน้ำสาขา
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ลุ่มปาวตอนบน ลุ่มน้ำสาขาลุ่มพันชาด ลุ่มน้ำสงคราม และลุ่มน้ำก้ำ ส่วนด้านทิศใต้ติดกับลุ่มน้ำสาขาลุ่มน้ำชีส่วนที่ 
4 ลักษณะภูมิประเทศต้น น้ำเริ่มจากบริเวณสันปันน้ำตามแนวเทือกเขาภูพานบริเวณภูกระแต ตั้งแต่อำเภอเขา
สวนกวาง จังหวัดขอนแก่น มี ความสูงประมาณ 500 เมตรเทียบกับระดับน้ำทะเลปานกลางและต่อไปยังบริเวณ
เทือกเขาภูพานเหนืออำเภอสหัสขันธ์ และอำเภอสมเด็จ จังหวัด กาฬสินธุ์ ซึ่งมีความสูงประมาณ 600 เมตรเทียบ
กับระดับน้ำทะเลปานกลางแล้วลาดต่ำลงตามแนวลุ่มปาว บริเวณด้านทิศใต้จังหวัดกาฬสินธุ์ ซึ่งเป็น บริเวณปลาย
ลุ่มน้ำ 

19). ลุ่มน้ำสาขาลุ่มน้ำยัง มีพื้นที่ 4,204 ตารางกิโลเมตรหรือ 2,627,688 ไร่ พื้นที่ลุ่มน้ำอยู่ด้านทิศ
ตะวันออกของ ลุ่มน้ำชี แนวสันปันน้ำของลุ่มน้ำเริ่มจากทิศเหนือด้านจังหวัดสกลนคร ตามแนวเทือกเขาภูพาน 
บริเวณอำเภอเขาวง จังหวัดกาฬสินธุ์ แล้วลาดต่ำลงสู่แอ่งบริเวณที่ตั้งอำเภอเขาวง บริเวณสันปันน้ำจะเริ่มจากแนว
สันเขาเหนืออำเภอเขาวง แล้วขยายไปตามสันเขาทางทิศตะวันออกด้านอำเภอหนองสูง จังหวัดมุกดาหาร ไปถึงภู
ผักหวานตามแนวเขตจังหวัดยโสธรและจังหวัดร้อยเอ็ด ด้านทิศตะวันตกติดกับขอบสันปันน้ำของลุ่มน้ำสาขาลุ่ม
ปาวตอนล่างและลุ่มน้ำชีส่วนที่ 4 บริเวณตั้งแต่ตอนกลางของลุ่มน้ำจนถึงปลายลุ่มน้ำ 

20) . ล ุ ่มน ้ ำสาขาล ุ ่ มน ้ ำช ี ตอนล ่าง ม ีพ ื ้นท ี ่  2,718 ตารางก ิ โล เมตรหร ือ 1,698,813 ไร่   
พื้นที่ลุ่มน้ำส่วนใหญ่เป็นที่ราบ น้ำท่วมถึง ด้านทิศเหนือติดกับลุ่มน้ำสาขาลุ่มน้ำยัง ด้านทิศตะวันออกติดลุ่มนำ้โขง 
และด้านทิศใต้ติดกับลุ่มน้ำมูล ด้าน ต้นน้ำพื้นที่จะกว้างแล้วแคบลง พ้ืนที่ลุ่มน้ำเริ่มต้นบริเวณอำเภอเสลภูมิ จังหวัด
ร้อยเอ็ด ผ่านจังหวัดยโสธรแล้วไปสิ้นสุด เมื่อบรรจบกับแม่น้ำมูลก่อนถึงตัวเมืองอุบลราชธานี 
สภาพภูมิประเทศของลุ่มน้ำชีแสดงดังรูปที่ 1 
 

 

รูปที่ 1 สภาพภูมิประเทศของลุ่มน้ำชี 
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ตารางท่ี 1 พื้นที่ครอบคลุมของลุ่มน้ำชีในเขตจังหวัดต่าง ๆ 
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2.1.2 สภาพภูมิอากาศของลุ่มน้ำชี 
สภาพภูม ิอากาศในประเทศไทยอยู ่ภายใต ้อ ิทธ ิพลลมมรสุมและลมพายุจร ด ังแสดงใน ร ูปที่2  

จากการรวบรวมข้อมูลภูมิอากาศที่สถานีตรวจวัดอากาศทั้งประเทศซึ ่งบันทึกไว้โดยกรมอุตุนิยมวิทยาและ  
ได้คัดเลือกสถานี ตรวจวัดอากาศที่ยังคงมีการบันทึกสถิติข้อมูลจนถึงปัจจุบัน และมีจำนวนข้อมูลต่อเนื่องอย่างน้อย 
30 ปีเพื่อให้ข้อมูลที่ จะน้ำมาใช้วิเคราะห์มีความน่าเชื่อถือ จึงคัดเลือกข้อมูลของสถานีตรวจวัดอากาศของกรม
อุตุนิยมวิทยาที่มีช่วงปีสถิติ ข้อมูล ตั้งแต่ปี 2529-2558 จำนวน 66 สถานี ดังแสดงตำแหน่งที่ตั้งสถานีในข้อมูล
ภูมิอากาศที่สำคัญของแต่ ละลุ่มน้ำหลัก ประกอบด้วย อุณหภูมิอากาศ ความชื้นสัมพัทธ์ ปริมาณการระเหยจาก
ถาด ความครึ้มเมฆและความเร็ว ลม ของลุ่มน้ำชีได้ดังนี้ 

ลุ่มน้ำชี มีสถานีตรวจวัดอากาศ จำนวน 4 สถานีที่อยู่ในพื้นที่ลุ่มน้ำ คือ สถานีอุตุนิยมวิทยาขอนแก่น 
(48381) สถาน ี อ ุ ต ุ น ิ ยมว ิ ทย ามหาส ารคาม  ( 48382) สถาน ี อ ุ ต ุ น ิ ยมว ิ ทย าช ั ยภ ู ม ิ  ( 48403) และ 
สถาน ีอ ุต ุน ิยมว ิทยา ร ้อยเอ ็ด (48405) อุณหภ ูม ิรายเด ือนเฉล ี ่ยของล ุ ่มน ้ำฯ ม ีค ่าระหว ่าง 23.6 ถึง  
29.9 องศาเซลเซียส เดือนที่มีอุณหภูมิ เฉลี่ยต่ำที่สุดคือ เดือนธันวาคม และเดือนที่มีอุณหภูมิเฉลี่ยสูงที่สุดคือ เดือน
เมษายน สำหร ับอ ุณหภ ูม ิ เฉล ี ่ ยท ั ้ งป ี ม ี  ค ่ าประมาณ 27.15 องศา เซล เซ ี ยส  ความช ื ้ นส ั มพ ัทธ์  
รายเดือนเฉลี่ยของพ้ืนที่ลุ่มน้ำฯ มีค่าระหว่าง 62.3 ถึง 82.5 เปอร์เซ็นต์ เดือนที่มีความชื้นสัมพัทธ์ต่ำสุด คือ เดือน
มีนาคมส่วนเด ือนที ่ม ีความช ื ้นส ัมพัทธ ์ส ูงส ุดค ือ เด ือนกันยายน และค่าความชื ้นส ัมพัทธ ์รายปีเฉลี่ย  
มีค่าประมาณ 71.65 เปอร์เซ็นต์ ค่าปริมาณการระเหยรายเดือนเฉลี่ยอยู่ระหว่าง 116.4 ถึง 179.4 มิลลิเมตร เดือน
กันยายนเป็นเดือนที่มีปริมาณการระเหยรายเดือนเฉลี่ยต่ำสุด ส่วนเดือนเมษายนเป็น เดือนที่มีปริมาณการระเหย
เฉลี่ยสูงสุด ค่าปริมาณการระเหยที่วัดจากถาดวัดการระเหยรวมทั้งปี มีค่าเฉลี่ย 1,690 มิลลิเมตร ความครึ้มเมฆ
รายเดือนเฉลี่ย มีค่าระหว่าง 2.6 ถึง 8.0 (10 ส่วนของท้องฟ้า) ช่วงที่มีความครึ้มเมฆต่ำสุดอยู่ในช่วงเดือนมกราคม
และสูงสุดอยู่ในเดือนสิงหาคม สำหรับค่าเฉลี่ยทั้งปีมีค่าประมาณ 5.16 (10 ส่วนของท้องฟ้า) สำหรับค่าความเร็ว
ลมในพื้นท่ีลุ่มน้ำฯ อยู่ระหว่าง 1.6 ถึง 2.7 น็อต เดือนที่มีความเร็วลมเฉลี่ยน้อยที่สุด คือ เดือน กันยายน ส่วนเดือน
ที่มีความเร็วเฉลี่ยสูงที่สุดคือ เดือนกรกฎาคม สำหรับความเร็วลมเฉลี่ยตลอดปี มีค่าประมาณ 2.19 น็อต 
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รูปที่ 2 ทิศทางและช่วงเวลาการเกิดของมรสุมและลมพายุจรที่พัดเข้าสู่ประเทศไทย 
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2.1.3 ปริมาณฝน  
ลุ่มน้ำชี มีสถานีวัดน้ำฝนคัดเลือกในพื้นที่และบริเวณใกล้เคียง จำนวนทั้งสิ้น 82 สถานี ดังแสดงในรูปท่ี 

3  ป ร ิ ม า ณ ฝ น ต ก ใ น ช ่ ว ง  ฤ ด ู ฝ น ร ะ ห ว ่ า ง เ ด ื อ น พ ฤ ษ ภ า ค ม ถ ึ ง เ ด ื อ น ต ุ ล า ค ม เ ฉ ล ี ่ ย  179.25  
มิลลิเมตร/เดือนส่วนช่วงฤดูแล้งระหว่างเดือนพฤศจิกายนถึงเดือน เมษายน จะมีปริมาณฝนตกค่อนข้างน้อย
ประมาณ 24.80 มิลลิเมตร/เดือน โดยปริมาณฝนในช่วงฤดูฝนจะมีปริมาณฝนเฉลี่ย 1,075.52 มิลลิเมตร คิดเป็นร้อย
ละ 87.85 ของปริมาณฝนทั้งปี 

2.1.4 ปริมาณน้ำท่า  
การรวบรวมข ้อม ูลปร ิมาณน ้ำท ่า จากสถาน ีว ัดน ้ำท ่าของกรมชลประทาน ม ีจำนวนท ั ้งสิ้น  

1,402 สถานี ดังแสดงในรูปที่ 4 โดยได้ทำการคัดเลือกสถานีวัดน้ำท่าที่มีข้อมูลมากกว่า 10 ปี เป็นจำนวน517 
สถานี ในลุ่มน้ำหลักของประเทศไทย พบว่า น้ำท่ารวมทั้งปีเฉลี่ยต่อหนึ่งหน่วยเวลาต่อหนึ่งหน่วยพื้นที่รับน้ำ  มีค่า
อยู่ระหว่าง 1.85 – 104.06 ลิตร/วินาที/ตารางกิโลเมตรโดยปริมาณน้ำท่าเฉลี่ยรายปีของสถานีวัดน้ำท่าในประเทศ
ไทยมีค่า ระหว่าง 5.08 – 29,074.76 ลุ่มน ลูกบาศก์เมตร ลุ่มน้ำชี มีสถานีวัดน้ำท่าคัดเลือกในพื้นที่ จำนวน45 
ส ถ า น ี  ป ร ิ ม า ณ น ้ ำ ท ่ า ร า ย ป ี เ ฉ ล ี ่ ย ข อ ง ส ถ า น ี ว ั ด น ้ ำ ท ่ า อ ย ู ่ ร ะ ห ว ่ า ง  
44.94 – 9,193.50 ลูกบาศก์เมตร และน้ำท่ารวมทั้งปีเฉลี่ยต่อหนึ่งหน่วยเวลาต่อหนึ่ง หน่วยพื้นที่รับน้ำมีค่าอยู่
ระหว่าง 3.31 – 17.46 ลิตร/วินาที/ตร.กม. 
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รูปที่ 3 สถานีวัดน้ำฝนของลุ่มน้ำชี 

 

รูปที่ 4 สถานีวัดน้ำท่าของลุ่มน้ำชี 
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2.1.5 ปัญหาอุทกภัยของลุ่มน้ำชี 
สภาพการเกิดอุทกภัยในลุ่มน้ำชีแบ่งออกเป็น 2 ลักษณะ คือ 
1). อุทกภัยที่เกิดในบริเวณพื้นที่ลุ่มน้ำตอนบนและลำน้ำสาขาต่างๆ เกิดจากการที่มีฝนตกหนักและน้ำป่า

ไหลหลากจากต้นน้ำลงมามากจนลำน้ำสายหลักไม่สามารถระบายน้ำได้ทัน ประกอบกับมีสิ่งกีดขวางจากเส้นทาง
คมนาคมขวางทางน ้ ำ และม ีอาคารระบายน ้ ำไม ่ เพ ี ยงพอพ ื ้ นท ี ่ ท ี ่ เก ิ ดน ้ ำท ่ วมเป ็ นป ระจำได ้ แก่   
อำเภออุบลรัตน์ จังหวัดขอนแก่น อำเภอเขาวง และอำเภอกุฉินารายณ์ จังหวัดกาฬสินธุ์ 

2). อุทกภัยที ่ เก ิดในพื ้นที ่ราบลุ ่ม เกิดบริเวณที ่เป ็นพื ้นที ่ราบลุ ่มและแม่น้ำสายหลักตื ้นเขิน  
มีความสามารถระบายน้ำไม่เพียงพอ ทำให้ไม่สามารถระบายน้ำลงได้อย่างมีประสิทธิภาพ 

พื ้นท ี ่ท ี ่ เก ิดน ้ำท ่วมเป ็นประจำได ้แก ่  อำเภอบ ้านเขว ้า อำเภอคอนสวรรค ์  จ ั งหว ัดช ัยภ ูมิ  
อำเภอมัญจาคีรี อำเภอชนบท จังหวัดขอนแก่น อำเภอกมลาไสย จังหวัดกาฬสินธุ์ อำเภออาจสามารถ อำเภอธวัช
บุรี อำเภอเสลภูมิ จังหวัดร้อยเอ็ด และอำเภอมหาชนะชัย จังหวัดยโสธร การติดตามเฝ้าระวังสถานการณ์น้ำในลุ่ม
น ้ ำ ช ี  จ ะ ใ ช ้ ค ว า ม ส ั ม พ ั น ธ ์ ข อ ง ข ้ อ ม ู ล ร ะ ด ั บ น ้ ำ ท ี ่ ว ั ด ไ ด ้ จ า ก อ า ค า ร ช ล ป ร ะท า น แ ล ะ ส ถ า นี  
วัดระดับน้ำ โดยมีอาคารชลประทานและสถานีวัดระดับน้ำที่สำคัญ ดังนี้ 
- อาคารชลประทานที่สำคัญในพ้ืนที่ลุ่มน้ำชี ได้แก่ 

• ฝายชนบท บ้านหนองเต่าน้อย อำเภอชนบท จังหวัดขอนแก่น 
• ฝายมหาสารคาม บ้านคุยเชือก อำเภอโกสุมพิสัย จังหวัดมหาสารคาม 
• ฝายวังยาง บ้านสะดำศรี อำเภอฆ้องชัย จังหวัดกาฬสินธุ์ 
• ฝายร้อยเอ็ด บ้านดอนวิเวก อำเภอเชียงขวัญ จังหวัดร้อยเอ็ด 
• ฝายยโสธร พนมไพร   อำเภอเมือง จังหวัดยโสธร 
• ฝายธาตุน้อย บ้านธาตุน้อย อำเภอเขื่องใน จังหวัดอุบลราชธานี 

- สถานีวัดระดับน้ำที่สำคัญในพื้นที่ลุ่มน้ำชี ได้แก่ 
• E.23 บ้านค่าย อำเภอเมือง จังหวัดชัยภูมิ 
• E.16A บ้านท่าพระ อำเภอเมือง จังหวัดขอนแก่น 
• E.91  บ้านหนองขนอน อำเภอโกสุมพิสัย จังหวัดมหาสารคาม 
• E.66A บ้านท่าลาด อำเภอจังหาร จังหวัดร้อยเอ็ด 
• E.18 บ้านท่าไคร้ อำเภอทุ่งเขาหลวง จังหวัดร้อยเอ็ด 
• E.20A บ้านฟ้าหยาด อำเภอมหาชนะชัย จังหวัดยโสธร 
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รูปที่ 5 แผนภูมิแสดงการติดตามสถานการณ์น้ำในพื้นที่ลุ่มน้ำชี  
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2.2 แนวทางการดำเนินงานของโครงการ 

การดำเนินโครงการวิเคราะห์การไหลของน้ำในลุ่มน้ำชี มีแนวทางในการดำเนินงานดังนี้ 
2.2.1 การศึกษาข้อมูลทั่วไปของลุ่มน้ำ 
เป ็นการศ ึกษาเพ ื ่อให ้เห ็นภาพรวมของพื ้นท ี ่ล ุ ่มน ้ำศ ึกษาท ั ้งหมด ได ้แก ่  การศ ึกษาล ักษณะ  

ทางกายภาพ สภาพภูมิประเทศ การปกครอง ระบบลุ่มน้ำและระบบลำน้ำ สภาพภูมิอากาศ ปริมาณฝน ปริมาณ
น้ำท่า ปริมาณน้ำหลาก สภาพทางชลศาสตร์และระบบการระบายน้ำ แหล่งน้ำและโครงการพัฒนาแหล่งน้ำใน
ปัจจุบัน 

2.2.2. พื้นที่ลุ่มน้ำชี 
กรมชลประทาน ภายใต้กระทรวงเกษตรและสหกรณ์ มีภารกิจในการบริหารจัดการน้ำอย่างบูรณาการให้

เพียงพอ ทั่วถึง และเป็นธรรม รวมไปถึงการป้องกันภัยอันเกิดจากน้ำ จากสถานการณ์ปัจจุบันโลกต้องเผชิญกับ
สภาพภูมิอากาศที่เปลี่ยนแปลงอย่างรวดเร็วและรุนแรง ทำให้เกิดปัญหาภัยแล้งและอุทกภัยขึ้นบ่อยครั้ง ส่งผลให้
การบริหารจัดการน้ำมีความท้าทายเพิ่มมากขึ้น จากปริมาณน้ำท่าในลุ่มน้ำชี 16,405 ล้าน ลบ.ม./ปี เมื่อพิจารณา
แหล่งเก็บน้ำในพื้นที่ลุ่มน้ำชีซึ่งมีอ่างเก็บน้ำขนาดใหญ่ จำนวน 3 แห่ง ได้แก่ เขื่อนจุฬาภรณ์ เขื่อนอุบลรัตน์ และ
เขื่อนลำปาว ซึ่งล้วนตั้งอยู่ในพื้นที่ลำน้ำสาขาและไม่ได้ตั้งอยู่ในพื้นที่ต้นน้ำชีในจังหวัดชัยภูมิ มีปริมาตรเก็บกัก 
4,575 ล้าน ลบ.ม. อ่างเก็บน้ำขนาดกลางจำนวน 69 แห่ง ปริมาตรเก็บกัก 440 ล้าน ลบ.ม. รวมปริมาตรเก็บกัก
อ่างเก็บน้ำขนาดใหญ่และขนาดกลางทั้งสิ้นแล้วมีเพียง 5,015 ล้าน ลบ.ม. ยังคงเหลือเหลือปริมาณน้ำส่วนเกินที่
ไหลลงลำน้ำชีทั้งปีอีกจำนวน 11,390 ล้าน ลบ.ม. 

จากปริมาณน้ำในลุ่มน้ำชี โดยเฉพาะในฤดูแล้งจะลดลงเป็นอย่างมาก เนื่องจากพื้นที่ตอนบนของลุ่มน้ำไม่
มีอ่างเก็บน้ำหรือโครงการชลประทานขนาดใหญ่ที่สามารถกักเก็บน้ำไว้ และเมื่อเข้าสู่ช่วงฤดูฝนปริมาณน้ำฝนที่ตก
จะกลายเป็นปริมาณน้ำท่าที่ไหลลงสู่ลำน้ำในปริมาณมาก ประกอบกับลำน้ำชีมีลำน้ำสาขา และมีความยาว
ค่อนข้างมากส่งผลให้เป็นอุปสรรคในการบริหารจัดการน้ำเนื ่องจากปัญหาทางสภาพภูมิประเทศ อาคาร
ชลประทาน การจัดระบบจราจรน้ำในลำสาขา ระดับน้ำในลุ่มน้ำมูล เป็นต้น  

ดังนั้น การบริหารน้ำท่าในลุ่มน้ำชีจึงเป็นอีกวิธีการหนึ่งที่จะช่วยเพิ่มประสิทธิภาพการบริหารจัดการน้ำ 
โดยการบริหารจัดการน้ำเป็นส่วนลำน้ำ โดยใช้อาคารชลประทานหลักในลำน้ำบริหารจัดการน้ำท่า จากการ
วิเคราะห์สภาพพ้ืนที่ชลประทานและอาคารชลประทานที่มีศักยภาพ โดยเฉพาะในลุ่มน้ำชีนั้น มีอาคารชลประทาน
หลักทั้งหมด 6 แห่ง คือ เขื่อนชนบท เขื่อนมาหาสารคาม เขื่อนวังยาง เขื่อนร้อยเอ็ด เขื่อนยโสธร และเขื่อนธาตุ
น้อย ที่สามารถบริหารจัดการน้ำได้ในช่วงฤดูแล้งอย่างมีประสิทธิภาพ  
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รูปที่ 6 พื้นที่ศึกษาลุ่มน้ำชี 6 BLOCK ตามการบริหารจัดการน้ำจากอาคารชลประทาน 
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ตารางที่ 2 แผนและผลการเพาะปลูกข้าวในพ้ืนที่ชลประทานที่ใช้น้ำจากลำน้ำชีกรณีน้ำต้นทุนอยู่ในเกณฑ์น้อย 

Block 
โครงการชลประทาน 

/โครงการส่งน้ำฯ 

พื้นที่ 
ชลประทาน 

 (ไร่) 
จังหวัด 

แผนการ 
เพาะปลูกขา้ว 

 (ไร่) 

ฤดูแล้ง  
(ปี) 

ผลการ 
เพาะปลูก

ข้าว 
 (ไร่) 

ฤดูแล้ง  
(ปี) 

1 โครงการส่งน้ำฯ ชีตอนบน 
    99,770.60  

 ชัยภูมิ              600  2556/57 
       1,147  2562/63 

1 โครงการส่งน้ำฯ ชีตอนบน  นครราชสีมา            1,200  2556/57 

2 โครงการส่งน้ำฯ ชีตอนกลาง     81,329.75   ขอนแก่น            5,200  2558/59 

      10,622  

2563/64 

3 โครงการส่งน้ำฯ ชีตอนกลาง         259.49   มหาสารคาม            5,225  2557/58 2563/64 

4 โครงการส่งน้ำฯ ชีตอนกลาง     54,397.63   ร้อยเอ็ด            5,200  2556/57 2563/64 

5 โครงการส่งน้ำฯ ชีตอนกลาง       8,749.24   กาฬสินธุ์            5,534  2556/57 2563/64 

6 คบ.ชีล่างและเซบายล่าง PR3       2,886.22   อุบลราชธานี            2,800  2565/66 

       5,635  

2561/62 

6 คบ.ชีล่างและเซบายล่าง P6/1     36,655.25   ยโสธร            4,300  2565/66 2561/62 

6 คบ.ชีล่างและเซบายล่าง P5     13,235.30   ยโสธร            4,300  2565/66 2561/62 

6 คบ.ชีล่างและเซบายล่าง P4     12,274.01   อุบลราชธานี            2,100  2565/66 2561/62 

6 คบ.ชีล่างและเซบายล่าง P2     40,194.19   อุบลราชธานี            6,700  2565/66 2561/62 

6 คบ.ชีล่างและเซบายล่าง P1     22,896.52   อุบลราชธานี            3,900  2565/66 2561/62 

6 โครงการส่งน้ำฯ หัวนา     15,892.63   ศรีสะเกษ          42,745  2560/61  -  - 

6 โครงการส่งน้ำฯ มูลล่าง     19,845.63   ศรีษะเกษ   5,100 -        5,121  2565/66 

  รวม 408,386.47    89,804.00    22,525.00   

 
 จากตารางที่ 2 แผนและผลการเพาะปลูกข้าวในพื้นที่ชลประทานที่ใช้น้ำจากลำน้ำชีกรณีน้ำต้นทุนอยู่ใน
เกณฑ์น้อย จะพบว่าพ้ืนที่ริมน้ำชีเริ่มตั้งแต่โครงการส่งน้ำฯ ชีตอนบนลงจาจนถึงโครงการส่งน้ำฯ มูลล่างนั้นมีพ้ืนที่
ที ่อยู่ในเขตชลประทานรวม 408,386.47 ไร่ ในปีที่มีน้ำต้นทุนจำกัดนั้นได้มีการวางแผนและเก็บสถิติผลการ
เพาะปลูกพืช รวมทั้งการใช้น้ำในกิจกรรมอื่นๆ ที่จำเป็นโดยวางแผนการเพาะปลูกรวม 89 ,804 ไร่ และมีผลการ
เพาะปลูกรวม 22,525 ไร่ 
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ตารางท่ี 3 ผลการวิเคราะห์ปริมาณความต้องการน้ำของโครงการชลประทาน/โครงการส่งน้ำฯ ในลุ่มน้ำชี 

Blo
ck 

โครงการ
ชลประทาน 
/โครงการส่งน้ำฯ 

พื้นที่ 
ชลประทาน 
 (ไร่) 

จังหวัด 
อุปโภค 
บริโภค 
mcm. 

น้ำใช ้
อ่ืนๆ 
mcm. 

อุตสาห
กรรม 
mcm. 

รักษา 
ระบบ 
นิเวศ 
mcm. 

การ 
เกษตร 
mcm. 

ฝน 
ใช้
การ 
mc
m. 

ปสภ 
% 

ควา
ม 
ต้อง
การ
น้ำ 
ชป. 
mc
m. 

ปริม
าณ 
การ
ส่ง
น้ำ 
mc
m. 

1 โครงการส่งน้ำฯ 
ชีตอนบน 

99,770.60 ชัยภูมิ 10.00 9.00 13.00 3.00 0.83 0.03 45.00 1.79 36.7
9 

2 โครงการส่งน้ำฯ 
ชีตอนบน 

นครรา
ชสีมา 

9.00 0.00 0.00 7.00 1.63 0.06 45.00 3.49 19.4
9 

2 โครงการส่งน้ำฯ 
ชีตอนกลาง 

81,329.75 ขอนแก่
น 

0.00 0.00 0.00 0.00 6.94 0.20 45.00 14.9
7 

14.9
7 

3 โครงการส่งน้ำฯ 
ชีตอนกลาง 

259.49 มหาสา
รคาม 

2.00 0.00 0.00 9.00 23.69 1.28 45.00 49.7
8 

60.7
8 

4 โครงการส่งน้ำฯ 
ชีตอนกลาง 

54,397.63 ร ้อยเอ็
ด 

0.00 0.00 0.00 0.00 7.17 0.21 45.00 15.4
7 

15.4
7 

5 โครงการส่งน้ำฯ 
ชีตอนกลาง 

8,749.24 กาฬสิน
ธุ์ 

12.00 0.00 0.00 31.00 8.00 0.21 45.00 17.3
2 

60.3
2 

6 คบ.ชีล่างและเซ
บายล่าง PR3 

2,886.22 อุบลรา
ชธานี 

0.04 0.07 0.04 0.04 4.08 0.08 45.00 8.88 9.07 

6 คบ.ชีล่างและเซ
บายล่าง P6/1 

36,655.25 ยโสธร 1.00 0.00 11.00 2.00 30.99 1.81 45.00 64.8
4 

78.8
4 

6 คบ.ชีล่างและเซ
บายล่าง P5 

13,235.30 ยโสธร 8.00 0.00 0.00 43.00 5.93 0.10 45.00 12.9
5 

63.9
5 

6 คบ.ชีล่างและเซ
บายล่าง P4 

12,274.01 อุบลรา
ชธานี 

0.16 0.31 0.16 0.16 3.06 0.06 45.00 6.66 7.45 

6 คบ.ชีล่างและเซ
บายล่าง P2 

40,194.19 อุบลรา
ชธานี 

0.51 1.03 0.51 0.51 9.75 0.19 45.00 21.2
5 

23.8
2 

6 คบ.ชีล่างและเซ
บายล่าง P1 

22,896.52 อุบลรา
ชธานี 

0.29 0.59 0.29 0.29 5.68 0.11 45.00 12.3
7 

13.8
3 

6 โครงการส่งน้ำฯ 
หัวนา 

15,892.63 ศ ร ี ส ะ
เกษ 

6.00 0.00 0.00 0.00 49.78 0.76 45.00 108.
94 

114.
94 

6 โครงการส่งน้ำฯ 
มูลล่าง 

19,845.63 ศร ีษะเ
กษ 

4.00 0.00 0.00 4.00 0.00 0.00 45.00 0.00 8.00 

รวม - 408,386.4
7 

- 
53.00  11.00  25.00  100.00  157.53  5.11  45.00 

338.
72  

527.
72  

จากตารางท่ี 3 ผลการวิเคราะห์ปริมาณความต้องการน้ำของโครงการชลประทาน/โครงการส่งน้ำฯ ในลุ่ม
น้ำชี กรณีน้ำต้นทุนอยู่ในเกณฑ์น้อย พบว่าพ้ืนที่ริมน้ำชีเริ่มตั้งแต่โครงการส่งน้ำฯ ชีตอนบนลงจาจนถึงโครงการส่ง
น้ำฯ มูลล่างนั้น ในปีที่มีน้ำต้นทุนจำกัดนั้นได้มีปริมาณความต้องการน้ำรวมทั้ งการใช้น้ำในกิจกรรมอื่นๆ ที่จำเป็น
ในช่วงฤดูแล้งรวม 527.72 ล้าน ลบ.ม. แบ่งเป็น อุปโภค-บริโภค 53 ล้าน ลบ.ม. รักษาระบบนิเวศ 100 ล้าน ลบ.ม. 
อุตสาหกรรม 25 ล้าน ลบ.ม. และอ่ืนๆ 11 ล้าน ลบ.ม.  โดยเป็นการวางแผนการเพาะปลูกรวม 89,804 ไร่  
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ตารางที่ 4 ผลการวิเคราะห์ปริมาณความต้องการน้ำของโครงการชลประทาน/โครงการส่งน้ำฯ ในลุ่มน้ำชีแบ่งตาม 

Block 
อุปโภค 
บริโภค 
mcm. 

น้ำใช้ 
อ่ืนๆ 

mcm. 

อุตสาหกรรม 
mcm. 

รักษา 
ระบบ 
นิเวศ 
mcm. 

การ 
เกษตร 
mcm. 

ฝน 
ใช้การ 
mcm. 

ปสภ 
% 

ความ 
ต้องการ

น้ำ 
ชป. 

mcm. 

ปริมาณ 
การส่ง

น้ำ 
mcm. 

1 10.00 9.00 13.00 3.00 0.83 0.03 45.00 1.79 36.79 

2 9.00 0.00 0.00 7.00 8.57 0.27 90.00 18.46 34.46 

3 2.00 0.00 0.00 9.00 23.69 1.28 45.00 49.78 60.78 

4 0.00 0.00 0.00 0.00 7.17 0.21 45.00 15.47 15.47 

5 12.00 0.00 0.00 31.00 8.00 0.21 45.00 17.32 60.32 

6 20.00 2.00 12.00 50.00 109.26 3.11 360.00 235.90 319.90 

จากตารางที ่  4 ผลการว ิเคราะห์ปริมาณความต้องการน้ำของโครงการชลประทาน/โครงการส ่งน้ำฯ  
ในลุ่มน้ำชี กรณีน้ำต้นทุนอยู่ในเกณฑ์น้อย พบว่าพื้นที่ริมน้ำชีเริ่มตั้งแต่โครงการส่งน้ำฯ ชีตอนบนลงจาจนถึง
โครงการส ่งน ้ำฯ ม ูลล ่าง สามารถแบ ่งพ ื ้นท ี ่ออกเป็น 6 ช ่วง โดยแบ ่งเป ็นปร ิมาณความต ้องการน้ำ  
เพ่ือกิจกรรมต่างๆ ในแต่ละช่วงตามลำดับที่ 1-6 ดังนี้ 36.79 , 34.46 ,60.78 ,15.47 ,60.32 และ 319.9 ล้าน ลบ.
ม. ตามลำดับ 
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2.2.3 การศึกษาสาเหตุและสภาพปัญหาการเกิดภัยแล้งในพ้ืนที่ลุ่มน้ำ 
เป็นการทบทวนปัญหาการเกิดภัยแล้งในพื้นที่ลุ่มน้ำที่เคยเกิดขึ้นในอดีต พร้อมทั้งตรวจสอบวิเคราะห์ถึง

สาเหตุของการเกิดภัยแล้ง การวิเคราะห์ระดับของปัญหาภัยแล้ง ได้แก่ ปัญหาภัยแล้งในระดับลุ่มน้ำหรือปัญหา
เฉพาะพื้นที่ ซึ่งจะมีความแตกต่างกันในด้านของมาตรการการแก้ไขปัญหา รวมถึงการศึกษาแนวทางการบริหาร
จัดการน้ำที่ดำเนินการอยู่ในปัจจุบัน เพื่อที่จะนำมาสู่การวางแนวทางการแก้ไขปัญหาและตำแหน่งสำคัญในการ
แจ้งเตือนภัยแล้งต่อไป 

2.2.4 การรวบรวมข้อมูลสำหรับนำเข้าแบบจำลองคณิตศาสตร์  
ดำเนินการรวบรวมข้อมูลลักษณะทางกายภาพของลุ่มน้ำที่สำคัญ ประกอบไปด้วย ลักษณะลุ่มน้ำ ความสูง

ต ่ำภ ูม ิประเทศ การใช ้ประโยชน ์ท ี ่ด ิน โครงข ่ายลำน ้ำ หน ้าต ัดลำน ้ำ ส ิ ่ งปล ูกสร ้างในลำน ้ำ และ  
สิ่งกีดขวางทางน้ำ สำหรับนำเข้าแบบจำลองชลศาสตร์เพื่อทำการวิเคราะห์การไหลต่อไป 

2.2.5 การพัฒนาแบบจำลองคณิตศาสตร์  
พัฒนาแบบจำลองคณิตศาสตร์ให้มีระบบโครงข่าย (Network System) และองค์ประกอบที่สอดคล้องกับ

ลักษณะทางภูมิประเทศและสภาพแวดล้อมที่มีอยู่ในปัจจุบันให้มากที่สุด กำหนดขอบเขตในการคำนวณ ปริมาณ
น้ำหลากที่ไหลเข้าตามตำแหน่งต่างๆ ทำการสอบเทียบและตรวจพิสูจน์แบบจำลองจากเหตุการณ์ที่เกิดขึ้นในอดีต 
เ พ ื ่ อ น ำ แ บ บ จ ำ ล อ ง ท ี ่ เ ช ื ่ อ ถ ื อ ไ ด ้ ไ ป ศ ึ ก ษ า ถึ ง ป ร ิ ม า ณ ก า ร ไ ห ล  แ ล ะ โ ป ร ไ ฟ ล์   
ผิวน้ำที่เกิดขึ้น รวมถึงระดับน้ำที่ไหลล้นตลิ่งท่วมพ้ืนที่โดยรอบ จากกรณีศึกษาต่างๆ ตามท่ีได้กำหนดไว 

2.2.6 การกำหนดกรณีศึกษา  
กำหนดกรณีศึกษาตามระดับความรุนแรงของภัยแล้ง ที่ และนำเข้าแผนการบริหารจัดการน้ำของอ่างเก็บ

น ้ ำ  หร ื อประต ู ระบายน ้ ำท ี ่ ส ำค ัญ ในพ ื ้ นท ี ่ ล ุ ่ มน ้ ำตามแผนการบรร เทาภ ัยแล ้ งของหน ่ วยงาน  
ที่รับผิดชอบ  

2.2.7 การพัฒนาระบบการแสดงผลการคาดการ์การไหลของน้ำในแม่น้ำ  
จัดทำระบบการแสดงผลการคาดการณ์การไหลในลักษณะของแผนที่ออนไลน์ที่ซ้อนทับได้ด้วย  ภาพถ่าย

ดาวเทียมในรูปแบบต่างๆ อาทิ แผนที่ภาพถ่ายดาวเทียม แผนที่ภูมิประเทศ แผนที่เส้นทางคมนาคม  
2.2.8 การจัดทำแผนที่เสี่ยงภัยแล้ง 
จัดทำแผนที่เสี่ยงภัยแล้งในพื้นที่ลุ่มน้ำซึ่งได้จากผลการศึกษาการไหลของแบบจำลองทางชล  ศาสตร์ใน

กรณีศึกษาที่ระดับความรุนแรงต่างๆ แสดงทิศทางการไหลของน้ำและพื้นที่ที่ขาดแคลนน้ำแบ่งช่วง  สีตามระดับ
ความรุนแรงของภัยแล้ง ซ้อนทับกับภาพถ่ายดาวเทียมเพ่ือแสดงให้เห็นถึงสภาพภูมิประเทศและสิ่งปลูกสร้างต่าง ๆ 
โดยมีมาตราส่วนที่สามารถมองเห็นได้ชัดเจน พร้อมทั้งจัดทำตารางสรุปพื้นที่ภัยแล้ง เป็นรายตำบล อำเภอ จังหวัด  

2.2.9 การศึกษาแนวทางการบริหารจัดการภัยแล้ง 
จัดทำแผนการบริหารจัดการภัยแล้ง จากองค์ประกอบและโครงการพัฒนาแหล่งน้ำที่มีอยู่ใน ปัจจุบัน เช่น 

อ่างเก็บน้ำ ประตูระบายน้ำ ได้แก่ การกำหนดเกณฑ์การเก็บกักน้ำที่เหมาะสมในแต่ละ ช่วงเวลา ขีดความสามารถ
ในการกักเก็บน้ำจากอ่างเก็บน้ำ การกำหนดระดับเฝ้าระวังและเตือนภัยในลำน้ำ สายสำคัญที่มีผลกระทบต่อชุมชน 
เป็นต้น  
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2.2.10 จัดทำข้อเสนอแนะการบริหารจัดการน้ำ  
เป็นการศึกษาเพื่อจัดทำข้อเสนอแนะการบริหารจัดการน้ำในพื้นที่ลุ ่มน้ำ ซี่งจะต้องทำการ  รวบรวม

โครงการพัฒนาแหล่ง 
ทั้งในปัจจุบันและที่อยู่ในแผนงานของหน่วยงานต่างๆ จำนวนและ ตำแหน่งสถานีตรวจวัดแบบอัตโนมัติ 

(สถานีโทรมาตร) เพื่อนำข้อมูลทั้งหมดมาจัดทำเป็นข้อเสนอในการ  บริหารจัดการน้ำทั้งในปัจจุบันและในอนาคต 
รวมถึงข้อเสนอในการติดตามสถานการณ์น้ำเพ่ือการเฝ้าระวังและเตือน 

2.3 การทบทวนเหตุการณ์ในอดีต 

ในการที ่จะพัฒนาระบบการไหลในแม่น้ำชีจำเป็นอย่างยิ ่งที ่จะต้องมีการทบทวนเหตุการณ์ในอดีต  
ที่ผ่านมาเพื่อจัดเก็บเป็นข้อมูลในการศึกษากรณีต่าง ๆ ที่จะมาประยุกต์ใช้เป็นแนวทางในการป้องกันและบรรเทา
ภัยที่อาจจะเกิดขึ้นอีกได้ในอนาคต ฉะนั้นจึงขอยกตัวอย่างกรณีสาเหตุการเกิดภัยแล้ง เนื่องจากปรากฏการณ์เอลนี
โญ เป็นปรากฏการณ์ธรรมชาติที่ปฏิสัมพันธ์ระหว่างการหมุนเวียนของกระแสอากาศกับกระแสน้ำในมหาสมุทร ซึ่ง
ป ก ต ิ แ ล ้ ว ใ น ม ห า ส ม ุ ท ร แ ป ซ ิ ฟ ิ ก ซ ึ ่ ง ก ั ้ น ร ะ ห ว ่ า ง ท ว ี ป เ อ เ ช ี ย แ ล ะ ท ว ี ป อ เ ม ร ิ ก า  
จะมีกระแสลมหรือเรียกว่าลมค้า (Trade winds) ซึ่งพัดจากด้านตะวันออกของมหาสมุทรแปซิฟิกไปยังด้าน
ตะวันตก ซึ่งจะทำให้กระแสน้ำอุ่นไหลจากอเมริกาใต้มายังประเทศอินโดนีเซีย ด้วยเหตุนี้จึงทำให้เกิดฝนตกใน
ภูมิภาคเอเชียตะวันออกเฉียงใต้ แต่หากกระแสลมมีกำลังอ่อนและเปลี่ยนทิศทางพัด จะทำให้กระแสน้ำอุ่นไหลไป
ยังทวีปอเมริกาใต้แทน ด้วยเหตุนี้ภูมิภาคเอเชียตะวันออกเฉียงใต้และออสเตรเลียจึงขาดฝนและเกิดความแห้งแล้ง 
รวมถึงไฟป่าอย่างรุนแรง กลายเป็นที่มาของปรากฏการณ์ “เอลนีโญ” 

ในการพิจารณาเงื่อนไขที่ใช้สำหรับศึกษา เริ่มจาก ปี พ.ศ. 2540 – 2541 เป็นปรากฏการณ์ที่รุนแรงที่สุด
ที่เคยมีการตรวจวัดมา มีการพัฒนาอย่างรวดเร็วและมีอุณหภูมิที่สูงกว่าทุกครั้ง เอลนีโญครั้งนี้พัฒนารวดเร็วมาก
ทั่วทั้งตอนกลางและตะวันออกของมหาสมุทรแปซิฟิกเขตร้อนช่วงเดือนเมษายนและพฤษภาคม 2540 และได้มี
กำลังแรงสูงที่สุดในเดือนมิถุนายน 2540 ในช่วงครึ่งหลังของปี 2540 เอลนีโญนี้มีกำลังแรงยิ่งกว่าเอลนีโญที่เกิดใน
ปี พ.ศ. 2525 – 2526 โดยมีอุณหภูมิผิวน้ำทะเลที่สูงกว่าปกติทั่วทั้งตอนกลางและตะวันออกของแปซิฟิก 2 – 5 
อ ง ศ า เ ซ ล เ ซ ี ย ส  อ ุ ณ ห ภ ู ม ิ ผ ิ ว น ้ ำ ท ะ เ ล ส ู ง เ ก ิ น ก ว ่ า  2 8  
องศาเซลเซ ียส ท ั ่ วท ั ้ งตอนกลางของแปซ ิฟ ิกเขตศ ูนย ์ส ูตรโดยเร ิ ่มต ั ้ งแต ่ เด ือนพฤษภาคม 2540  
โดยผลกระทบที่เกิดกับประเทศไทย ทำให้ความแห้งแล้ง มีฝนตกต่ำกว่าค่าปกติ 
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2.4. แนวคิด ทฤษฎี และสมมติฐานงานวิจัย 

2.4.1 การระเหยและการคายน้ำของพืช 

 ในเรื่องวัฏจักรของน้ำ หัวข้อที่มีความสำคัญและเป็นที่สนใจในการทำการเกษตร คือ การระเหยน้ำ และ
การคายน้ำของพืช โดยสามในสี่ของปริมาณน้ำจากฟ้าทั้งหมดที่โลกได้รับ กลับคืนสู่บรรยากาศโดยการ ระเหย และ
การคายน้ำ (Fang Meier et al.,2006) ปริมาณน้ำทั้งหมดที่สูญเสียไปจากแปลงพืช โดยการระเหยจากดิน (Soil 
evaporation) และการคายน้ำจากพืช (plant transpiration) เรียกว่า การคายระเหยน้ำ (Evapotranspiration, ET) 
การระเหยน้ำเป็นกระบวนการที่อาศัยพลังงานในการเปลี่ยนสถานะจากของเหลวไปเป็นไอน้ำ นักอุตุนิยมวิทยาได้
แบ่งการคายระเหยน้ำออกเป็น 2 ลักษณะด้วยกัน คือ 

2.4.1.1 การคายระเหยน้ำจริง (Actual evapotranspiration) หมายถึงปริมาณไอน้ำที่เกิดขึ้นจาก
การระเหยน้ำที่ผิวดินและการคายน้ำของพืชสู่บรรยากาศได้จริงในสภาวะอากาศขณะนั้นซึ่งปริมาณน้ำที่สูญเสียโดย
การคายระเหยน้ำนี้มีปัจจัยในการควบคุมหลายอย่างเช่น รังสีความร้อนจากดวงอาทิตย์ ความเร็วลม ปริมาณไอน้ำ
ในอากาศ คุณภาพน้ำ ชนิดพืช ความชื้นในดิน เป็นต้น 

2.4.1.2 การคายระเหยน้ำได้สูงสุด (Potential evapotranspiration) ปริมาณไอน้ำที่เกิดขึ้นจาก
การระเหยน้ำและการคายน้ำของพืชสู่บรรยากาศได้สูงสุดในสภาวะอากาศขณะนั้น ถ้ามีน้ำให้แก่กระบวนการคาย
ระเหยน้ำได้อย่างเหมาะสมเพียงพอปริมาณการคายระเหยน้ำได้สูงสุดนี้จะมีค่าสูงหรือเท่ากับปริมาณการคาย
ระเหยน้ำจริงเสมอ 

1) ปัจจัยที่ควบคุมการคายระเหยน้ำ 
ปริมาณการคายระเหยน้ำจะผันแปรไปตามลักษณะพื้นที่ชนิดป่าลักษณะอากาศความชื้นในดินและปัจจัย

ทางสรีรวิทยาของพืช (เกษม, 2539) ซึ่งวิชา (2535 ) ได้แบ่งปัจจัยที่ควบคุมการคายระเหยน้ำออกเป็น 3 ประเภท
ใหญ่ๆคือ 

(1) ปัจจัยที่เกี่ยวกับลักษณะอากาศ (meteorological factors) ปัจจัยที่เกี่ยวกับลักษณะอากาศ
ซ่ึง วิชา (2535 ) และเกษม (2522 ) สามารถจำแนกได้ดังนี้ 

- ปริมาณรังสีจากดวงอาทิตย์ (solar radiation) 
ปริมาณรังสีดวงอาทิตย์ที่ตกกระทบลงสู่ผิวโลกขึ้นอยู่กับลักษณะสิ่งแวดล้อมของโลกได้แก่ 

ตำแหน่งพื้นที่ผิวโลกฤดูกาลช่วงเวลาของวันสภาพของท้องฟ้าเป็นต้นโดยเฉลี่ยแล้วโลกได้รับความร้อนจากดวง
อาทิตย์ประมาณ 0.0487 วัตต์ต่อตารางเมตรจากการศึกษาของ Chunkao (1971) พบว่าปริมาณรังสีของรังสีคลื่น
สั้นจะมีความสัมพันธ์ต่ออุณหภูมิและการคายระเหยน้ำโดยตรงเมื่อโลกได้รับรังสีจากดวงอาทิตย์ในปริมาณมาก
อัตราการคายระเหยน้ำก็จะเพ่ิมข้ึนด้วย 
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- อุณหภูมิของอากาศ (air temperature) 
อุณหภูมิหมายถึงค่าที ่ใช้เพื ่อชี ้ให้เห็นถึงความสามารถในการเคลื ่อนย้ายความร้อนโดย

กระบวนการพาความร้อน (convection) อุณหภูมิของอากาศจะแปรผันตรงกับปริมาณรังสีจากดวงอาทิตย์ที่โลก
ได้รับอุณหภูมิของอากาศส่วนใหญ่ได้รับอิทธิพลจากดวงอาทิตย์แต่ก็มีบางทีเกิดจากโลกเช่นภูเขาไฟระเบิดน้ำพุร้อน
และอาจมาจากการใช้พลังงานของมนุษย์ถ้าอุณหภูมิของอากาศสูงโอกาสที่กลายเป็นไอน้ำอยู่ในก้อนอากาศหนึ่ง
หน่วยปริมาตรค่อนข้างสูงขึ้นนั่นหมายความว่าอุณหภูมิยิ่งสูงการคายระเหยยิ่งสูงขึ้นด้วย 

-  ความชื้นสัมพัทธ์ของอากาศ (relative humidity) 
ปริมาณความชื้นสัมพัทธ์ขึ้นอยู่กับปริมาณน้ำที่ระเหยกลายเป็นไอน้ำโดยทั่วไปความชื้นสัมพนัธ์

มีค่าต่ำลงเมื่ออุณหภูมิสูงขึ้นเนื่องจากไอน้ำในอากาศไม่พอเพียงและในช่วงที่อุณหภูมิสูงขึ้นอัตราการระเหยน้ำจะมี
มากขึ้นตามไปด้วย สำหรับในช่วงที่มีอากาศเย็นเช่นตอนกลางคืนความชื้นสัมพัทธ์จะมีค่ามากขึ้น อัตราการระเหย
น้ำมีค่าสูงข้ึนเมื่อความชื้นสัมพัทธ์มีค่าลดลง 

- การเคลื่อนที่ของลม (wind movement) 
ลมเป็นปัจจัยหนึ ่งที ่ทำให้อัตราการระเหยน้ำสูงขึ ้นเพราะว่าลมพัดมาไอน้ำจากบริเวณ  

ที่มีความชื้นสูงไปสู่บริเวณที่มีความชื้นต่ำ ได้ทำให้บริเวณที่เคยมีความชื้นสูงมีไอน้ำลดลงโอกาสที่น้ำจะระเหยก็มี
มากขึ้น ลมเป็นตัวพัดพาไอน้ำซึ่งมีการสะสมความร้อนของอากาศให้กระจายทั่วๆไปและลมจะพัดจากบริเวณที่มี
อากาศเย็นไปสู่ที่มีอากาศร้อน ทำให้อากาศเย็นลอยตัวขึ้น ความสามารถที่จะให้ไอน้ำในอากาศอยู่ในหนึ่งหน่วย
ปริมาตรมีมากขึ้นการระเหยน้ำก็จะมีมากข้ึนตามไปด้วย 

(2) ธรรมชาติของผิวหน้าในการระเหยน้ำ (nature of evaporating surface) การระเหยน้ำจะ
แตกตางกันตามชนิดของสสารต่างๆ (วิชา, 2535) ดังนี้ 

- พืชพรรณที่ปกคลุม (vegetative cover) 
พืชพรรณแต่ละชนิดมีความแตกต่างกันในการยึดน้ำเอาไว้และการคายน้ำออกสู่บรรยากาศซึ่ง

ขึ้นอยู่กับชนิดของพืช (species) ความหนาแน่นของพืชพรรณ (density) ระยะห่างระหว่างต้น (spacing) จำนวน
เปอร์เซ็นต์เรือนยอดปกคลุมดิน (ground cover) การกระจายของพันธุ์พืชในพ้ืนที่ (distribution) สัดส่วนของพันธุ์
พืชในพื้นที่ (proportion of species) เป็นต้นพืชพันธุ ์ชนิดใดสามารถยึดน้ำไว้ได้มากโอกาสที่จะสูญเสียน้ำสู่
บรรยากาศโดยการระเหยก็มีมากขึ้นด้วยและพืชพันธุ์ที่มีอัตราการคายน้ำสูงการสูญเสียน้ำก็มีมากเช่นกัน 

- สิ่งก่อสร้างที่สัมผัสกับฝน (infrastructure) 
สิ่งก่อสร้างในที่โล่งมีโอกาสสัมผัสกับฝนและผิวของสิ่งก่อสร้างเช่นหลังคาบ้านถนนลานจอดรถ

สนามกีฬาเป็นต้นจะดูดซับน้ำไว้และสูญเสียให้กับบรรยากาศต่อไปโดยไม่มีโอกาสที่จะซึมลงสู่ดิน 
- การอ่ิมตัวของผิวหน้าการระเหย (saturation of evaporating surface) 
ผิวหน้าของสารใดที่อิ่มตัวด้วยน้ำก็เปรียบเสมือนผิวหน้าน้ำนั่นเองหรือเป็นผิวหน้าอิสระที่จะ

ระเหย (free water surface) โอกาสที่น้ำจะระเหยเท่ากับจำนวนผิวหน้าของผิวน้ำอิสระท่ีเกิดข้ึน 
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(3) ปัจจัยที่เกี่ยวกับสรีระวิทยาของพืช (plant physiology) ปัจจัยที่เกี่ยวกับสรีระของพืชที่มี
ผลต่อการคายระเหยน้ำในรูปของการคายน้ำจากปากใบของพืชซึ่งมีปัจจัยในการควบคุมดังนี้ 

- ลักษณะอากาศ (meteorological factors) 
ลักษณะอากาศได้แก่รังสีดวงอาทิตย์อุณหภูมิของอากาศความเร็วลมความชื้นสัมพัทธ์ของอากาศ

จำนวนชั่วโมงที่พืชได้รับแสงแดดเป็นต้นซึ่งปัจจัยเหล่านี้มีผลต่อการสังเคราะห์ด้วยแสงของพืชพืชต้องการคายน้ำ
เพ่ือลดความร้อนและเพ่ือดูดแร่ธาตุขึ้นมาใช้และคายน้ำออกทางปากใบ 

-  สภาพความชื้นในดิน (soil moisture condition) 
ปริมาณความชื ้นในดินเป็นตัวจำกัดการคายน้ำได้อย่างมากถ้าสภาพความชื ้นในดินมีน้อย  

พืชพรรณก็ต้องเก็บไว้ใช้มากกว่าที่จะปล่อยไปเพ่ือการคายน้ำหรือกล่าวได้ว่าการคายน้ำจะผันแปรตามความชื้นดิน 
การคายน้ำเป็นกระบวนการหลักที ่กระตุ ้นให้พืชดูดน้ำทวนทิศทางการดึงดูดของโลกและ  

Frictional resistance ในทางลำเลียงภายในต้นพืช อัตราการดูดน ้ำจะถูกควบคุมโดยอัตราการคายน้ำ  
เป็นหลัก ส่วน Root pressure ซึ่งเป็น Active absorption ของน้ำจะมีความสำคัญน้อยกว่าในการดูน้ำ และ
ความสำคัญจะเด่นชัดก็ต่อเมื ่อพืชมีการคายน้ำหรือหยุดการคายน้ำเท่านั ้น (นวรัตน์, 2541) การระเหย 
(evaporation) หมายถึงการที่น้ำมีการเปลี่ยนแปลงสถานะไปเป็นไอน้ำ หรือโมเลกุลของน้ำไปเป็นไอ ล่องลอยไปสู่
อ า ก าศ  น ้ ำ หน ึ ่ ง ก ร ั ม ร ะ เ หย กล าย เ ป ็ น ไ อ  ต ้ อ ง ก า รคว าม ร ้ อน  2 . 5  kJ ( ห ร ื อ  5 00  แคลอ รี )  
โดยได้รับความร้อนจากรังสีแสงอาทิตย์ ความร้อนจากบรรยากาศชั้นบน หรือความร้อนจากใต้พิภพเป็นสำคัญ 
(สายสุนีย์,2546) การระเหยและการคายน้ำของพืช ซึ่งเรียกรวมกันว่า การคายระเหยน้ำของพืช (ET) จะใช้เป็น
ข้อมูลในการหาปริมาณการใช้น้ำของพืช ซึ่งมีวิธีการตรวจวัดต่างๆ เช่น (1) ใช้ถังวัดการใช้น้ำหรือ Lysimeter ใน
การศึกษา (2) การตรวจวัดในแปลงโดยการวัดปริมาณน้ำเข้า-ออก ในพื้นที่ศึกษาขนาดเล็ก (3) การศึกษาจาก
ปริมาณน้ำในดินหรือความชื้นดิน (4) ศึกษาจากข้อมูลทางภูมิอากาศ (5) ศึกษาจากปริมาณการใช้น้ำของพืชและ
การระเหยน้ำจากผิวน้ำและผิวดิน (6) ศึกษาปริมาณน้ำที่เข้า-ออก พ้ืนที่ศึกษาซึ่งเป็นพ้ืนที่ขนาดใหญ่ และใช้ระยะ
เวลานาน (Allen et al.,1998) สิทธิพร (2536) กล่าวว่าสิ่งสำคัญที่ควบคุมการระเหยของพื้นผิวดินและผิวน้ำ คือ 
ความชื้นในบรรยากาศ ลม และความร้อนจากดวงอาทิตย์ ซึ่งจะเป็นตัวควบคุมการระเหยจากแปลงพืชด้วยน้ำส่วน
ใหญ่ที่พืชดูดเข้าไปจะถูกคายออกมาทางใบโดยผ่านรูเล็กๆ ตามผิวใบเรียกว่า stomata กรรมวิธีนี้เรียกกว่าการคาย
น ้ ำ  ซ ึ ่ ง เ ป ็ น ส ่ ว น ห น ึ ่ ง ข อ ง ว ั ฏ จ ั ก ร ข อ ง น้ ำ  
โดยความแตกต่างของความเข้มข้นระหว่างน้ำหล่อเลี้ยงที่อยู่ในเซลล์ของรากพืช และน้ำที่อยู่ในดิน ทำให้เกิดความ
ดัน osmotic ทำให้น้ำในดินสามารถเคลื่อนผ่านเนื้อเยื่อของรากพืชเข้าไปในเซลล์รากพืชได้ จากนั้นจะเคลื่อนตัวไป
ยัง intercellular space ในขณะที่อากาศเคลื่อนตัวเข้าสู่ใบ น้ำที่จะถูกปล่อยออกผ่านทาง Stomata (สายสุนีย์, 
2546) potential evapotranspiration จะมีค่ามากกว่า เท่ากับ หรือน้อยกว่า ค่าของevapotranspiration ก็ได้ 
ทั้งนี้ ขึ้นอยู่กับองค์ประกอบต่างๆ ความชื้นในดินระหว่างฤดูกาลเพาะปลูก หรือชนิดของพืชที่ปลูก เป็นต้น (ราสินี, 
2539) การสูญเสียน้ำสู่บรรยากาศถูกกำหนดโดยทั้งปัจจัยแวดล้อมและปัจจัยพืช ผลของปัจจัยแวดล้อมต่อการคาย
ระเหยน้ำเรียกว่า atmospheric demand หรือ evaporatory demand ยิ่ง atmospheric demand สูง การ
สูญเสียน้ำก็ยิ่งเร็ว ปัจจัยที่กล่าวถึงต่อไปนี้มีอิทธิพลต่อ atmospheric demand (นวรัตน์, 2541) 
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1. แสงอาทิตย์ (solar radiation) จากแสงอาทิตย์ทั้งหมดที่ถูกดูดซับไว้โดยใบพืชเพียงร้อยละ 1 ถึง 
5 เท่านั้นที่ถูกนำไปใช้เพื่อการสังเคราะห์แสง ร้อยละ 75 ถึง 85 จะไปทำให้อุณหภูมิใบเพิ่มขึ้นและทำให้เกิดการ
คายน้ำ แสงอาทิตย์เพ่ิมข้ึนจึงไปทำให้ atmospheric demand เพ่ิมข้ึน 

2. อุณหภูมิ (temperature) การที่อุณหภูมิเพิ่มขึ้นจะไปมีผลให้ความสามารถของอากาศในการ อุ้ม
น้ำมากขึ้น ซึ่งหมายถึง atmospheric demand สูงขึ้น 

3. ความชื ้นสัมพันธ์ (relative humidity) ปริมาณน้ำในอากาศเพิ ่มขึ ้นทำให้ air เพิ ่มขึ ้น ซึ่ง
หมายความว่า atmospheric demand ลดลงเมื่อความชื้นสัมพัทธ์เพิ่มข้ึน 

4. ลม (wind) การคายน้ำเกิดข้ึนเมื่อน้ำมีการแพร่ออกจากปากใบ เมื่อลมสงบจะทำให้เกิด diffusion 
gradient barrier รอบๆ ปากใบ ทำให้การคายน้ำลดลง เมื่อลมพัดพาเอาความชื้นรอบๆ ใบออก จะทำให้เกิด
ความแตกต่างมากขึ้นระหว่าง water potential ภายในใบและนอกปากใบ และมีผลให้การแพร่ของน้ำออกจากใบ
มากขึ้น 

วิธีการหาอัตราการระเหยที่ใช้ในปัจจุบันที่ได้เลือกมาเปรียบเทียบกับอัตราการระเหยที่ประเมินจาก
ภาพถ่ายดาวเทียม ได้แก่ การหาอัตราการระเหยโดยวิธี FAO Penman-Monteith (Allen et al.,1998) และการ
หาอัตราการระเหยโดยใช้ถาดวัดการระเหย class A (Doorenbos and Pruitt, 1977) อัตราการระเหยที่หาจาก
วิธ ี Penman-Monteith นั ้น เป็นอัตราการระเหย หรือปริมาณการใช้น้ำของพืชอ้างอิง ( reference crop 
evapotranspiration, To) ซึ่งมีสมมติฐานว่าเป็นอัตราการระเหยจากหญ้าที่ปกคลอมดินสม่ำเสมอและมีน้ำไม่
จำกัด และอัตราการระเหยที่หาจากถาดวัดการระเหยได้ใช้ค่าปรับแก้มาเป็นปริมาณการใช้น้ำของพืชอ้างอิง
เช่นเดียวกัน (เอกสิทธิ์,2547) 

2.4.2. ปริมาณการใช้น้ำของพืช 
ปริมาณการใช้น้ำของพืชเป็นข้อมูลที ่สำคัญอย่างยิ ่งที ่ผ ู ้ออกแบบระบบชลประทานและโครงการ

ชลประทานจำเป็นจะต้องทราบ เพราะปริมาณการใช้น้ำของพืชนี้จะเข้ามาเกี่ยวข้องกับปริมาณและความถี่  
ในการให้น้ำ การออกแบบขนาดอาคารชลประทาน การจัดหาน้ำมาให้กับโครงการชลประทาน ตลอดจนการศึกษา
ว่าโครงการชลประทานนั ้นจะให้ผลที ่ค ุ ้มค่าหรือไม่ด้วยปริมาณการใช้น้ำของพืชที ่ภาษาอังกฤษเรียกว่า 
consumptive use of water หรือ evapotranspiration เป็นปริมาณน้ำทั้งหมดที่สูญเสียจากพื้นที่เพาะปลูกสู่
บรรยากาศในรูปของไอน้ำ ปริมาณดังกล่าวนี้ประกอบด้วยส่วนใหญ่ๆ สองส่วน (วิบูลย์,2526) 

2.4.2.1 ปริมาณน้ำที่พืชดูดไปจากดิน นำไปใช้สร้างเซลล์ และเนื้อเยื่อแล้วคายออกทางใบสู่
บรรยากาศ ซึ่งเรียกว่า การคายน้ำ (transpiration) 

2.4.2.2 ปริมาณน้ำที่ระเหยจากผิวดินบริเวณรอบๆ ต้นพืช จากผิวน้ำในขณะให้น้ำหรือขณะที่มีน้ำ
ขังอยู่และจากน้ำท่ีเกาะอยู่ตามใบเนื่องจากฝนหรือการให้น้ำซึ่งเรียกว่า การระเหย (evaporation) 

วิบูลย์ (2526) กล่าวว่า การใช้น้ำของพืชเมื่อดินมีความชื้นมากพอคลอดเวลานั้น ขึ้นอยู่กับสภาพอากาศ
รอบๆ ต้นพืช ชนิดของพืช และช่วงการเจริญเติบโด (growth stages) โดยปกติแล้วพืชมีการใช้น้ำน้อยที่สุดเมื่อเริ่ม
เพาะปลูกและเพิ่มขึ้นเรื่อย ๆ จนกระทั้งมากที่สุดเมื่อพืชเจริญเติบโตเต็มที่ และจะค่อยๆ ลดลงเมื่อพืชออกผล ผล
แก่ และถึงเวลาเก็บเกี่ยว เราอาจแบ่งการเจริญเติบโตของพืชออกเป็น 3 ช่วงด้วยกันคือ ช่วงเจริญเติบโตทางลำต้น
และใบ (vegetative Stage) ช่วงออกดอก (flowering Stage) และช่วงออกผล (fruiting Stage) สำหรับช่วงการ
ผลิใบยังแบ่งออกเป็นสองช่วงย่อย คือ เมื่อพืชยังอ่อนอยู่ และเม่ือพืชมีการแตกก่ิงก้านอย่างเต็มที่แล้ว ส่วนช่วงออก
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ผลอาจแบ่งออกเป็น 2 ช่วง ได้เช่นกัน คือ ช่วงที่ผลและเมล็ดยังสดอยู่ (wet fruiting stage) และช่วงที่เมล็ดหรือ
ผลเริ่มแห้ง (dry fruiting stage) ซึ่งพืชจะต้องการน้ำน้อยมาก (Allen, 1998) กล่าวว่า ช่วงเวลาที่พืชต้องการน้ำ
มากที่สุดจะแตกต่างกันไปตามชนิดของพืชถึงแม้ว่าตลอดช่วงการเจริญเติบโตของพืช พืชจะให้น้ำอย่างต่อเนื่อง แต่
อัตราการใช้น้ำจะขึ้นอยู่กับ ชนิดของพืช ระดับการเจริญเติบโต และสภาพภูมิอากาศ เช่น ความเข้มแสง อุณหภูมิ 
ลม และความชื้น 

2.4.3 การหาปริมาณการใช้น้ำของพืช 
ปริมาณการใช้น้ำของพืช (consumption use) คือปริมาณน้ำทั้งหมดที่สูญเสียไปจากพื้นที่เพาะปลูกซึ่ง

ประกอบด้วยปริมาณน้ำที่พืชดูดไปจากดินเพื่อนำไปใช้ในการสร้างเซลล์และเนื้อเยื่อแล้วคายออกสู่บรรยากาศ 
(transpiration) รวมถึงปริมาณน้ำที่ระเหยออกจากผิวดินและผิวน้ำ (evaporation) (วิบูลย์, 2526) 

Allen et al. (1998) สรุปปริมาณการใช้น้ำของพืชว่าขึ้นกับปัจจัย 3 ปัจจัยต่อไปนี้คือ 
2.4.3.1 พืชเป็นปัจจัยหนึ่งที่สำคัญในการประเมินการใช้น้ำที่แตกต่างกันไปโดยขึ้นกับชนิดและช่วง

อายุของพืชการใช้น้ำของพืชจะน้อยเมื่อเริ่มต้นปลูกและเพ่ิมสูงขึ้นเรื่อย ๆ จนมากที่สุดเมื่อพืชโตเต็มที่และอยู่ในวัย
ขยายพันธุ์จากนั้นความต้องการน้ำจะค่อยๆลดลง (วิบูลย์, 2526) 

2.4.3.2 สภาพภูมิอากาศรอบต้นพืชได้แก่รังสีแสงอาทิตย์อันมีความสัมพันธ์กับการระเหยน้ำออก
จากดินรวมถึงสภาพอุณหภูมิและความชื้นสัมพัทธ์ในอากาศทั้งนี้เพราะพลังงานรังสีจะก่อให้เกิดความร้อนขึ้นใน
วัตถุความร้อนส่วนหนึ่งจะถูกระบายออกในรูปความร้อนแฝงซึ ่งทำให้เกิดการระเหยน้ำออกสู่ บรรยากาศ 
(คณาจารย์ภาควิชาปฐพีวิทยา, 2541) 

2.4.3.3 ดินได้แก่ความชื้นในดินดินที่มีระดับความชื้นใกล้เคียงจุดความจุสนาม  (field capacity, 
FC) เป็นจุดที่ดินมีความชื้นเหมาะสมและพืชใช้ประโยชน์ได้ระดับความชื้นในดินที่สูงมีผลต่อระดับพลังงานศักยน์้ำ
ที่สูงด้วยซึ่งส่งผลให้น้ำไหลจากดินเข้าไปในรากพืชได้ง่ายขณะที่พืชกำลังดูดน้ำนอกจากนี้ความหนาดินชั้นรากพืชยัง
มีผลต่อแหล่งปริมาณน้ำกักเก็บสำรองสำหรับพืชโดยความหนาดินชั้นรากที่มากมีผลต่อปริมาณน้ำสำรองสำหรับพืช
ใช้มากด้วยสุดท้ายคือลักษณะเนื้อดินและสภาพนำน้ำในดินซึ่งเป็นตัวบ่งชี้ถึงการปลดปล่อยน้ำและเคลื่อนที่ของน้ำ
ในดินไปยังพืช (คณาจารย์ภาควิชาปฐพีวิทยา, 2541) 

การประเมินหาปริมาณการใช้น้ำของพืช โดยใช้ข้อมูลจากภูมิอากาศโดยมีหลักการและแนวคิดที่ว่าปริมาณ
การใช้น้ำของพืชจะมีปริมาณมากหรือน้อยเพียงใดขึ้นอยู่กับองค์ประกอบที่สำคัญ 4 อย่าง คือ สภาพของดิน ชนิด
ของอายุของพืช สภาพภูมิอากาศรอบๆ ต้นพืช และการจัดการเพาะปลูก สามารถเลือกใช้สมการใดสมการหนึ่งที่
เหมาะสมกับข้อมูลทางภูมิอากาศที่มีอยู่จาก 3 วิธี ดังต่อไปนี้ 

1). วิธีที่หนึ่ง โดยใช้ข้อมูลศักย์การคายระเหยน้ำของพืช หรือปริมาณการใช้น้ำ ของพืชอ้างอิง (ETo) 
และค่าสัมประสิทธิ์การใช้น้ำของพืช หลักการในการดำเนินการก็คือ ให้พืชมีการเจริญงอกงามดีมีอัตราการ ใช้น้ำ
ตลอดเวลา แต่ผลของการใช้น้ำของพืชจะไม่มีผลกระทบต่อการจัดการเพาะปลูกหรือองค์ประกอบอื่น ๆ ทั้งนี้ เพื่อให้
การใช้น้ำของพืชที่เลือกมาศึกษาขึ้นอยู่กับสภาพภูมิอากาศเพียงอย่างเดียวเท่านั้น ซึ่งพืชที่มีคุณสมบัติดังกล่าวนี้
ม า ก ท ี ่ ส ุ ด ก ็ ค ื อ ห ญ ้ า  แ ล ะ ต ่ อ ม า ก ็ ม ี ก า ร ใ ช ้ พ ื ช อ ื ่ น ๆ  อ ี ก  เ ช ่ น  อ ั ล ฟ ั ล ฟ า  
มาทำการศึกษา เรียกว่าการใช้น้ำของพืชอ้างอิงที่เลือกมาปลูกในดินที่มีความชื้นสูงตลอดเวลา เพื่อให้อัตราการใช้
น้ำขึ้นอยู่กับสภาพภูมิอากาศเพียงอย่างเดียวว่าการใช้น้ำของพืชอ้างอิง หรือศักย์การใช้น้ำของพืช หรือศักย์การคาย
ระเหยของน้ำตรงกับภาษาอังกฤษว่า potential evapotranspiration และนิยมใช้ตัวย่อว่า ETo  
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(ธีระพงษ์,2538) ในการหาค่าการใช้น้ำของพืชมาตรฐานส่วนใหญ่จะทำการคำนวณจากข้อมูลภูมิอากาศ
โดยใช้สูตรคำนวณโดยเฉพาะสูตร Penman จะมีการใช้อย่างแพร่หลายและมีการพัฒนาตลอดเวลาซึ่งในปี 1990 
ทางผู้เชี่ยวชาญของ FAO ได้แนะนำให้ใช้สูตร Penman Monteith โดยในต่างประเทศถือว่า Penman Monteith 
น่าจะเป็นวิธีการคำนวณ ETo ที่ถูกต้องแม่นยำมากกว่าวิธีอ่ืนๆสำหรับประเทศไทยยังมีการใช้ไม่แพร่หลายดังนั้นถ้า
นำสูตรดังกล่าวมาปรับปรุงค่าสัมประสิทธิ์บางค่าตามสภาพภูมิอากาศของประเทศไทยแล้วคาดว่าสูตรนี้ได้รับความ
นิยมในการนำไปใช้ประโยชน์ทั้งทางด้านเกษตรและการจัดการการชลประทานทั่วไป จากหลักดังกล่าวสามารถ
คำนวณศักย์การคายระเหยน้ำของพืช หรือปริมาณการใช้น้ำ ของพืชอ้างอิง (ETo) ในสมการที่ (8) 
 ค่าสัมประสิทธิ์การใช้น้ำของพืชหรือ Kc เป็นค่าที่ข้ึนอยู่กับชนิดและอายุของพืชเพียงอย่างเดียวค่าดังกล่าว
นี้ได้จากการทดลองวัดจริงๆ ในสนาม โดยการปลูกหญ้าหรือพืชอ้างอิงอื่นๆ และพืชที่ต้องการหาค่าสัมประสิทธิ์
การใช้น้ำของพืชในช่วงการเจริญเติบโตช่วงใดช่วงหนึ่งหรือตลอดฤดูกาลเพาะปลูก  เนื่องจากสภาพภูมิอากาศ 
คุณสมบัติของดินและองค์ประกอบอื่นๆ คล้ายคลึงกัน ดังนั้น ค่า Kc จึงขึ้นอยู่กับชนิดและอายุของพืชเพียงอย่าง
เดียว เพราะฉะนั้นค่าที่วัดได้นี ้สามารถนำไปใช้ได้โดยทั่วๆ ไป โดยไม่ขึ ้นอยู่กับสถานที่เพาะปลูกหรือสภาพ
ภูมิอากาศ โดยรอบนั้น คือ ถ้าหากเราคำนวณ ETo โดยใช้ข้อมูลภูมิอากาศได้แล้ว ถ้าเราต้องการจะทราบปริมาณ
ความต้องการใช้น้ำของพืชใด ก็เอาค่า Kc ของพืชที่ต้องการทราบมาคูณกับค่า ETo ก็จะได้ปริมาณการใช้น้ำของพืช 
ดังนั้น เมื่อมีข้อมูลการคายระเหยน้ำของพืชหรือปริมาณการใช้น้ำของพืชอ้างอิง (ETo) และค่าสัมประสิทธิ์การใช้น้ำ
ของพืช (Kc) สามารถหาอัตราการคายระเหยของน้ำจริงของแปลงพืชชนิดอื่นที่ไม่ใช้พืชอ้างอิง ดังในสมการท่ี (7) 

2). วิธีที่สอง โดยใช้ค่าปริมาณการระเหยน้ำจากถาดวัดการระเหยแบบเอ (Epan) สัมประสิทธิ์ถาด
วัดการระเหย สำหรับถาดวัดแบบ เอ (Kp) และสัมประสิทธิ์การใช้น้ำของพืช (Kc) หลักการระเหยน้ำเป็นการ
แพร่กระจายไอน้ำสู่บรรยากาศ แต่เนื่องจากการคายน้ำของพืชนั้นจะถูกควบคุมโดยการเปิดปิดของรูปากใบ
แตกต่างกันจากการระเหยจากผิวน้ำไม่มีอะไรควบคุมเลย ดังนั้น จึงจำเป็นต้องใช้ค่าสัมประสิทธิ์มาคูณกับค่าการ
ระเหยจากถาดวัดการระเหย ตามปกติมักใช้ถาดที่เรียกว่า Class A pan ของกรมอุตุนิยมวิทยาสหรัฐอเมริกา 

ส่วนประกอบของถาดวัดการระเหยน้ำแบบ เอ ได้แก่ ถาดน้ำ ขอวัดระดับน้ำ และที่รองรับขอวัดระดับน้ำ ถาด
น้ำนี้มีลักษณะทรงกลมเส้นผ่าศูนย์กลาง 120.7 เซนติเมตร มีความลึก 25 เซนติเมตร วัสดุที่นิยมใช้ คือ เหล็ก
เคลือบสังกะสี (เบอร์ 22) ตัวถาดตั้งอยู่บนฐานไม้ซึ่งมีความสูง 15 เซนติเมตร จากฐานดินและฐานดินนี้ควรจะสูง
กว่าระดับเดิมเล็กน้อย ถาดน้ำที่ติดตั้งแล้วควรอยู่ในแนวระดับ ระดับน้ำในถาดควรรักษาให้อยู่ในระดับที่คงที่ คือ 
ที่ระดับความลึกจากขอบประมาณ 5 เซนติเมตร และ 
ไม่ควรลดต่ำลงกว่า 7.5 เซนติเมตร ทั้งนี้ ก็เพราะว่าจะทำให้เกิดลมหมุนเหนือผิวน้ำระเหยแตกต่างกันซึ่งจะเป็นตัว
กระเทือนต่อปริมาณการระเหยน้ำ (สิทธิพร,2536) ทำการตรวจวัดการระเหยน้ำของถาดวัดทุกวันและตรวจวัดใน
เวลาเช้า และเป็นเวลาเดียวกับการเก็บข้อมูลปริมาณน้ำฝน ที่รองรับขอวัดมีลักษณะเป็นรูปทรงกระบอกกลวงทำ
ด้วยโลหะมีเส้นผ่าศูนย์กลางประมาณ 10 เซนติเมตร ลึก 20 เซนติเมตร และยึดติดอยู่กับฐาน ซึ่งจะช่วยป้องกันการ
ก ร ะ เ พ ื ่ อ ม ข อ ง ผ ิ ว น ้ ำ ข ั ้ น ต อ น ก า ร ว ั ด โ ด ย ก า ร ว า ง ข อ ว ั ด ร ะ ด ั บ น ้ ำ ล ง บ น ท ี ่ ร อ ง ร ั บ ข อ วั ด  
เลื่อนก้านขอวัดขึ้นลงให้ปลายขอจมลงใต้น้ำเล็กน้อย แล้วหมุนให้ปลายขอเลื่อนขึ้นมาช้าๆ จนแตะผิวน้ำ จากนั้นก็
ยกขอวัดระดับน้ำข้ึนมา อ่านขีดสเกลบนก้านขอวัดและแป้นกลางตามลำดับ (Doorenbos and Pruitt,1977)  
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โดยสรุปเมื่อมีข้อมูลปริมาณการระเหยน้ำจากถาดวัดการระเหยแบบ เอ (Epan) ซึ่งอ่านค่าได้จากอุปกรณ์นี้ที่ติดตั้ง
ในแปลงพืชและสัมประสิทธิ์ถาดวัดการระเหยสำหรับ ถาดวัดแบบ เอ (Kp) สัมประสิทธิ์การใช้น้ำของพืช (Kc) สามารถ
หาปริมาณการใช้น้ำของพืชได้จาก 

 ETc = Kp x Epan x Kc     (9) 
  เมื่อ ETc = เป็นการใช้น้ำของพืช 
   Kp = สัมประสิทธิ์ถาดวัดการระเหย แบบ เอ 
   Epan = ปริมาณการระเหยน้ำจากถาดวัดการระเหย 
   Kc = สัมประสิทธิ์การใช้น้ำของพืช 

เครื่องมือที่ใช้วัดการระเหยอาจแบ่งได้ออกเป็นสองแบบด้วยกันคือแบบที่เป็นถาดบรรจุน้ำหรือที่เรียกว่า
ถาดวัดการระเหย (Evaporation Pan) ซึ่งยอมให้น้ำระเหยจากผิวน้ำโดยตรงและแบบที่ให้น้ำระเหยจากผิววัตถุที่
พรุนซึ่งเปียกน้ำถึงแม้ว่าการระเหยของน้ำจะไม่เหมือนกับคายน้ำของพืชแต่ขบวนการของทั้งสองอย่างคล้ายคลึงกัน
มากกล่าวคือเป็นการแพร่กระจายของไอน้ำสู่บรรยากาศแต่การคายน้ำจะถูกควบคุมโดยการปิดเปิดของรู ใบใน
ขณะที่การระเหยจากผิวน้ำไม่มีอะไรควบคุมเลยเนื่องจากว่าสภาพภูมิอากาศทุกอย่างเช่นรังสีจากดวงอาทิตย์
อุณหภูมิความชื้นสัมพัทธ์ความเร็วของลมเป็นต้นที่มีผลต่อการคายน้ำก็มีผลต่อการระเหยของน้ำจากถาดวัดการ
ระเหยด้วยเช่นกันดังนั้นถาดวัดการระเหยที่ได้รับการติดตั้งอย่างถูกต้องจึงใช้เทียบหาปริมาณการใช้น้ำของพืช
ในช่วงสั้นๆได้อย่างละเอียดถูกต้องกว่าสูตรเอมไพริกัลที่ใช้ข้อมูลภูมิอากาศเพียงอย่าง เดียวหรือหลายอย่าง
นอกจากนั้นถาดวัดการระเหยยังใช้ง่ายและราคาถูกอีกด้วย (วิบูลย์, 2526) 

3). วิธีที ่สาม โดยใช้ข้อมูลปริมาณการระเหยน้ำจากถาดวัดการระเหยแบบ เอ (Epan) และ
สัมประสิทธิ์ถาดวัดแบบ เอ (K’p) แนวคิดของการหาปริมาณการใช้น้ำโดยวิธีนี้มาจากเมื่อมีข้อมูล Epan หรือ
ปริมาณการระเหยน้ำจากถาดวัดการระเหยแบบ เอ เพียงอย่างเดียวเท่านั้น แต่ไม่มีข้อมูลทั้ง ETo หรือปริมาณการ
ใช้น้ำของพืชอ้างอิง และ Kc หรือสัมประสิทธิ์การใช้น้ำ ในกรณีนี้ได้มีผู้แนะนำให้หาปริมาณใช้น้ำของพืชโดยการ
คำนวณจากค่าของ K’p หรือสัมประสิทธิ์ของถาดวัดการระเหยแบบเบ็ดเสร็จสำหรับถาดวัดแบบ เอ แทนค่า Kc 
และ Kpโดยใช้สมการ (ดิเรก และคณะ,2545) 

ETc = Epan x K’p      (10) 
  เมื่อ ETc = เป็นการใช้น้ำของพืชที่ต้องการทราบ 
   Epan = ปริมาณการระเหยน้ำจากถาดวัดการระเหยแบบ เอ 
   K’p = สัมประสิทธิ์ของถาดวัดการระเหยแบบเบ็ดเสร็จ 

สำหรับความต้องการน้ำเพ่ือการเพาะปลูกข้าวแบ่งออกได้เป็น 2 ส่วนคือความต้องการน้ำเพ่ือการเตรียมแปลงและ
ความต้องการน้ำเพื่อการเจริญเติบโตของต้นข้าว ความต้องการน้ำเพื่อการเตรียมแปลงชูพันธุ์  (2547) อ้างถึงดิเรก 
(2528) กล่าวว่าความต้องการน้ำที ่ใช้เตรียมแปลงสำหรับการเพาะปลูกข้าวรวมทั้งสิ ้นประมาณ  200 – 350 
มิลลิเมตร ความต้องการน้ำเพ่ือการเจริญเติบโตของต้นข้าวขึ้นอยู่กับปริมาณของน้ำที่ต้องสูญเสียไป 3 ทางด้วยกัน
คือการระเหย (evaporation) การคายน้ำ (transpiration) และการซึมลงไปในดิน (percolation) โดยปริมาณ
การใช้น้ำของข้าวที่ตรวจวัดจากถังวัดการใช้น้ำ (lysimeter) ของสถานีค้นคว้าและวิจัยการใช้น้ำชลประทานกรม
ชลประทานประมาณวันละ 4 - 7 มิลลิเมตรในฤดูฝนและประมาณวันละ 5 - 9 มิลลิเมตร ในฤดูแล้งส่วนการซึมลง



30 
 

ไปในดินทั้งแนวราบและแนวดิ่งขึ้นอยู่กับสภาพของดินชนิดของดินสภาพความลึกของชั้นดินและระดับน้ำใต้ดินเช่น
ดินเหนียวและมีระดับน้ำใต้ดินตื้นจะมีการสูญเสียน้ำประมาณวันละ 1 - 2 มิลลิเมตรแต่ถ้าสภาพเป็นดินทรายและ
มีระดับน้ำใต้ดินอยู่ลึกอาจจะมีการสูญเสียน้ำถึงประมาณวันละ 7 - 10 มิลลิเมตร (ดิเรก, 2526) 

2.4.4. ทฤษฎีการคำนวณปริมาณน้ำของพืช 
2.4.4.1 วิธีการคำนวณปริมาณน้ำที่พืชใช้การคายระเหยของพืช 

ค่าการคายระเหยของพืช (Evapotranspiration, ETc มีหน่วยมิลลิเมตร/วัน) (mm/day) คำนวณจาก 

    ocsc ETKKET =      (1) 
โดยท ี ่  ETo ค ื อ ค ่ าการคายระเหยอ ้ างอ ิ งของพ ื ช  (Reference Crop Evapotranspiration, ETo  

มีหน่วยมิลลิเมตร/วัน (mm/day) คำนวณได้จากสมการ Penman-Monteith FAO 56. (Allen et al., 1998) ดังนี้  
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    (2) 
เมื่อ การคายระเหยอ้างอิง (ETo, mm/day) ได้จากค่าคงที่ 0.408 ความชันของเส้นโค้งความดันไออ่ิมตัว 

(∆, kPa/Celsius) รังสีสุทธิ (Rn, MJ/m2/day) ฟลักซ์ของการถ่ายเทความร้อนของดิน (G, MJ/m2/day) ค่าคงที่

ไซโครเมติก ( , kPa/Celsious) ค่าคงที่ 900 อุณหภูมิเฉลี่ย (T, Celsious) ค่าคงที่การเปลี่ยนหน่วย 273 ความเร็ว
ลมที่ความสูง 2 เมตร (U2 ,m/s) ความดันไออ่ิมตัวเฉลี่ย (es, kPa) ความดันไอจริง (ea, kPa) ความเร็วลมที่ความ
สูง 2 เมตร (U2 ,m/s) และ Kc คือค่าสัมประสิทธิ์พืช (Crop Coefficient) ซึ่งช่วงการเจริญเติบโตของพืชนั้นสมมติ
ให้ค่า Kc มีค่าเพิ่มขึ้นเป็นเส้นตรงจากช่วง เริ่มต้นการเพาะปลูก (Kc,ini) ถึงช่วงกลางของการเพาะปลูก (Kc,mid) 
และมีค่าคงที่ไปจนถึงระยะสุดท้ายของการเพาะปลูกสมมติให้ค่า Kc ลดลงเป็นเส้นตรงจาก Kc,mid ไปจนถึง 
Kc,end 

Ks คือ สัมประสิทธิ์ความเครียดน้ำ (Water Stress) โดยมีค่าอยู่ระหว่าง 0 ถึง 1 ในกรณีที่น้ำในดินในเขต
รากพืชมีค่าการพร่อง (Depletion, Drมีหน่วย mm) น้อยกว่าปริมาณน้ำที่มีอยู่ที่ใช้การได้ (Readily available 
soil water in the root zone, RAW ม ี ห น ่ ว ย  (mm) จ ะ ไ ด ้ ว ่ า  Ks = 1 ใ น ก ร ณ ี ที่  Dr> RAW  
จะได้ว ่า Ks ลดลงเชิงเส ้นตรง และถ้า Dr มีค ่าเท่าก ับน้ำที ่อย ู ่ ในด ินทั ้งหมดในเขตรากพืชที ่ ใช ้การได้  
(Total available soil water in the root zone, TAW มีหน่วย (mm) จะได้ว่า Ks = 0 ดังสมการ (3), (4) และ (5)  

กรณี Dr< RAW 1=sK         (3) 

กรณี TAW <Dr< RAW RAWTAW

DTAW
K r

s
−

−
=

     (4) 

กรณี Dr = TAW 0=sK        (5) 

2.4.4.2 การคำนวณสมดุลน้ำในแปลงนา 
สำหรับการหาค่าการใช้น้ำสำหรับนาข้าวหาได้จากหลักการสมดุลของน้ำในแปลงนาซึ่งมีตัวแปรต่าง ๆ  

สามารถเขียนเป็นสมการได้ดังนี้ (วราวุธ, 2545) 
   Wi + Re = ET + P + S      (6) 



31 
 

โดย Wi   =  ปริมาณน้ำชลประทาน (irrigation water) 
Re  =  ปริมาณฝนใช้การ (effective rainfall) 
ET  =  ปริมาณการใช้น้ำของพืช (evapotranspiration) 
P  =  ปริมาณน้ำที่ไหลซึมเลยเขตรากพืช (percolation) 
S  =  ปริมาณรั่วซึมทางด้านข้าง (seepage) 

ในกรณีที่แปลงนาที่อยู่ข้างๆมีน้ำขังเหมือนกันปริมาณรั่วซึมทางด้านข้างจะมีค่าไม่มากและโดยทั่วไปจะ
รวมค่า P และ S เข้าด้วยกันเรียกว่าปริมาณรั่วซึมในแปลงนา (PS) ดังนั้นสมการที่ (6) สามารถเขียนได้ใหม่เป็น 

   Wi =  ET + PS – Re - Ro    (7) 
 กรณีที่มีการใช้น้ำชลประทานเพื่อการอื่นเช่นการเตรียมดินหรือการตกกล้าจะต้องนำปริมาณน้ำ

ส่วนนั้นมารวมอยู่ในค่า Wi ด้วย 

 
รูปที่ 7 สมดุลของน้ำในแปลงนา 

 

2.4.4.3 การคำนวณสมดุลน้ำในเขตรากพืช 
แนวคิดของสมดุลน้ำในเขตรากพืช โดยที ่สมมติให้ดินในเขตรากพืชได้ร ับน้ำจากฝน (Rain) หรือ

ชลประทาน (Irrigation) ในปริมาณมากเกินความสามารถการซึมลงดิน จะมีส่วนเกินที่เป็นน้ำท่าผิวดิน (runoff) 
ไหลบนผิวดิน น้ำในส่วนที่ซึมลงดินจะทำให้น้ำในเขตรากพืชอยู่ในระดับความชื้นอิ่มตัว (Saturation) ชั่วขณะและ
ส่วนหนึ่งของน้ำจะซึมลึกลง (Deep percolation) ทำให้เหลือน้ำในดินเท่ากับระดับความจุความชื้นสนาม (Field 
Capacity) ซึ่งสามารถแปลงอยู่ในรูปของระดับน้ำ เรียกว่า น้ำที่อยู่ในดินทั้งหมดในเขตรากพืชที่ใช้การได้ (Total 
available soil water in the root zone, TAW) ในบางครั ้งหากระดับน้ำใต้ดินอยู ่ส ูงอาจมีผลกระทบของ 
Capillary rise ต่อระดับน้ำในเขตรากพืช น้ำในเขตรากพืชสามารถลดลงเนื่องจากการคายระเหยหากน้ำพร่องลง
ต่ำกว่าระดับน้ำที่มีอยู่ที่ใช้การได้ (RAW) จะทำให้เกิดปรากฏการณ์ความเครียดน้ำ ดังกล่าวในหัวข้อที่ผ่านมาใน
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สมการ (3) , (4) และ (5) การคำนวณค่าการพร่องของน้ำในเขตรากพืช ณ วันที่ i (Dr,i) ซึ่งมีหน่วยเป็นมิลลิเมตร 
(mm) สามารถคำนวณได้จากสมดุลน้ำในเขตรากพืช ดังสมการนี้ 

( ) iiciiiiirir DPETCRIROPDD ++−−−−= − ,1,,     (8) 

โดยที่ Pi คือ น้ำฝนในวันที่ i ROi คือ น้ำท่าผิวดินในวันที่ i I คือ ความลึกน้ำชลประทานที่ซึมลงดินในวันที่ 
i CRi คือ capillary rise จากน้ำใต้ดินในวันที่ i ETc,i คือ การคายระเหยของพืชในวันที่ i และ DPi คือ น้ำที่สูญเสีย
ออกจากเขตรากพืชโดยการซึมลึกในวันที่ i ในการศึกษานี้ยังไม่ได้พิจารณาการสูญเสียน้ำชลประทานจากการส่งน้ำ 

 
รูปที่ 8 สมดุลน้ำในเขตรากพืช 

  

 

Evapotranspiration 
Irrigation 

Rain 

Runoff 

Deep Percolation Capillary Rise 

Saturation 

Field capacity 

Threshold 

Wilting point 

RAW 

TAW Depletion, Dr 



33 
 

2.5 งานวิจัยท่ีเกี่ยวข้อง  

นายทะนงศักดิ ์ สุขศิร ิ (2558) การประเมินค่า NDVI,NDWI,NDDI Evaluation of NDVI,NDWI and 
NDDI for Drought Monitoring ในการศึกษานี้จึงมีวัตถุประสงค์เพื่อการประเมินค่ดัชนี NDVI, NDIVI และ NDDI
เพื่อการตรวจสอบสภาพภัยแล้ง โดยทำการศึกษาพื้นที่ลุ่มน้ำปีงตอนบน โดยใช้ข้อมูลการรับรู้ระยะไกลที่มีอยู่ใน
ระหว่างปี พ.ศ. 2544 ถึง พ.ศ. 2553 จากนั้นจึงนำผลการประเมินสภาพภัยแล้งที่คำนวณได้โดยดัชนีภัยแล้งทั้ง 3 
ดัชนี มาเปรียบเทียบกับรวมทั้งนำมาเปรียบเทียบกับความลึกฝนสำหรับแต่ละลุ่มน้ำย่อยของลุ่มน้ำปีงตอนบน โดย
มีสมมุติฐานว่า ดัชนีใดมีความสัมพันธ์ที่ดีกับความลึกฝนมากกว่าดัชนีอื่น ก็มีแนวโน้มว่าดัชนีนั้นน่าจะมีความ
น่าเชื่อถือในการนำมาใช้เพ่ือการติดตามภัยแล้งได้อย่างถูกต้องแม่นยำมากกว่าดัชนีอ่ืน ต่อจากนั้นจะนำดัชนีนั้นมา
ใช้เพื่อการประเมินสภาพภัยแล้งสำหรับลุ่มน้ำในประเทศไทยต่อไป ทั้งนี้จะมีการสรุปสภาพภัยแล้งสำหรับพ้ืนที่ลุ่ม
น้ำทั้ง 25 ลุ่มน้ำ ในลักษณะภาพรวมเท่านั้น 

เอกรัฐ สีขาว ,ชรัตน์ มงคลสวัสดิ์ ,รัศมี สุวรรณวีระกำธร (2556) การใช้ดัชนีพืชพรรณมาตรฐานเพ่ือ
ประเมินพื้นที่ความแห้งแล้งในภาคตะวันออกเฉียงเหนือ Using Standardized Vegetation Index to Assess 
Drought Areas in Northeast Thailand การศึกษาครั้งนี้มีพื้นฐานจากการเปลี่ยนแปลงของพืชพรรณ โดยใช้
ข้อมูลภาพถ่ายดาวเทียม Terra/MODIS ในชุด ผลิตภัณฑ์ MOD13Q1 เพื่อน ามาตรวจสอบสภาพความแห้งแล้ง
ของพืชพรรณด้วย ดัชนีพืชพรรณมาตรฐาน (Standardized Vegetation Index: SVI) (Peters et al., 2002) โดย 
SVI ช่วยให้มองเห็นความเขียวขจีของพืช พรรณในแง่ความน่าจะเป็นในแต่ละจุดภาพในช่วงฤดูกาลต่างๆ ในช่วง 
10 ปี (พ.ศ. 2544-2553) เพื่อแสดงให้เห็นถึง การเปรียบเทียบระดับความแห้งแล้งที่สูงและต่ำกว่าค่าเฉลี่ยใน
ช่วงเวลา 10 ปี ตามช่วงฤดูกาล และได้ใช้ดัชนีปริมาณน้ำฝนมาตรฐาน (Standardized Precipitation Index: 
SPI) มาท าการเทียบในเชิงเวลา โดยดัชนี SPI ใช้ข้อมูล ปริมาณ้ำฝนเพียงอย่างเดียวในการคำนวณหาค่าระดับ
ความแห้งแล้ง และเป็นเครื่องมือตรวจวัดเชิงเวลาที่สามารถ ปรับให้เข้ากับแต่ละสถานการณ์โดยสามารถกำหนด
ช่วงในการใช้ค่าปริมาณน้ำฝนได้ตามความต้องการ (McKee, 1993; 1995) 

ธีรภัทร์ ถิระพล 2562 การคำนวนหาดัชนีความแห้งและพืชพรรณจากอุณหภูมิพื้นผิวของข้อมูลดาวเทยีม
แลนด์แซท 8 และเปรียบเทียบกับผลผลิตข้าวในจังหวัดอุบลราชธานี   CALCULATION OF DROUGHT AND 
VEGETATION INDICES FROM LAND SURFACE TEMPERATURE OF LANDSAT 8 DATA AND COMPARISON 
TO THE RICE PRODUCTION IN UBON RATCHATHANI ในปัจจุบันมีดาวเทียมมากมายหลายดวงที ่มีระบบ
เซนเซอร์นำมาหาดัชนีความแห้งแล้งได้เช่น Operational Land Imager (OL) และ Thermal Infrared Sensor 
(TIRS) ของดาวเทียมLandsat 8 รายละเอียดภาพที่ 30 เมตร เป็นต้น จากข้อมูลที่ให้บริการนี้ทำให้มีการศึกษา
และวิจัยที่เกี่ยวกับดัชนีความแห้งแล้ง งานวิจัยนี้จึงใช้ประโยชน์จากคุณสมบัติของภาพดาวเทียม Landsat 8 หา
ความแห้งแล้งในกลุ่มดัชนีรวมโดยการใช้ดัชนี Vegetation Health Index (VHI) และ Normalized Difference 
Drought Index (NDDI) จากภาพดาวเทียม Landsat 8 แบนด์ 4, 5 และ 6 เนื่องจากดัชนีทั้ง 2 เป็นดัชนีรวมขั้น
สุดท้ายที่ต้องเริ่มต้นหาจากกลุ่มดัชนีอิงตามความเป็นพืชพรรณคือNormalized Difference Vegetation Index 
NDVI) กลุ่มดัชนีอิงตามความเป็นน้ำคือ Normalized Difference Water Index (NDWI) และกลุ่มดัชนีอิงตาม
อุณหภูมิค ือ Land Surface Temperature (LST) ซึ ่งคำนวนด้วยวิธ ี Radiative Transfer Equation-Based 
Method (RTE) จากภาพดาวเทียม Landsat 8 แบนด์ 10 เพราะมีความถูกต้องแม่นยำมากที่สุด (Yu et al, 2014) 
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พร้อมกับนำ ดัชนีความแห้งแล้ง อุณหภูมิพื้นผิว มาวิเคราะห์หาความสัมพันธ์กับผลผลิตข้าวด้วยการเปรียบเทียบ
ค่าผิดปกติที่มีการเปลี่ยนแปลงในแต่ละปี รวมทั้งวิธีการวิเคราะห์สหสัมพันธ์และการถดถอย ช่วงเวลา ตั้งแต่ ปี 
พ.ศ.2556-2561 ในพ้ืนที่จังหวัดอุบลราชธานี 

วรลักษณ์ ไก่งาม ( 2564 ) การวิเคราะห์ภัยแล้งบริเวณภาคเหนือของประเทศไทยโดยใช้ดัชนีความแห้ง
แล้ง Standardized Precipitation Index (SPI) การศึกษานี้มีวัตถุประสงค์เพื่อวิเคราะห์คุณลักษณะของภัยแล้ง
บ ร ิ เ วณภาค เหน ื อ ขอ งประ เทศ ไทยท ั ้ ง เ ช ิ ง พ ื ้ นท ี ่ แ ล ะ เ ช ิ ง เ ว ล าช ่ ว งป ี  ค . ศ . 1980-2017 (38 ปี )  
โดยวิเคราะห์จากค่าดัชนีความแห้งแล้ง Standardized Precipitation Index (SPI) ในช่วงฤดูฝน (พฤษภาคม-
ตุลาคม) ของทุกปี ข้อมูลที่ใช้ประกอบไปด้วยข้อมูลน้ำฝนรายเดือนจากสถานีตรวจวัดของกรมอุตุนิยมวิทยา 31 
สถานี และข้อมูลน้ำฝนรูปแบบกริดจาก Climatic Research Unit (CRU) จากผลการวิเคราะห์ค่าสัมประสิทธิ์
สหสัมพันธ์ระหว่างข้อมูลฝนรายเดือนจากสถานีตรวจวัดของกรมอุตุนิยมวิทยาและข้อมูลกริดน้ำฝนจาก CRU 
พบว่ามีค่าสูงอยู่ในช่วง 0.826-0.983 ซึ่งแสดงว่าข้อมูล CRU สามารถใช้เป็นตัวแทนข้อมูลตรวจวัดได้ ดังนั้นใน
งานวิจัยนี้จึงใช้ข้อมูลฝนรูปแบบกริดจาก CRU ทั้งหมด 78 กริดครอบคลุมพื้นที่ภาคเหนือเพ่ือคำนวณดัชนี  SPI ใน 
2 ช่วงเวลาที่แตกต่างกัน คือดัชนี SPI ราย 3 เดือน (SPI3) เพ่ือวิเคราะห์ภัยแล้งในช่วงต้นฤดูฝน และดัชนี SPI ราย 
6 เดือน (SPI6) เพ่ือวิเคราะห์ภัยแล้งตลอดช่วงฤดูฝน จากการวิเคราะห์ค่าดัชนี SPI3 ของเดือนกรกฎาคม (ค่าเฉลี่ย
ของเดือนพฤษภาคม มิถุนายน และกรกฎาคม) พบปีที่เกิดภัยแล้งตั้งแต่ระดับความแห้งแล้งรุนแรงถึงรุนแรงมาก 
(SPI3 ≤ -1.50) ทั้งหมด 14 ปี โดยปี ค.ศ.1987 มีพื้นที่ที่ได้รับผลกระทบมากกว่า 25% ของพื้นที่ศึกษา และปี 
ค.ศ.2015 มีพ้ืนที่ที่ได้รับผลกระทบมากกว่า 75% ของพ้ืนที่ศึกษา  

กรมอุตุนิยมวิทยา ( 2555 ) วิจัยโครงการ ดรรชนีความแห้งแล้งสำหรับประเทศไทยปี 2555 
การศึกษาวิจัยเรื่องดรรชนีความแห้งแล้ง สําหรับ ประเทศไทยมีวัตถุประสงค์ เพ่ือสร้าง ข้อมูลดรรชนีความแห้งแล้ง
เชิงพื ้นที่ในบริเวณพื้นที ่ศึกษา โดยค่าดรรชนีความแห้งแล้งในอดีต จนถึงปัจจุบันจะเป็นข้อมูลพื ้นฐานเพ่ือ
ประกอบการตัดสินใจในการลดความเสี่ยงภัยจากภัยแล้ง บริ เวณประเทศไทย การศึกษาวิจัยในครั้งนี้ได้ศึกษา
ดรรชนีความแห้งแล้งในหลายๆวิธี เพ่ือที่จะ สามารถนํามาใช้เป็นเครื่องมือบ่งบอกสถานะของภัยแล้งได้ทั้งทางตรง
และทางอ้อม ซึ่ง ประกอบด้วยดรรชนีความแห้งแล้ง จํานวน 8 วิธี ได้แก่ 1. ดรรชนีความแห้งแล้งแสดงผลกระทบ
เนื้องจากฝน (EDI) 2. ดรรชนีความแห้งแล้งทางด้านเกษตรกรรมตามฤดูกาลมรสุม(GMI) 3.ดรรชนีความแห้งแล้ง
ของฝนทีÉต่างจากค่าปกติ (SPI) 4. ดรรชนีความชื้นที่เป็นประโยชน์ สําหรับ พืช ( MAI) 5. ดรรชนีความแห้งแล้ง
ทีÉผิดปกติทางด้านเกษตรกรรม (AI) 6. ดรรชนีความแห้งแล้งทีÉตรวจวัดและคํานวณได้จากดาวเทียม (SMest) 7. 
ดรรชนีความแตกต่างพืชพรรณทีÉคํานวณได้จากดาวเทียม (NDVI) 8. ดรรชนีความชื้นในดินแบบสมดุลน้ำ(SMI ) 

พิชิตพร ผลเกิดดี ( 2562 ) โครงการการประยุกต์เทคโนโลยีภูมิสารสนเทศเพื่อการศึกษาดัชนีพืชพรรณ 
และความชื้นในการวิเคราะห์ความแห้งแล้งในพื้นที่ เศรษฐกิจพิเศษภาคตะวันออก การศึกษาครั้งนี้มีวัตถุประสงค์
เพื่อ 1) ศึกษาดัชนีพืชพรรณและความชื้นจากภาพถ่าย ดาวเทียม Terra / MODIS 2) ศึกษาดัชนีพืชพรรณและ
ความชื้นประเมินพื้นที่ที่เกิดความแห้งแล้งเชิง พื้นที่และเวลา ในพื้นที่เศรษฐกิจพิเศษภาคตะวันออก 3) จำแนก
ระดับความรุนแรงของความแห้งแล้ง จากการวิเคราะห์ดัชนีพืชพรรณและความชื้น ในพื้นที่เศรษฐกิจพิเศษภาค
ตะวันออก 4) ศึกษาแนวทางในการเตรียมตัวรับมือกับปัญหาความแห้งแล้งอย่างยั่งยืน ในพ้ืนที่เศรษฐกิจพิเศษภาค 
ตะวันออก วิธีการศึกษาครั้งนี้เป็นการรวบรวมข้อมูลที่เกี ่ยวข้องกับการนำดัชนีพืชพรรณและความชื้น มาใช้
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ประเมินความแห้งแล้งบริเวณพื้นที่เศรษฐกิจพิเศษภาคตะวันออก ทำการวิเคราะห์ข้อมูลจาก ดาวเทียมเพ่ือ
ตรวจสอบความแห้งแล้งจะศึกษาคลอโรฟิลด์ในใบพืชที่มีการเปลี่ยนแปลงตอบสนองต่อ การขาดแคลนน้ำ ปรากฏ
ในภาพถ่ายเป็นค่าการสะท้อนที่เปลี่ยนแปลงแตกต่างกันในเดือนที่มีน้ำ เดือนที่ขาดน้ำ ดัชนีเชิงคลื่นที่นำมาใช้
วิเคราะห์ในครั้งนี้เป็นดัชนีที่ตอบสนองต่อคลอโรฟิลด์ในใบพืช ปริมาณน้ำในพืชและในดิน ได้แก่ ดัชนีผลต่างพืช
พรรณ (NDVI) ดัชนีผลต่างความชื้น (NDWI) และ ดัชนีเน้นภาพพืชพรรณ (EVI) จากนั้นทำการวิเคราะห์ความ
เปลี่ยนแปลงในพืชพรรณระหว่างฤดูกาล และระหว่างปี ต่อมาทำการวิเคราะห์เพ่ือประเมินความเปลี่ยนแปลงของ
พื้นที่โดยอาศัยพื้นฐานจาก ความเปลี่ยนแปลงของค่าดัชนีระหว่างคู่ภาพต่างวัน และหามาตราการแนวทางในการ
เตรียมตัวรับมือ กับปัญหาความแห้งแล้งอย่างยั่งยืน ในพ้ืนที่เศรษฐกิจพิเศษภาค 

สุนิสา สายอุปราช ( 2564 ) การวิเคราะห์ภัยแล้งเพื่อบริหารจดัการน้ำ โดยใช้ระบบ สารสนเทศภูมิศาสตร์
การศึกษาปัจจัยการเกิดภัยแล้งเพื่อนำ มาวิเคราะห์และบริหารจัดการน้ำ มีความสำคัญ เป็นอย่างมาก ซึ่งปัจจัยที่
ท า  ใ ห ้ เ ก ิ ด ภ ั ย แ ล ้ ง ท ี ่ ส ำ ค ั ญ  ค ื อ ส ภ า ว ะ อ า ก า ศ ใ น ฤ ด ู ร ้ อ น ท ี ่ ผ ิ ด ป ก ติ ก า ร พ ั ด พ า ข อ ง ล ม  
ความกดอากาศและส่วนผสมของอากาศ ได ้แก่ไอน้ำ หยดน้า ซ ี ่งป ัจจ ัยด ังกล ่าวข้างต ้น สามารถนำ  
มาวิเคราะห์หาปริมาณน้ำ ฝน ในพื้นที่บริเวณลุ่มแม่น้ำภาคกลางตอนล่างได้โดยข้อมูลเบื้องต้นของการวิจัยที่ใช้ใน
การวิเคราะห์การเกิดภัยแล้งได้มาจากกรม 

ปาลิดา ดกพฤกษ์ ( 2561 ) การประเมินความถูกต้องดัชนีภัยแล้งด้วยข้อมูลผลิตภัณฑ์ดาวเทียม: พื้นที่
ศึกษาลุ่มน้ำน่าน Drought Accuracy Assessment of indices from satellite dataดัชนีความแห้งแล้งคือดัชนี
ที่บ่งบอกความแห้งแล้งของพื้นที่ ได้จากการน าปัจจัยที่มี อิทธิพลส่งผลต่อความแห้งแล้งในพื้นที่นั้น ในการศึกษา
เลือกสามดัชนีคือ Normalized Monthly Precipitation Anomaly Percentage (NPA), Vegetation Health 
Index (VHI) และ Normalized Vegetation Supply Water Index (NVSWI)และได้ ใช้ข้อมูล TRMM3B42 V.7 
จากดาวเทียม TRMM เข้ามาช่วยประเมินความถูกต้องความเหมาะสมของดัชนีภัยแล้งกับพ้ืนที่ศึกษาคือลุ่มน้ำน่าน 
โดยระยะเวลาที่ใช้ในการศึกษาคือสิบปี (ปี พ.ศ 2551- ปี พ.ศ 2560) โดยได้มีการนำข้อมูลฝน จากสถานีฝนในลุ่ม
น้ำน่านและข้อมูลผลิตภัณฑ์ TRMM3B42 V.7 มาตรวจสอบก่อนเพื่อตรวจดู ลักษณะฝนในพ้ืนที่ลุ่มน้ำน่านเพ่ือง่าย
ต่อการวิเคราะห ์

ชรินทร์ เสริมการดี  (2553) การวิเคราะห์พ้ืนที่เสี่ยงต่อการเกิดอุทกภัย โดยใช้ระบบสารสนเทศภูมิศาสตร์ 
อำเภอควนขนุน จังหวัดพัทลุง งานวิจัยครั้งนี้มีจุดมุ่งหมายเพื่อวิเคราะห์พื้นที่เสี่ยงต่อการเกิดอุทกภัย อำเภอควน
ขนุน จังหวัดพัทลุง โดยใช้ระบบสารสนเทศภูมิศาสตร์ โดยการซ้อนทับข้อมูลปัจจัยทางอุตุนิยมวิทยา  และข้อมูล
ปัจจัยทางกายภาพ ที่มีผลต่อการเกิดอุทกภัย คือ ข้อมูลปริมาณน้ำฝน ข้อมูลขนาดพื้นที่  ลุ่มน้ำ ข้อมูลความ
ห น า แ น ่ น ข อ ง ท า ง น ้ ำ ข ้ อ ม ู ล ค ว า ม ล า ด ช ั น ข อ ง ส ภ า พ ภ ู ม ิ ป ร ะ เ ท ศ  ข ้ อ ม ู ล ล ั ก ษ ณ ะ   
เนื้อดิน ข้อมูลความลึกของดิน และข้อมูลการใช้ประโยชน์ที่ดิน พบว่า ตำบลทะเลน้อย มีพื้นที่ที่มี  โอกาสเสี่ยงต่อ
เกิดอุทกภัยมากที่สุด ตำบลแหลมโตนด ตำบลปันแต ตำบลพนางตุง ตำบลมะกอก เหนือ และตำบลชะมวง มีพ้ืนที่
ที่มีโอกาสเสี่ยงต่อเกิดอุทกภัยมากตำบลชะมวง ตำบลควนขนุน ตำบลโตนดด้วน ตำบลแพรกหา ตำบลนาขยาด 
ตำบลพนมวังก์และตำบลดอนทราย มีพื้นที่ที่มี โอกาสเสี่ยงต่อเกิดอุทกภัยปานกลาง ตำบลนาขยาด ตำบลดอน
ทราย และตำบลพนมวังก์ มีพื้นที่ ที่มีโอกาสเสี่ยงต่อเกิดอุทกภัยน้อยและพื้นที่ลาดชันบริเวณเชิงเขา มีพื้นที่ที่มี
โอกาสเสี่ยงต่อเกิด อุทกภัยน้อยที่สุด ตามลำดับ ซึ่งปัญหาอุทกภัยเป็นปัญหาที่ก่อให้เกิดความสูญเสียทั้งชีวิตและ  
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ทรัพย์สิน ผู้วิจัยใช้ระบบสารสนเทศภูมิศาสตร์เป็นเครื่องมือในการวิเคราะห์ปัญหาและได้  เสนอแนะแนวทาง
ป้องกันและบรรเทาผลกระทบจากการเกิดอุทกภัยคือการลดความรุนแรง เช่น  การสร้างพนังกั้นน้ำ การสร้างการ
ป้องกันตลิ่งพัง การวางผังเมือง การควบคุมสิ่งปลูกสร้างไม่ให้ไป ขวางทางน้ำ และการเตือนภัยอุทกภัย  

ประวิทย์ จันทร์แฉ่ง (2553) การวิเคราะห์ความเสี่ยงต่อความแห้งแล้ง ในพ้ืนที่อำเภอกำแพงแสน จังหวัด
นครปฐม โดยการประยุกต์ใช้ระบบสารสนเทศภูมิศาสตร์งานวิจัยครั้งนี้มีวัตถุประสงค์เพื่อศึกษา ปัจจัยที่มีอิทธิพล
ต่อความเสี่ยงต่อความแห้งแล้ง และวิเคราะห์ความเสี่ยงต่อ ความแห้งแล้ง รวมทั้งหาสมการความสัมพันธ์ระหวา่ง
ปัจจัยที่ใช้ใน การศึกษากับความเสี่ยงต่อความแห้งแล้งในพื้นที่อำเภอกำแพงแสน จังหวัดนครปฐม โดยมีปัจจัย  ที่
เกี่ยวข้องกับความแห้งแล้งได้แก่ ปัจจัยที่เก่ียวกับ ลักษณะทางธรรมชาติคือ ปริมาณน้ำฝนต่อปี, ปริมาณน้ำบาดาล,
ลักษณะเนื้อดิน และการระบายน้ำของดิน ปัจจัยที่เก่ียวข้องกับลักษณะทาง กายภาพท่ีมนุษย์สร้างขึ้น ได้แก่ คลอง
ชลประทาน และการใช้ประโยชน์จาก ที่ดิน โดยกำหนดให้ ผู้เชี่ยวชาญจากหน่วยงานภาครัฐที่เกี่ยวข้องจำนวน 17 
คน ให้คะแนนความสำคัญ ( Weighting) และค่าน้ำหนักระดับปัจจัย (Rating) ทำการศึกษาความสัมพันธ์ระหว่าง
ความเสี่ยง ต่อความแห้ง แล้งกับปัจจัยที่มีอิทธิพลต่อ ความเสี่ยงต่อ ความแห้งแล้งด้วยวิธีการวิเคราะห์ถดถอยเชิง
เส้น (Linear Regression Analysis) ที่ระดับความเชื่อมั่นร้อยละ 95 และวิเคราะห์ความเสี่ยงต่อ ความ แห้งแล้ง
ในพ้ืนที่โดยการประยุกต์ใช้ระบบสารสนเทศภูมิศาสตร์ 

สรียา หมัดอาด้ำ (2553) การประยุกต์ใช้ข้อมูลการสํารวจระยะไกลเพ่ือศึกษาภัยแล้ง จังหวัดสงขลา การศึกษาภัย
แล้งครั้งนี้เป็นการนําข้อมูลการสํารวจระยะไกล(Remote Sensing System : RS) มาประยุกต์ใช้ เพ่ือศึกษาภัยแล้งในพ้ืนที่
จังหวัดสงขลา ครอบคลมุพ้ืนที่ 7,393.889 ตารางกิโลเมตร โดยใช้ข้อมูลภาพถ่ายดาวเทียม Landsat 5TM (Path 122, Row 
55) ในช่วงปี พ.ศ. 2548 และปี พ.ศ. 2553 โดยใช้ดัชนี normalized difference vegetation index (NDVI) มาวิเคราะห์
เพื่อตรวจสอบภาวะของพืชพรรณในช่วงแห้งแล้ง จากผลของการศึกษาครั้งนี้พบว่า ค่า NDVI ปี พ.ศ. 2548 มีค่าเท่ากบั 
0.04 และค่า NDVI ปี พ.ศ. 2553 มีค่าเท่ากบั 0.80 จากผลการศึกษาชี้ให้เห็นว่าการนําข้อมูลการสํารวจระยะไกลมาใช้กบ
พื้นที่นั้นให้ประสิทธิภาพที่ดีและสามารถนําข้อมูลที่ได้มาใช้ให้เกิดประโยชน์ และ สานต่อการพัฒนางานด้านภัยแล้ง
เพ่ิมเติมได ้

บุษบา สำแดงชัย (2565) การวิเคราะห์และระบุพื้นที่ที่เกิดอุทกภัยด้วยข้อมูลจากดาวเทียม Sentinel-1 จาก
อุทกภัยที่เกิดขึ้นในประเทศไทยทุกครั้ง คนไทยต้องเผชิญกับความเสียหายต่อ ทรัพย์สิน บ้าน อาคารพาณิชย์รวมทั้งพื้นที่
เกษตรกรรม จังหวัดสุโขทัยก็เป็นอีกพื้นที่หนึ่งที่ประสบ อุทกภัยทุกปีเช่นกัน การศึกษาในครั้งนี้ได้ทำการนำข้อมูล
ดาวเทียม Sentinel-1 บักทึกข้อมูลระหว่าง ปี2559 ถึง 2563 มาทำการวิเคราะห์และสร้างแผนที่ดังนั้น การศึกษานี้จึงมี
วัตถุประสงค์เพ่ือ วิเคราะห์ภัยพิบัติที่เกิดจากอุทกภัยผ่านข้อมูลจากดาวเทียม Sentinel-1 สำหรับวิธีการ วิเคราะห์ ข้อมูล
จากดาวเทียม Sentinel-1 ในพื้นที่ที่ทำการศึกษาโดยใช้โปรแกรม SNAP และ ArcGIS ผลการ วิเคราะห์ข้อมูล พบว่าข้อมูล
ของปีพ.ศ. 2559 พบพื้นที่อุทกภัย คือ 1,532.66 ตารางกิโลเมตร ปี พ.ศ. 2560 พบพื้นที่อุทกภัย คือ 1,137.22 ตาราง
กิโลเมตร ปีพ.ศ. 2561 ไม่พบการเกิดอุทุกภัยใน พื้นที่ศึกษา ปีพ.ศ. 2562 พบพื้นที่อุทกภัย คือ 262.53 ตารางกิโลเมตร 
และปีพ.ศ. 2563 พบพ้ืนที ่อุทกภัย คือ 257.31 ตารางกิโลเมตร 
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ดร.ประเทือง วงษ์ทอง (2562)การประเมินความเสี่ยงภาคเกษตรกรรมจากการเปลี่ยนแปลงสภาพภูมิอากาศ ใน
พื้นที่ภาคกลางตอนล่าง : จังหวัดชัยนาท สิงห์บุรี อ่างทอง และ พระนครศรีอยุธยาการวิจัยนี้มีวัตถุประสงค์เพื่อสร้าง
แ บ บ จ ำ ล อ ง ค ว า ม เ ส ี ่ ย ง ข อ ง ภ า ค เ ก ษ ต ร ก ร ร ม ด ้ ว ย ร ะ บ บ  ส า ร ส น เ ท ศ ภ ู ม ิ ศ า ส ต ร์   
(Geo Information System: GIS) จากนั้นคำนวณค่าดัชนีความเปราะบางของ การทำเกษตรกรรมในพื้นที่ศึกษา โดย
กำหนดให้จังหวัดชัยนาท สิงห์บุรี อ่างทอง และ พระนครศรีอยุธยาเป็นพื้นที่ศึกษา การศึกษาใช้แนวคิดจากดัชนีความ
เปราะบางต่อการดำรงชีว ิต (Likelihood Vulnerability Index : LVI) จากนั ้นคัดเลือกปัจจัยเกี ่ยวข้องกับการทำ
เกษตรกรรม และมีความสัมพันธ์กับสภาพภูมิอากาศมาเป็นกำหนดเป็นองค์ประกอบหลัก 3 องค์ประกอบ แต่ละ 
องค์ประกอบหลักมีองค์ประกอบย่อยรวมทั้งสิ ้น 6 องค์ประกอบ ได้แก่ องค์ประกอบโอกาสเสี่ยงภัย (Exposure) 
ประกอบด้วย อุณหภูมิต่ำสุด อุณหภูมิสูงสุด องค์ประกอบความไวต่อความเสี่ยง (Sensitivity) ประกอบด้วย ปริมาณ
น้ำท่ารวมรายปี ปริมาณน้ำในดินรวมรายปีจำนวนครั้งที่เกิดภัย พิบัติทางธรรมชาติ และองค์ประกอบความสามารถการ
ปรับตัว (Adaptive Capacity) ประกอบด้วย ระยะห่างจากแหล่งน้ำ จากนั้นคำนวณค่าดัชนีความเปราะบางของการ
ทำเกษตรกรรม (Agricultural Vulnerability Index: AVI) รายตำบลในพ้ืนที่ศึกษา 

วีระศักดิ์ อุดมโชค;พูลศิริ ชูชีพ (2548) การกำหนดพื้นที่เสี่ยงภัยแล้งบริเวณภาคตะวันออกของประเทศ
ไทย เป็นการศึกษาปัจจัยที่ก่อให้เกิดสภาวะภัยแล้ง โดยใช้การวิเคราะห์หาความสัมพันธ์เชิงพื้นที่ระหว่างปัจจัย
ต่างๆ ร่วมกับการใช้ระบบสารสนเทศทางภูมิศาสตร์ในการจัดเตรียมข้อมูลพื้นฐาน วิเคราะห์ และจัดทำแผนที่ ซึ่ ง
การวิเคราะห์เพ่ือกำหนดพ้ืนที่เสี่ยงภัยแล้งได้กำหนดค่าถ่วงน้ำหนักของแต่ละปัจจัยตามลำดับของอิทธิพลที่มีผลต่อ
ความแห้งแล้ง คือ ดัชนีฝนแล้ง การอุ้มน้ำของดิน พ้ืนที่ชลประทาน ปริมาณน้ำใต้ดิน จำนวนวันที่ฝนตกรายปีเฉลี่ย 
และการใช้ประโยชน์ที่ดิน มีค่าถ่วงน้ำหนักเป็น 3:2.5: 2:1.5:1: 1 ตามลำดับ พบว่าสามารถจัดกลุ่มระดับความ
เสี่ยงภัยแล้งบริเวณภาคตะวันออก เป็น 4 ระดับ คือ ระดับไม่เสี่ยงภัยแล้งมีพื้นที่ 8 ,370.24 ตารางกิโลเมตร เสี่ยง
ภัยแล้งระดับต่ำมีพ้ืนที่ 10,236.22 ตารางกิโลเมตร เสี่ยงภัยแล้งระดับปานกลางมีพ้ืนที่ 10,343.06 ตารางกิโลเมตร 
และเสี่ยงภัยแล้งระดับสูงมีพ้ืนที่ 5,661.74 ตารางกิโลเมตร 

ทวีศักดิ์ ธนเดโชพล และคณะ (2563) ภัยแล้งปี พ.ศ.2563 เป็นผลพวงมาจากฤดูฝนปี พ.ศ. 2562 ซึ่งเป็นปี
ที่มีปริมาณฝนน้อย ที่สุดในรอบ 30 ปี สาเหตุหลักมาจากปรากฏการณ์ “เอลนีโญ” ทำให้เกิดสภาวะทั้งร้อน ทั้งแล้ง
ในหลาย พื้นที่ในภาคเหนือ ภาคตะวันออกเฉียงเหนือ ภาคกลาง และภาคตะวันออก ก่อให้เกิดปัญหาขาดแคลนน้ำ 
อย่างเห็นได้ชัด โดยเฉพาะน้ำในพื้นที่ทำเกษตรกรรม ในการศึกษาครั้งนี้ มีวัตถุประสงค์เพื่อศึกษา วิเคราะห์การ
บริหารจัดการน้ำในฤดูแล้งในปี พ.ศ.2563 เพื่อหาสาเหตุปัญหาภัยแล้งและหาแนว ทางการแก้ไขปัญหาภัยแล้งใน
อนาคต ผลการศึกษาพบว่า 1) ปริมาณฝนสะสมในฤดูฝน 2562 (1 พฤษภาคม 2562-31 ตุลาคม 2562)  มีค่าน้อย
กว่าฝนสะสมค่าเฉลี่ย 30 ปี ร้อยละ 16 2) ผลของฝนสะสมปี 2562 น้อยส่งผลทำให้น้ำต้นทุนในอ่างเก็บน้ำขนาด
ใหญ่และขนาดกลางในฤดูแล้งปี 2563(พฤศจิกายน 2562 – เมษายน 2563) มีปริมาณน้ำเก็บกักน้อยโดยเฉพาะลุ่ม
น้ำเจ้าพระยา 3) ในลุ่มน้ำ เจ้าพระยาซึ่งเป็นพื้นที่วิกฤติน้ำแล้ง ภาครัฐไม่มีแผนปลูกข้าวนาปรังเนื่องจากน้ำต้นทุนใน
อ่างเก็บน้ำน้อย อย่างไรก็ดีเกษตรกรในลุ่มน้ำเจ้าพระยาปลูกข้าวนาปรังเกินแผน 1.98 ล้านไร่ (ข้อมูล ณ วันที่  
30 เมษายน 2563) 4) กรมชลประทานผันน้ำจากแม่น้ำแม่กลองมาช่วยผลักดันน้ำเค็มในแม่น้ำเจ้าพระยา  
แต่ปัญหาน้ำประปาเค็มยังจะเกิดขึ้นอีกเป็นระยะๆ  แนวทางการแก้ไขปัญหาภัยแล้ง ภาครัฐควรเร่ง ดำเนินการแก้ไข
ภัยน้ำแล้ง ดังนี้ 1.จัดทำแผนมาตรการและแผนปฏิบัติการรองรับสภาวะภัยแล้งในพื้นที่ เสี ่ยงภัยแล้งทั้งในเขต
ชลประทานและนอกเขตชลประทาน 2.สร้างการรับรู้ความเข้าใจเรื่องสถานการณ์ วิกฤติน้ำแล้ง ประชาสัมพันธ์ให้
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ผู้ใช้น้ำภาคการเกษตร และขอความร่วมมือเกษตรกรในลุ่มน้ำเจ้าพระยาไม่ ปลูกข้าวเกินกว่าแผนควบคุม 3.การบูร
ณาการร่วมกันระหว่างหน่วยงานที่เกี ่ยวข้องกับการบริหารจัดการน้ำ เพื่อแก้ไขวิกฤติภัยแล้งให้เป็นไปอย่างมี
ประสิทธิภาพและรวดเร็วทันท่วงที 

รัชพล สัมพุทธานนท์ ( 2561 ) งานวิจัยเรื่องการสร้างฐานข้อมูลระบบสารสนเทศภูมิศาสตร์ เพื่อจัดการ
ปัญหาภัยแล้งด้านการเกษตรในจังหวัดเชียงใหม่ มีวัตถุประสงค์เพื่อศึกษาปัจจัยที่ส่งผลต่อภัยแล้งด้านการเกษตร 
เพื่อจัดสร้างฐานข้อมูลระบบสารสนเทศภูมิศาสตร์ และเพื่อวิเคราะห์ความสัมพันธ์ของความต้องการใช้น้ำด้าน
การเกษตรกับแหล่งน้ำและปริมาณน้ำฝน โดยปัจจัยที่ถูกนำมาพิจารณาเพ่ือการวิเคราะห์ภัยแล้งด้านการเกษตรด้วย
ระบบสารสนเทศภูมิศาสตร์ได้แก่ปริมาณน้ำฝนเฉลี่ยรายเดือน แหล่งน้ำผิวดินในระยะกันชน 500 เมตร เขตพื้นที่
ชลประทาน และเขตพ้ืนที่น้ำถึง โดยการวิเคราะห์ได้พิจารณาเฉพาะพืชหลัก 12 ประเภทในเขตนอกพื้นที่น้ำถึง
เนื่องจากเกษตรกรต้องพึ่งพาน้ำฝนเป็นหลัก สำหรับการจัดเตรียมข้อมูลพบว่าปริมาณฝนเฉลี่ยต่ำสุดรายเดือนมี
ปริมาณที่แตกต่างกันอย่างมีนัยสำคัญจึงจำแนกออกเป็น 2 ช่วงได้แก่ช่วงฤดูแล้งคือช่วงเดือนพฤศจิกายน – เมษายน 
และช่วงฤดูมีฝนคือตั้งแต่เดือนพฤษภาคม – ตุลาคม เมื่อทำการวิเคราะห์พื้นที่เสี่ยงภัยแล้งด้านการเกษตรจากปัจจัย
เชิงพื้นที่ดังกล่าวได้ผลลัพธ์ที่สามารถแสดงการกระจายตัวในเชิงพื้นที่และเชิงเวลา โดยพบว่าในช่วงฤดูแล้งพืชหลัก
ทุกประเภทประสบปัญหาภัยแล้งเนื่องจากปริมาณฝนที่ไม่เพียงพอต่อความต้องการของพืชตามเกณฑ์การใช้น้ำของ
พืช สำหรับในช่วงฤดูมีฝนพบว่าปริมาณฝนไม่เพียงพอต่อพืชทุกชนิดแม้ว่าเดือนสิงหาคมและเดือนกันยายนปริมาณ
ฝนเฉลี่ยต่ำสุดจะมีค่าสูงมากที่สุดในรอบปีก็ตาม โดยมะม่วงถือเป็นไม้ผลยืนต้นที่มีความต้องการน้ำมากจึงปรากฎ
ปัญหาภัยแล้งทุกเดือนโดยเฉพาะในพื้นที่เขตตำบลเชียงดาว และตำบลเมืองนะ อำเภอเชียงดาว พื้นที่ปลูกข้าวถือ
เป็นปัญหาภัยแล้งเช่นกันซึ่งแสดงสภาพทั้งในเชิงเวลาและเชิงพ้ืนที่ปรากฎภัยแล้ง 10 เดือนในรอบปีและกระจุกมาก
อย่างชัดเจนในหลายตำบลในเขตอำเภอพร้าว การวิเคราะห์ครั ้งนี ้ถือเป็นการจำลองกรณีศึกษาภัยแล้งด้าน
การเกษตรระดับสูงสุดเนื่องจากการพิจารณาค่าปริมาณฝนเฉลี่ยในระดับต่ำสุดรายเดือนและไม่นำชั้นข้อมูลทางน้ำ
ขนาดเล็กมาร่วมวิเคราะห์เพื่อต้องการแสดงผลที่สามารถนำไปใช้วางแผนรับมือและการป้องกันเหตุรุนแรงไ ด้ 
ท้ายที่สุดของผลลัพธ์จากการวิเคราะห์ในครั้งนี้สามารถแสดงสัญญาณภัยแล้งด้านการเกษตรโดยการฉายภาพรวมได้
อย่างน่าพอใจ และสำหรับการศึกษาในครั้งต่อไปควรคัดเลือกเฉพาะบางพ้ืนที่ที่มีระดับความรุนแรง มีการกระจุกตัว
ของภัยแล้งที่โดดเด่นทั้งในเชิงพื้นที่และเชิงเวลา การวิเคราะห์เฉพาะตำแหน่งรวมทั้งการบูรณาการศาสตร์จะ
สามารถทำให้อธิบายปรากฎการณ์ในเชิงพ้ืนที่ได้ละเอียดและครอบคลุมมากยิ่งขึ้น คำสำคัญ: ภัยแล้งด้านการเกษตร 
ความต้องการน้ำของพืชเชิงพ้ืนที่ แผนที่เสี่ยงภัยแล้งด้านการเกษตร ระบบสารสนเทศภูมิศาสตร์ 

ธนกร เขียวขำ ( 2561 ) งานวิจัยเรื่อง การวิเคราะห์พื้นที่เสี่ยงภัยแล้งเชิงเกษตรกรรม อำเภอนครไทย 
จังหวัด พิษณุโลก ถือเป็นการศึกษาจากการเก็บข้อมูลเชิงเกษตรกรรมในพื้นที่ศึกษาปี 2015 โดยการนำ ข้อมูลมา
วิเคราะห์กระบวนการผ่าน VCI ทั้งนี้ งานวิจัยนี้มีวัตถุปะสงค์เพื่อประเมินพื้นที่เสี ่ยงภัยแล้ง ในอำเภอนครไทย 
จังหวัดพิษณุโลก ซึ่งการวิเคราะห์และเปรียบเทียบจากข้อมูลทั้งหมดนี้ทำให้เห็นว่า 1) พ้ืนที่เสี่ยงภัยแล้งในแต่ละจุด
จ ะส ่ ง ผ ล ก ร ะ ท บ  ต ่ อ ป ร ะช า ช น ใ น เ ข ต ต ำ บ ล ใ ด บ ้ า ง ใ น อ ำ เ ภ อน ค ร ไ ท ย  จ ั ง ห ว ั ด พ ิ ษ ณ ุ โ ล ก  
2) พื้นที่ใดบ้างที่ไม่ได้รับผลกระทบความเสี่ยงภัยแล้ง ผลการศึกษาพบว่าใน 1) พื้นที่ที่มีความแล้งมากส่วนใหญ่จะไม่
ค่อยมีพืชพรรณปกคลุมและ พ้ืนที่ส่วนใหญ่ทำเกษตรกรรมกันอย่างกว้างขวางในพ้ืนที่ศึกษาและประกอบกับปริมาณ
ฝนแล้งที่ ส่งผลกระทบต่อพ้ืนที่เสี่ยงภัยแล้งในเชิงเกษตรกรรม 2) ในบางช่วงเวลาในเขตอำเภอนครไทยไม่ได้มี ความ
แห้งแล้งในพ้ืนที่ เมื่อเปรียบเทียบผลการวิเคราะห์แล้วพบว่าในพื้นที่อำเภอนครไทยในปี 2558 เกิดพ้ืนที่เสี่ยงภัยแล้ง
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มากพอสมควร จากการวิเคราะห์โดยกระบวนการ VCI 3) จากการศึกษาจะ พบว่าในเขตอำเภอนครไทย ปี พ.ศ. 
2558 มีพื้นที่เสี่ยงภัยแล้งครอบคลุมพื้นที่ศึกษามากที่สุด คือ 521,552 ไร่ และรองลงมาคือพื้นที่เสี่ยงภัยแล้งระดับ
ปานกลาง มีพื้นที่ 491,502 ไร่ ส่วนพื้นที่ไม่มี ความแล้งมีพื้นที่ครอบคลุมน้อยที่สุดในเขตพื้นที่ศึกษา มีพื้นที่ 
454,546 ไร่ โดยคิดเป็นร้อยละของ พ้ืนที่ทั้งหมด(คิดเป็นเปอเซ็นต์) คือ 35.54 , 33.49 และ 30.97 

ขวัญชัย ชัยอุดม (2559) ได้ศึกษาเพื่อประเมินหาพื้นที่เสี่ยงภัยแล้งและระดับพื้นที่เสี่ยงภัยแล้งในจังหวัด
ลพบ ุ ร ี  ค รอบคล ุ มพ ื ้ น ท ี ่  6 ,275 . 35  ดาร า งก ิ โ ล เมตร  ว ิ เ ค ร าะห ์ โ ดย ใช ้ เ ทคนิ คก ารซ ้ อน ทั บ  
(Overlay technique) ในโปรแกรม Arc GIS 10.2 ปัจจัยที ่ใช ้ในการศึกษา คือ ปริมาณน้ำฝนเฉล ี ่ยรายปี  
การระบายน้ำของดิน ลักษณะเนื้อดิน พื้นที่ระบบชลประทาน ปริมาณน้ำบาดาล และการใช้ประโยชน์ที่ดิน และได้
กำหนดค่าถ่วงน้ำหนักเป็น 6: 6: : 4: 3 ดามลำดับ พบว่าสามารถจัดกลุ่มระดับความเสี่ยงภัยแล้งเป็น 4 ระดับ ได้แก่ 
พื้นที่เสี่ยงภัยแล้งมาก มีพื้นที่ 974.16 ตารางกิโลเมดร (15.52% ของพื้นที่ทั้งหมด) เสี่ยงภัยแล้งระดับปานกลาง มี
พื้นที่ 1,850.99 ดารางกิโลเมดร (29.50%) เสี่ยงภัยแล้งน้อย มีพื้นที่ 2.122.26 ตารางกิโลเมตร (33.82%) และไม่
เสี่ยงภัย มีพ้ืนที ่1,327.95 ดารางกิโลเมดร (21.16%) 

วิษณุ เร ือนทอง , พงศ์พล ปลอดภัย และ พรทิพย์ ว ิมลทรง (2563 )ได้ศ ึกษาภัยแล้งในพื ้นที่  
จังหวัดศรีสะเกษ ซึ่งถือเป็นพื้นที่ที่ได้รับผลกระทบรุนแรงทุกปี ส่งผลให้ประชาชนในพื้นที่ใด้รับความเดือดร้อน 
และขาดแคลนน้ำอุปโภคบริโภค หรือขาดน้ำใช้เพื่อการทำการเกษตร และนำมาสู่ผลกระทบต่อระบบเศรษฐกิจใน
ภาพรวม  ทา งผ ู ้ ว ิ จ ั ย จ ึ ง เ ล ็ ง เ ห ็ นป ัญหาและม ี ก า รป ระย ุ กต ์ ใ ช ้  ร ะบบ สารสน เทศภ ู ม ิ ศ า สต ร์  
มาช่วยในกรวิเคราะห์พื้นที่เสี่ยงภัยแล้งในจังหวัดศรีสะเกษ โดยมีวัตถุประสงค์ คือ 1) เพื่อศึกษาปัจจัยที่ส่งผลต่อ
การเกิดภัยแล้งในจังหวัดศรีสะเกษ 2) เพ่ือประเมินพ้ืนที่เสี่ยงภัยแล้ง 3) เพ่ือเสนอแนวทางการแก้ไขปัญหาภัยแล้ง
จังหวัดศรีสะเกษ โดยใช้การเก็บรวบรวมข้อมูลสถิติการเกิดภัยแล้ง ศึกษาสภาพพื้นที่และศึกษาปัจจัยที่ส่งผลต่อ 
การเกิดภัยแล้งในจังหวัดศรีสะเกษ และนำมาวิเคราะห์และซ้อนทับปัจจัยทั้งหมด เพื่อแบ่งระตับ ( Reclassify) 
พื้นที่เสี่ยงภัย โดยใช้เทศนิค Point Score Anysis (PSA) ผลการศึกษาพบว่า ปัจจัยที่มีอิทธิพลและส่งผลต่อการ
เกิดภัยแล้งในจังหวัดศรีสะเกษมากที่สุด คือ ปริมาณน้ำฝนเฉลี่ย 10 ปีย้อนหลัง เมื่อซ้อนทับข้อมูลปัจจัยทั้งหมด
และแบ่งระดับ พื้นที่เสี่ยงภัยแล้งจังหวัดศรีสะเกษ ผลการศึกษาพบว่า พื้นที่เสี่ยงภัยแล้งมากที่สุด 3 อำเภอ อยู่ที่
อำเภอยางชุมน้อย 
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บทที่ 3 

อุปกรณ์และวิธีดำเนินงานวิจัย 
3.1 อุปกรณ์ 

อุปกรณ์สำรวจภาคสนาม 
1) เครื่องมือการรังวัดด้วยระบบโครงข่ายด้วยดาวเทียมแบบจลน์ (Real Time Kinetics Network)  
2) โทรศัพท์มือถือระบบ Android ติดตั้ง Application SW Maps 
3) เครื่องมือสำรวจหยั่งน้ำลึกแบบพกพา (Echo Sounder) 
4) โน้ตบุ๊ก ติดตั้ง Application Garmin Homeport 
5) เรือจำลองขนาดเล็ก 
อุปกรณ์ในห้องปฏิบัติการ 
1) เคร ื ่ องคอมพ ิว เตอร ์  (Computer)  หร ือโน ๊ตบ ุ ๊ ค  (Notebook) ท ี ่ม ี ระบบปฏ ิบ ัต ิการ (OS)  

ที่สนับสนุน ได้แก่ Windows 10/11 (64 bit เท่านั้น)  
2) เครื่องพิมพ์ 
3) โปรแกรมทางด้านสารสนเทศภูมิศาตร์ 
4) โปรแกรมหรือแบบจำลอง HEC หรือเวอร์ชั่นสูงกว่า 
5) Shape file เส้นทางน้ำ ขอบเขตการปกครอง และตำแหน่งจุดตรวจวัดค่าระดับตามแนวขวางของ

แม่น้ำ Cross-section River ของพ้ืนที่ศึกษาแม่น้ำชี 
6) โปรแกรมจัดการเอกสาร MS-Word, MS-Excel และ MS-PowerPoint 
7) ข้อมูลค่าระดับตามแนวขวางของแม่น้ำ Cross-section River ของพื้นที่ศึกษาแม่น้ำชี 55 จุด ตลอด

ความยาวของแม่น้ำ 
8) Shape file พ้ืนที่ภัยแล้งที่ได้จากภาพถ่ายดาวเทียม 

3.2 วิธีการวิจัย 
ในการดำเนินการศึกษานี้ จะใช้แบบจำลอง HEC-ResSim เป็นแบบจำลองที่พัฒนามาจากแบบจำลอง HEC-5 

(Simulation of Flood Control and Conservation Systems) โดยทำงานแบบ Graphical User Interface (GUI) เพ่ือ
ช่วยเหลือในการวางแผนและประเมินแนวทางในการจัดการอ่างเก็บน้ำและการกำหนดขนาดเก็บกักน้ำ เพื่อป้องกันน้ำท่วม 
เพื่อการอนุรักษ์ และการผลิตพลังงานไฟฟ้านอกจากนี้ HEC-ResSim ยังสามารถจำลองแบบการเกิดน้ำท่วมก่อนและหลัง
ดำเนินโครงการซึ่งนำไปสู่การคำนวณอัตราการปล่อยน้ำอย่างเหมาะสมเพ่ือที่จะทำให้เกิดการท่วมน้อยที่สุดเท่าที่จะเป็นไป
ได ้ 

แบบจำลอง HEC-ResSim ประกอบไปด้วย 3 โมดูล คือ Watershed Setup, Reservoir Network และ Simulation 
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Watershed Setup Module เป็นเครื่องมือที่ใช้สร้างรวบรวมข้อมูลคุณลักษณะของลุ่มน้ำประกอบด้วยลำน้ำลำ
น้ำสาขาโครงการ (เช่นอ่างเก็บน้ำเขื่อน) สถานีวัดน้ำพื้นที่น้ำท่วม ช่วงเวลาการจำลองแบบและคุณลักษณะทางชลศาสตร์
ทางอุทกวิทยา 

Reservoir Network Module มีวัตถุประสงค์เพ่ือที่จะสร้างและพัฒนาแบบจำลองอ่างเก็บน้ำที่ได้จำลองแบบแล้ว
โดยนำผลที่ได้จากการจำลองแบบมาพัฒนาเป็นทางเลือก 

Simulation Module เป็นส่วนของการกำหนดค่าการจำลองแบบและแสดงผลการจำลองแบบ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



42 
 

3.2.1 ขั้นตอนกระบวนการการวิจัย (Flow Chart) 
 

 
 

รูปที่ 9 ผังกระบวนการดำเนินงาน 
 



43 
 

3.2.2 การรวบรวมข้อมูลที่ใช้ในการวิจัย 
1) ขอบเขตการศึกษา 

(1) จัดทำแบบจำลองทางชลศาสตร์ โดยการนำเข้าข้อมูลทางกายภาพของแม่น้ำ (Geometric 
Data) ประกอบด้วยระบบเครือข่ายแม่น้ำ (River Network) หน้าตัดการไหล (Cross-sections) และโครงสร้าง
ทางชลศาสตร์ (Hydraulic Structures) 

(2) นำเข้าข้อมูลการไหล (Flow Data) เช่น ระดับน้ำ หรือ อัตราการไหล และการกำหนด
รูปแบบการไหล เป็นต้น 

(3) การกำหนดเงื่อนไขขอบเขต (Boundary Condition) การกำหนดรูปแบบเงื่อนไขขอบเขต
ในแบบจำลองตามลักษณะการไหลที่กำหนด 

(4) จำลองการไหลชลศาสตร์ของแม่น้ำชี  
(5) ปรับเทียบและตรวจสอบแบบจำลองการไหลชลศาสตร์ของแม่น้ำชี 
(6) วิเคราะห์สมดุลน้ำ เกณฑ์เฝ้าระวังและเตือนภัยแล้งในลุ่มน้ำชี 

3.2.3 แบบจำลองทางคณิตศาตร์ การสร้างโครงข่ายแบบจำลองของแม่น้ำชี มีข้ันตอนดังนี้ 
1) เปิดโปรแกรม HEC-ResSim 3.3 เลือก File<New Watershed 

 
รูปที ่10 การสร้างโครงการใหม่ 
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2) สร้าง Project ที่ต้องการและตำแหน่งจัดเก็บข้อมูล หน่วย และ Time Zones 

 
รูปที่ 11 การจัดเก็บไฟล์โครงการในตำแหน่งที่ต้องการ 

3) Watershed Setup Module สร้างเส้นจำลองเส้นลำน้ำ  

 
รูปที่ 12 การสร้างเส้นจำลองเส้นลำน้ำ 
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4) การสร้างอ่างเก็บน้ำในแบบจำลอง 

 
รูปที่ 13 การสร้างอ่างเก็บน้ำ 

5) เลือกเมนู Diversion Tool เลือกจุดที่เล้นลำน้ำสายหลักที่ทำการสร้างไว้ก่อนหน้า กด Ctrl ค้าง
คลิกซ้ายเพ่ือสร้างจุดเริ่มต้นส่งน้ำ คลิกซ้ายอีกครั้งเพื่อสร้างจุดสิ้นสุด 

 
รูปที่ 14 แสดงการจุดส่งน้ำ 
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6) ทำการสร้าง Configuration กดท่ี Watershed< Configuration Editor< Configuration < 
New ทำการตั้งชื่อและกด Apply 

 
รูปที่ 15 แสดงการสร้าง Configuration 

7) เลือก Module Reservoir Network จากนั้นไปท่ีเมนู Network>New ตั้งชื่อโครงข่ายใหม่ 
เลือก Configuration กด New 

 
รูปที่ 16 การสร้างโครงข่าย Module Reservoir Network 
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8) กดไอคอน Junction Tool กด Ctrl ค้างคลิกซ้ายเพื่อสร้างจุด Junction จากนั้นทำการตั้งชื่อ กด OK  
 

 
รูปที่ 17 การสร้าง Junction 

9) กดไอคอน Reach Tool เพ่ือกำหนดระยะทางของน้ำ 

 
รูปที่ 18 การสร้าง Reach 
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10) คลิกขวาเลือก Edit Reservoir Properties ใส่ข้อมูลอ่างเก็บน้ำ 

      
รูปที่ 19 การใส่ข้อมูลอ่างเก็บน้ำ 

11) กดเลือกเมนู Alternative>Edit แล้วกดเลือก Alternative>New แล้วตั้งชื ่อใส่ข้อมูล เมื่อ
ดำเนินการใส่ข้อมูลครบถ้วนแล้วให้เลือก Alternative>Save 

 

รูปที่ 20 การสร้าง Alternative 
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12) เลือก Module Simulation กดเมนู Simulation>New ทำการตั้งค่าเวลาที่จะคำนวณ 
จากนั้นกดคำสั่ง Compute เพ่ือทำการวิเคราะห์ผล 

 

รูปที่ 21 การวิเคราะห์ผล 

3.2.4 การวิเคราะห์พ้ืนที่เสี่ยงขาดแคลนน้ำ บริเวณพ้ืนศึกษาลุ่มน้ำชี  
การวิเคราะห์พื้นที่เสี่ยงขาดน้ำ ด้วยระบบภูมิสารสนเทศนั้นเป็นเทคโนโลยีในการวิเคราะห์จากข้อมูลที่มีปัจจัยที่
ส่งผลต่อการเกิดความเสี่ยงในการเกิดพื้นที่เสี่ยงขาดแคลนน้ำ และด้วยข้อดีของเทคโนโลยีทางภูมิสารสนเทศ
สามารถนำมาประยุกต์ใช้ในการวิเคราะห์พื้นเสี่ยงขาดแคลนน้ ำ โดยศึกษาได้จากภาพถ่ายดาวทียมและดัชนีที่
เกี่ยวข้องกับการวิเคราะห์พ้ืนที่เสี่ยงขาดแคลนน้ำ ที่อาจส่งผลต่อการเกิดภัยแล้ง จึงทำให้เป็นทางเลือกในการศึกษา
เพื่อเป็นแนวทางในการศึกษาร่วมกับการศึกษาทางด้านวิศวกรรมชลประทาน ที่จะสามารถนำมาช่วยคาดการณ์
พ้ืนที่ที่จะได้รับความเสี่ยงขาดแคลนน้ำ ในบริเวณพ้ืนที่ศึกษาลุ่มน้ำชี เพ่ือให้สามารถนำไปวางแผนและเตรียมแผน
รองรับการจัดสรรน้ำทางชลประทานต่อไป 
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3.2.4.1 การวิเคราะห์หาพ้ืนที่เสี่ยงภัยแล้งจาก ทฤษฎี APH 
1).เครื่องมือ อุปกรณ์ และข้อมูลที่ใช้ในการวิจัย 

( 1 )  โ ป ร แ ก ร ม ร ะ บ บ ภ ู ม ิ ส า ร ส น เ ท ศ  (ArcGIS Desktop 10)  แ ล ะ ร ี โ ม ท เ ซ น ซิ ง  
ENVI – Image Processing and Analysis Solution 

(2) ข้อมูลภัยแล้ง  
(3 )  ข ้ อม ูลภาพถ ่ ายดาว เท ียม Landsat 8 OLI/TIRS ป ี  2563 คลอบค ุมพ ื ้ นท ี ่ ศ ึ กษา  

Path 127-129 Row 48-49 จากเว็ปไซต์ https://earthexplorer.usgs.gov (USGS,2021) 
(4) ข้อมูลพื้นที่เชิงระบบสารสนเทศภูมิศาสตร์ พื้นที่ภัยแล้ง แบบจำลองความสูงภูมิประเทศ 

ความลาดชัน เส้นทางน้ำ แหล่งน้ำ ปริมาณน้ำฝน เนื้อดิน ขอบเขตลุ่มน้ำ การใช้ประโยชน์ที่ดิน ขอบเขตการ
ปกครอง พ้ืนที่ชลประทาน ความลาดชัน 
 
 
3.3 ขั้นตอนการวิเคราะห์พื้นที่เสี่ยงภัยแล้ง 

3.3.1 ศึกษาหาข้อมูลพ้ืนที่ศึกษา ให้เข้าใจสภาพแวดล้อมทางกายภาพ ปัจจัยเบื้องต้นท่ีมีผลต่อความเสี่ยง
ภัยแล้งในพื้นที่ จากการทบทวนเอกสารและงานวิจัยที่เก่ียวข้อง 

 

 
รูปที่ 20 ขอบเขตพ้ืนที่ศึกษา 
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3.3.2 กำหนดเกณฑ์ที่ใช้ในงานวิจัย (Criteria) เพื่อประเมินพื้นที่เสี่ยงภัยแล้งด้วยเทคนิคการวิเคราะห์
ศักยภาพเชิงพ้ืนที่ (Potential Surface Analysis) โดยเกณฑ์ที่เหมาะสมในการวิเคราะห์พ้ืนที่เสี่ยงภัยแล้งในพ้ืนที่
ศึกษา มี 7 เกณฑ์ ได้แก่ ปริมาณน้ำฝนเฉลี่ยรายปี พื้นที่แล้งซ้ำซากในอดีตย้อนหลัง ระยะห่างเส้นทางน้ำ ค่าดัชนี
ความแห้งแล้งแตกต่าง(NDDI) พื้นที่ชลประทาน การระบายน้ำของดิน สภาพการใช้ประโยชน์ที่ดิน  จากนั้นให้ค่า
น้ำหนักของแต่ละเกณฑ์โดยวิธีการจัดลำดับ (Ranking Method) แบบ Rank Exponent กำหนดค่า Exponent 
Value (p) เท่ากับ 2 ทั้งนี้เมื่อวิเคราะห์ด้วยสมการ (1) แสดงค่าถ่วงน้ำหนักเป็นค่าถ่วงน้ำหนักแบบนอร์มอลไลซ์ 
(Normalized Weight) 

wi = (n − ri + 1)p

∑( n − rj + 1)p
 

โดยที่ 
Wi  = ค่าน้ำหนักที่ Normalized แล้ว -ของแต่ละตัวเกณฑ์ j (Normalized Weight) 
n  = จำนวนตัวเกณฑ์ท่ีพิจารณา (เท่ากับ 7 ตัว) 
rj  = อันดับความสำคัญของตัวเกณฑ์ j (Straight Rank) 
p  = Exponent Value (กำหนดเท่ากับ 2) 

แต ่เน ื ่องจากม ีว ิธ ีการลำด ับช ั ้นเช ิงว ิ เคราะห ์แบบ  (Analytical Hierarchy Process) หร ือ AHP 
กระบวนการลำดับชั้นเชิงวิเคราะห์เป็นกระบวนการที่ใช้ในการ “วัดค่าระดับ ”  ของการตัดสินใจในเรื่องต่างๆ ได้
อย่างมีประสิทธิภาพ และให้ผลการตัดสินใจที่ถูกต้องตรงกับเป้าหมายของการตัดสินใจได้มากที่สุด ดังตาราง
ตัวอย่าง A B และ C 
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3.3.2.1 ว ิธ ีการคำนวณค่าน ้ำหน ักของเกณฑ์ด ้วยกระบวนการว ิ เคราะห์ตามล ําด ับชั้น  
(Analytic Hierarchy Process: AHP) 
ตารางท่ี 5 Pairwise Comparison Matrix 
 ฝน แล้ง NDDI Landuse ระบายน้ำ พ้ืนที่ชลประทาน ระยะห่าง 

ฝน 1 2 3 4 5 6 7 

แล้ง 1/2 1 2 3 4 5 6 
NDDI 1/3 1/2 1 2 3 4 5 
Landuse 1/4 1/3 1/2 1 2 3 4 

ระบายน้ำ 1/5 1/4 1/3 1/2 1 2 3 

พ้ืนที่ชลประทาน 1/6 1/5 1/4 1/3 1/2 1 2 

ระยะห่าง 1/7 1/6 1/5 1/4 1/3 1/2 1 

        

ตารางท่ี 6.การใส่ค่า Pairwise Comparison Matrix 
 ฝน แล้ง NDDI Landuse ระบายน้ำ พ้ืนที่ชลประทาน ระยะห่าง   
ฝน 1.00 2.00 3.00 4.00 5.00 6.00 7.00 

  
แล้ง 0.50 1.00 2.00 3.00 4.00 5.00 6.00 

  
NDDI 0.33 0.50 1.00 2.00 3.00 4.00 5.00   
Landuse 0.25 0.33 0.50 1.00 2.00 3.00 4.00   
ระบายน้ำ 0.20 0.25 0.33 0.50 1.00 2.00 3.00 

  
พ้ืนที่ชลประทาน 0.17 0.20 0.25 0.33 0.50 1.00 2.00 

  
ระยะห่าง 0.14 0.17 0.20 0.25 0.33 0.50 1.00 

  
Total 2.59 4.45 7.28 11.08 15.83 21.50 28.00   
 
ตารางท่ี 7. การทํา normalize และคํานวณค่า Eigenvector 
 ฝน แล้ง NDDI Landuse ระบายน้ำ พ้ืนที่ชลประทาน ระยะห่าง  Eigenvector 

ฝน 0.39 0.45 0.41 0.36 0.32 0.28 0.25 2.45 0.35 

แล้ง 0.19 0.22 0.27 0.27 0.25 0.23 0.21 1.66 0.24 

NDDI 0.13 0.11 0.14 0.18 0.19 0.19 0.18 1.11 0.16 

Landuse 0.10 0.07 0.07 0.09 0.13 0.14 0.14 0.74 0.11 

ระบายน้ำ 0.08 0.06 0.05 0.05 0.06 0.09 0.11 0.49 0.07 

พ้ืนที่ชลประทาน 0.06 0.04 0.03 0.03 0.03 0.05 0.07 0.32 0.05 

ระยะห่าง 0.06 0.04 0.03 0.02 0.02 0.02 0.04 0.22 0.03 

Total 1.00 1.00 1.00 1.00 1.00 1.00 1.00 7.00 1.00 
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3.3.2.2 การทดสอบทฤษฎีความถูกต้องของเกณฑ์ที ่ใช้ในงานวิจัย  โดยวิธี CR ดัชนีวัดความ
สอดคล้องกันของเหตุผล (Consistency Ratio) 

การคำนวณหาค่าอัตราส่วนความสอดคล้อง CI RI และ CR ตามลำดับต่อไปนี้ 
การคำนวณเวกเตอร์ความสมเหตุสมผล (Weight sum vectors) ของแต่ละเกณฑ์ปัจจัยที่ได้จากการ

เปรียบเทียบทีละคู่ เพ่ือหาคำตอบความสมเหตุสมผลของผลลัพธ์งานวิจัย โดยมีสมการดังนี้ 
  

  𝐶𝑅 = 𝐶𝐼
𝑅𝐼

                                           (A) 
CR คือ อัตราส่วนความสอดคล้อง 
CI คือ สัดส่วนความสอดคล้องได้จากการคำนวณ 
RI คือ ดัชนีความสอดคล้องเชิงสุ่มได้จากตาราง 

 
ดัชนีความสอดคล้อง (Consistency Index :CI) 
 
                                                   𝐶𝐼 =

𝜆 𝓂𝒶𝓍− 𝓃

𝓃−1
 ……………………..             (B) 

กำหนดปัจจัยให้ n = จำนวนปัจจัย  
RI เป็นค่าที่ข้ึนอยู่กับตารางเมทริกซ์ 
 

ตารางท่ี 8 แสดงค่าของดัชนีความสอดคล้องตามขนาดเมตริกซ์ (Random Consistency Index :RI)  
N 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 
RI 0.00 0.00 0.58 0.90 1.12 1.24 1.32 1.41 1.45 1.49 1.51 1.48 1.56 1.57 1.59 

 
จากการอ้างอิงข้อมูลตามเกณฑ์ที่ใช้วิเคราะห์พื้นที่เสี่ยงภัยแล้ง ทั้ง 7 เกณฑ์ ดังนี้ ค่าที่นำมาใช้จะเป็น 

1.32 ดังอ้างอิงจากตาราง RI ดังนั้น การคำนวณค่าอัตราความสอดคล้อง CI RI และ CR ตามเกณฑ์ที่ใช้วิเคราะห์
พ้ืนที่เสี่ยงภัยแล้ง ตามลำดับต่อไปนี้ 
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1.) คำนวณค่าตารางเมทริกซ์ กับ ค่า Eigenvector เพ่ือหาค่า CI   
(1) หาค่าตารางเมทริกซ์  𝜆 𝓂𝒶𝓍 

𝜆 𝓂𝒶𝓍 = 

[
 
 
 
 
 
 
1.00 2.00 3.00 4.00 5.00 6.00 7.00
0.50 1.00 2.00 3.00 4.00 5.00 6.00
0.33 0.50 1.00 2.00 3.00 4.00 5.00
0.25 0.33 0.50 1.00 2.00 3.00 4.00
0.20 0.25 0.33 0.50 1.00 2.00 3.00
0.17 0.20 0.25 0.33 0.50 1.00 2.00
0.14 0.17 0.20 0.25 0.33 0.50 1.00]

 
 
 
 
 
 

 × 

[
 
 
 
 
 
 
0.35
0.24
0.16
0.11
0.07
0.05
0.03]

 
 
 
 
 
 

 = 

[
 
 
 
 
 
 
2.57
1.75
1.16
0.76
0.49
0.33
0.23]

 
 
 
 
 
 

 

 

[
 
 
 
 
 
 
2.57/0.35
1.75/0.24
1.16/0.16
0.76/0.11
0.49/0.07
0.33/0.05
0.23/0.03]

 
 
 
 
 
 

  =  

[
 
 
 
 
 
 
7.34
7.36
7.29
7.17
7.07
7.05
7.10]

 
 
 
 
 
 

   = 50.38 

 
             

(1) ค่า     𝜆 𝓂𝒶𝓍 =
 50.38

7
= 7.20                                             

(2) ค่า    𝐶𝐼 =
 7.20 − 7

7−1 
= 0.03 

2.) ค่า    𝑅𝐼 = 1.32  (จากตารางแสดงค่าของดัชนีความสอดคล้องตามขนาดเมตริกซ์ RI) 
3.) ค่า   𝐶𝑅 =

 0.03

1.32 
= 0.02 

 
ดังนั้น จากทฤษฎีดัชนีวัดความสอดคล้องกันของเหตุผล (Consistency Ratio) ที่คำนวณได้หากมีค่าน้อย

กว่า 0.1 หมายถึง การให้ความสำคัญสำหรับการเปรียบเทียบคู่ของแต่ละทางเลือกมีความน่าเชื่อถือ  
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ตารางที่ 9 เกณฑ์และค่าถ่วงน้ำหนัก เพ่ือประเมิณพ้ืนที่เสี่ยงภัยแล้ง ด้วยเทคนิคการวิเคราะห์ศักยภาพเชิงพ้ืนที่ 
ปัจจัยที่ใช้ในการศึกษา ประเภทข้อมูล คะแนน ค่าน้ำหนัก 
ปริมาณน้ำฝนเฉลี่ยรายปี  <900 มม. 

901-1200 มม. 
1201-1500 มม. 
>1501 มม. 

4 
3 
2 
1 

0.35 

พ ื ้นท ี ่ แล ้ งซ ้ ำซากในอดีต
ย้อนหลัง 

แล้ง ≥ 6 คร้ัง/10ปี 
แล้ง 4-5 คร้ัง/10ปี 
แล้ง ≤3 คร้ัง/10ปี 
ไม่เคยแล้ง 

4 
3 
2 
0 

0.24 

ค่าดัชนี NDDI 
(NDVI-NDWI) / 
(NDVI+NDWI) 

ความแห้งแล้งรุนแรงมาก 
ความแห้งแล้งรุนแรง 
ความแห้งแล้งค่อนข้างรุนแรง 
ความแห้งแล้งเบาบาง 
ไม่เกิดความแห้งแล้ง 

4 
3 
2 
1 
0 

0.16 

สภาพการใช้ประโยชน์ที่ดิน
และสิ่งคลุมดิน 

พื้นที่โล่งแจ้ง และอ่ืนๆ 
พืชไร่ 
ข้าว 
พืชสวน 
ไม้ยืนต้น ป่าไม้ พื้นที่ชุ่มน้ำ และแหล่งน้ำ 

4 
3 
2 
1 
0 

0.11 

การระบายน้ำของดิน การระบายน้ำดีถึงค่อนข้างดีมาก 
การระบายน้ำดีปานกลาง 
การระบายน้ำค่อนข้างเลว 
การระบายน้ำเลว 

4 
3 
2 
1 

0.07 

พื้นที่ชลประทาน นอกเขตชลประทาน 
ในเขตชลประทาน 

4 
2 

0.05 

ระยะห่างจากเส้นทางน้ำ > 5 กิโลเมตร 
2.1 - 5 กิโลเมตร 
0.5 - 2 กิโลเมตร 
< 0.5 กิโลเมตร 

4 
3 
2 
1 

0.03 

รวม   1.00 
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3.3.3 จัดเตรียมข้อมูลที่ใช้วิเคราะห์พื้นที่เสี่ยงภัยแล้งในระบบสารสนเทศภูมิศาสตร์  ตามเกณฑ์ที่ใช้
ว ิ เ คราะห ์พ ื ้ นท ี ่ เ ส ี ่ ย งภ ั ยแล ้ ง  ท ั ้ ง  7  เกณฑ ์  โ ดยการต ั ดข ้ อม ู ล  ( Clip), ลบขอบเขต  (Dissolve),  
รวมข้อมูล (Merge) และซ้อนทับข้อมูล (Overlay) เพื่อแบ่งชั้นข้อมูล และใส่ค่าคะแนนตามเกณฑ์ที่กำหนดไว้ใน
ตารางที่ 1 จากนั้นทำการเปลี่ยนข้อมูลเกณฑ์วิเคราะห์ทั้งหมดที่อยู่ในรูปแบบของข้อมูลเชิงพื้นให้อยู่ในรูปแบบ
ข้อมูลเชิงกริด โดยใช้คำสั่ง Polygon to Raster ในโปรแกรม ArcGIS Desktop 10 
โดยไปท่ี ArcToolbox >> Conversion Tools >> Polygon to Raster 
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และทำการจัดลำดับเกณฑ์ที่กำหนดตามเกณฑ์และค่าถ่วงน้ำหนัก เพ่ือประเมิณพ้ืนที่เสี่ยงภัยแล้ง ให้แต่ละ
ปัจจัย ด้วยคำสั่ง Reclass โดยไปท่ี ArcToolbox >> Spatial Analyst Tools >> Reclass >> Reclassify  
 

 
 
เนื่องจากShapefileของแต่ละเกณฑ์ที่นำมาใช้ มีแหล่งที่มาหลากหลาย ลักษณะการบันทึกข้อมูลจึงไม่

เหมือนกัน ดังนั้นการจัดเตรียมข้อมูลจึงแตกต่างกันบ้าง ซึ่งวิธีทำโดยละเอียดและผลลัพธ์ที่ได้จากการเตรียมข้อมูล
ตามเกณฑ์ที่ใช้วิเคราะห์พื้นที่เสี่ยงภัยแล้ง ทั้ง 7 เกณฑ์ ดังนี้ 
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3.3.3.1 ปริมาณน้ำฝนเฉลี่ยรายปี 

 
รูปที่ 21 ปริมาณน้ำฝนเฉลี่ยรายปี 

ตารางท่ี 10 ปริมาณน้ำฝนเฉลี่ยรายปี  
ปริมาณน้ำฝนเฉลี่ย ระดับ คะแนน 
น้อยกว่า 900 มิลลิเมตร พ้ืนที่ฝนตกน้อย 4 
901 – 1200 มิลลิเมตร พ้ืนที่ฝนตกปานกลาง 3 
1201 – 1500 มิลลิเมตร พ้ืนที่ฝนตกค่อนข้างมาก 2 
มากกว่า 1501 มิลลิเมตร พ้ืนที่ฝนตกมาก 1 
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- เปิดโปรแกรม ArcGIS 10.3 เพ่ือนำเข้าข้อมูลปริมาณน้ำฝนเฉลี่ยรายปี  บริเวณลุ่มน้ำชี 
 

 
 
- เปิด Attribute ของชั้นข้อมูล เพื่อตรวจเช็ค Field ที่จะใช้ในการจัดกลุ่มข้อมูล โดยดูได้จากการคลิกขวา
บนชั้นข้อมูลที่ต้องการ >> เลือก Open Attribute จากนั้นข้อมูลในตาราง Attribute ทั้งหมดจะแสดงบนหนา้จอ 
ดังภาพ 
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- จากนั้นทำการแปลงชั ้นข้อมูล จากข้อมูลในรูปแบบ Vector เป็นข้อมูล Raster โดยไปที่เครื ่องมือ 
ArcTools box >> Conversion Tools >> To Raster >> Polygon to Raster 

 

 
 
- จากนั้นใส่ชั้นข้อมูลที่ต้องการแปลงเป็น Raster ลงไป ทำการเลือก Value Field จากนั้นเลือกพื้นที่ที่
จัดเก็บชั้นข้อมูลที่ผ่านการประมวลผลแล้ว และกด OK 
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- ผลลัพธ์ที่ได้จากการแปลงข้อมูลในรูปแบบ Polygon เป็นชั้นข้อมูลในรูปแบบ Raster จะได้ดังภาพ 

 
 
- จากนั้นทำการ Reclassify ชั้นข้อมูล เพื่อนำข้อมูลผลลัพธ์ที่ได้ ไปคำนวณค่า Weighting ต่อไป โดยไปที่
เครื่องมือ ArcTools box >> Spatial Analyst Tools >> Reclass >> Reclassify 
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- จากนั้นทำการใส่ข้อมูลที่ต้องการ Reclassify ลงไป เลือก Field ที่ต้องการ Reclass แล้วใส่ค่าใหม่ที่
ต้องการลงไปในช่อง New Value จากนั้นเลือกพ้ืนที่จัดเก็บข้อมูลที่ผ่านกระบวนการ Reclassify และกด OK  

 
 
- ผลลัพธ์ที่ได้จากการ Reclassify จะได้ข้อมูลที่ทำการจัดค่าใหม่ ดังภาพ 
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3.3.3.2 พื้นที่แล้งซ้ำซากในอดีตย้อนหลัง  

 
รูปที่ 22 พื้นที่เสี่ยงภัยแล้งซ้ำซาก 

 โดยแบ่งพ้ืนที่เสี่ยงภัยแล้งซ้ำซากจากกรมพัฒนาที่ดิน มีความรุนแรง 4 ระดับ ดังนี้ 
ตารางท่ี 11 เสี่ยงภัยแล้งซ้ำซาก 
จำนวนครั้งที่เกิดภัยแล้ง ระดับเสี่ยงภัยแล้งซ้ำซาก คะแนน 
แล้ง ≥ 6 ครั้ง/10ปี ระดับรุนแรงมาก 4 
แล้ง 4-5 ครั้ง/10ปี ระดับรุนแรงปานกลาง 3 
แล้ง ≤3 ครั้ง/10ปี ระดับรุนแรงน้อย 2 
ไม่เคยแล้ง ระดับไม่รุนแรง 0 
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- เปิดโปรแกรม ArcGIS 10.3 เพ่ือนำเข้าข้อมูลพื้นที่แล้งซ้ำซากในอดีตย้อนหลัง บริเวณลุ่มน้ำชี 

 
 
- เปิด Attribute ของชั้นข้อมูล เพ่ือตรวจเช็ค Field ที่จะใช้ในการจัดกลุ่มข้อมูล Dissolve โดยดูได้จากการ
คลิกขวาบนชั้นข้อมูลที่ต้องการ >> เลือก Open Attribute จากนั้นข้อมูลในตาราง Attribute ทั้งหมดจะแสดงบน
หน้าจอ ดังภาพ 
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- จากนั้นทำการแปลงชั ้นข้อมูล จากข้อมูลในรูปแบบ Vector เป็นข้อมูล Raster โดยไปที่เครื ่องมือ 
ArcTools box >> Conversion Tools >> To Raster >> Polygon to Raster 

 
 

- จากนั้นใส่ชั้นข้อมูลที่ต้องการแปลงเป็น Raster ลงไป ทำการเลือก Value Field จากนั้นเลือกพื้นที่ที่
จัดเก็บชั้นข้อมูลที่ผ่านการประมวลผลแล้ว และกด OK 
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- ผลลัพธ์ที่ได้จากการแปลงข้อมูลในรูปแบบ Polygon เป็นชั้นข้อมูลในรูปแบบ Raster จะได้ดังภาพ 

 
 
- จากนั้นทำการ Reclassify ชั้นข้อมูล เพื่อนำข้อมูลผลลัพธ์ที่ได้ ไปคำนวณค่า Weighting ต่อไป โดยไปที่
เครื่องมือ ArcTools box >> Spatial Analyst Tools >> Reclass >> Reclassify 
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- จากนั้นทำการใส่ข้อมูลที่ต้องการ Reclassify ลงไป เลือก Field ที่ต้องการ Reclass แล้วใส่ค่าใหม่ที่
ต้องการลงไปในช่อง New Value จากนั้นเลือกพ้ืนที่จัดเก็บข้อมูลที่ผ่านกระบวนการ Reclassify และกด OK  

 
 
- ผลลัพธ์ที่ได้จากการ Reclassify จะได้ข้อมูลที่ทำการจัดค่าใหม่ ดังภาพ 
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3.3.3.3 ระยะห่างเส้นทางน้ำ 

 

รูปที่ 23 ระยะห่างจากเส้นทางน้ำ 

ตารางท่ี 12 ระยะห่างจากเส้นทางน้ำ 
ระยะห่างจากแหล่งน้ำ ระดับเสี่ยงภัยแล้ง คะแนน 
มากกว่า 5 กิโลเมตร ห่างมาก 4 
2.1 - 5 กิโลเมตร ห่างปานกลาง 3 
0.5 - 2 กิโลเมตร ห่างน้อย 2 
น้อยกว่า 0.5 กิโลเมตร ห่างน้อยที่สุด 1 
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- เปิดโปรแกรม ArcGIS 10.3 เพ่ือนำเข้าข้อมูลเส้นลำน้ำ บริเวณลุ่มน้ำชี 

 
 
- เปิด Attribute ของชั้นข้อมูล เพื่อดูข้อมูลคุณลักษณะของ Shapefile จากการคลิกขวาบนชั้นข้อมูลที่
ต้องการ >> เลือก Open Attribute แล้วทำการคัดเลือกข้อมูล โดยคำสั่ง Select By Attribute ตั้งค่าให้ช่อง 
"CLASS" แสดงเส้นถึงแค่ระดับ 1 ถึง 4 ซึ่งหมายถึงลำน้ำสายหลัก-สายรอง กำหนดค่า "CLASS" < ‘4’ ตามรูป 
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- เมื ่อคัดเลือกข้อมูลได้แล้ว จากนั ้นทำการ  Export Shapefile เพื ่อ Save เป็นไฟล์ใหม่ โดยคลิกขวา         
> Data > Export Data 

 
 
- เมื ่อเสร็จแล้ว ทำการเปิดไฟล์ผลลัพธ์ Shapefile ใหม่ที ่ได้ จากนั ้นวัดระยะห่างจากลำน้ำ ใช้คำสั่ง 
Euclidean Distance เล ือกท ี ่กล ่องเคร ื ่องม ือ ArcTool box > Spatial Analyst Tools.tbx > distance > 
Euclidean Distance และกำหนดภาพOutput cell size ที่ 30 เพื่อช่องกริดของแต่ละข้อมูลจะได้ตรงกัน 
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- เปิดไฟล์ผลลัพธ์ และทำการ Reclassify ชั้นข้อมูล เพื่อจัดลำดับชั้นค่า Weighting โดยไปที่เครื่องมือ 
ArcTool box >> Spatial Analyst Tools >> Reclass >> Reclassify 
 

 
 
- ได้ผลลัพธ์ที่ได้จากการ Reclassify สำหรับนำไปประมวลผลขั้นถัดไป ดังภาพ 
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3.3.3.4 ค่าดัชชี NDDI (ค่าดัชนีความแห้งแล้งแตกต่าง) 

 

รูปที่ 24 ดัชนีความแห้งแล้ง (NDDI) 

วิธีการคำนวณค่าดัชนีความแห้งแล้งแตกต่างแบบนอมัลไลซ์ (Normalized Different Drought 
Index : NDDI) จากข้อมูลภาพถ่ายดาวเทียม Landsat 8 OLI/TIRS โดยแสดงผลข้อมูลในลักษณะข้อมูลตัวเลข
ทศนิยม (Float) มาคำนวณหาค่าดัชนี NDDI  สร้างจากค่าดัชนีพืชพรรณแตกต่างแบบนอมัลไลซ์ (Normalized 
Difference Vegetation Index : NDVI) และค่าดัชนีความชื้นแตกต่างแบบนอมัลไลซ์ (Normalized Difference 
Water Index) มีสูตรการคำนวณดังสมการ 

 
NDDI = (NDVI – NDWI) / (NDVI + NDWI) (1) 
NDWI = (NIR – SWIR) / (NIR + SWIR)  (2) 
NDVI = (NIR - RED) / (NIR + RED)  (3) 
 

โดยที่  SWIR  = ค่าการสะท้อนในช่วงคลื่น SWIR 
           NIR  = ค่าการสะท้อนในช่วงคลื่น NIR 
            Red  = ค่าการสะท้อนในช่วงคลื่นสีแดง 
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ตารางท่ี 13 สูตรสามารถเทียบค่า Band จากภาพถ่ายดาวเทียม Landsat 8 OLI/TIRS 
 

LANDSAT - 8 Operational Land Imager (OLI)  

แบนด์ ความยาวคลื่น (ไมโครเมตร) รายละเอียดภาพ Resolution (เมตร) 

1 0.43 - 0.45 (Coastal Aerosol) 30 

2 0.45 - 0.51 (Blue) 30 

3 0.53 - 0.59 (Green) 30 

4 0.64 - 0.67 (Red) 30 

5 0.85 - 0.88 (Near Infrared NIR) 30 

6 1.57 - 1.65 (SWIR 1) 30 

7 2.11 - 2.29 (SWIR 2) 30 

8 0.50 - 0.68 (Panchromatic) 15 

9 1.36 - 1.38 (Cirrus) 30 

10 10.60 - 11.19 (Thermal Infrared - TIRS 1) 100 

11 11.50 - 12.51 (Thermal Infrared - TIRS 2) 100 
 
ดังนั้นสูตรที่ได้ คือ  

NDDI = (NDVI – NDWI) / (NDVI + NDWI)  (6) 
NDWI = (BAND 5 – BAND 6) / (BAND 5 + BAND 6) (7) 
NDVI = (BAND 5 – BAND 4) / (BAND 5 + BAND 4) (8) 
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สามารถจำแนกประเภทข้อมูลและแปลผลความแห้งแล้งจากดัชนี NDDI ของภาพถ่ายดาวเทียม Landsat 
8 จำแนกดัชนีออกเป็น 5 ระดับ ดังตารางท่ี 14 

 
ตารางท่ี 14 การจำแนกประเภทข้อมูลและแปลผลความแห้งแล้งจากดัชนี NDDI 
ค่าดัชนี NDDI ประเภทข้อมูล การแปลผล คะแนน 
0.50 – 1 พ้ืนที่เปิดโล่ง นาที่ดอน (แห้งแล้ง) ความแห้งแล้งรุนแรงมาก 4 
0.40 – 0.50 พ้ืนดินเปิดโล่งไม่มีสิ่งปกคลุมดิน (แห้ง) ความแห้งแล้งรุนแรง 3 
0.30 – 0.40 พ้ืนดินเปิดโล่งพืชปกคลุมเบาบาง (แห้ง) ความแห้งแล้งค่อนข้างรุนแรง 2 
0.20 – 0.30 บริเวณพืชปกคลุมหนาแน่นปานกลาง ความแห้งแล้งเบาบาง 1 
0.06 – 0.20 
-0.50 – 0.06 
-1 ถึง -0.50 

บริเวณพืชปกคลุกหนาแน่นมาก 
ดินมีน้ำขัง ดินชุ่มชื้น 
แหล่งน้ำ 

ไม่เกิดความแห้งแล้ง 0 
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- เปิดโปรแกรม ArcGIS 10.3 เพ่ือนำเข้าข้อมูล Raster NDVI และ NDWI  

 
- เลือกใช้เครื ่องมือ Raster Calculator โดยไปที่ ArcToolbox เลือก Spatial Analyst Tools > Map 
Algebra > Raster Calculator เพ่ือนำข้อมูล NDVI และ NDWI มาคำนวณหาข้อมูล NDDI เป็นลำดับต่อไป 
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- จะได้ผลลัพธ์ NDDI ดังภาพ และเมื่อคำนวณเสร็จ จึงนำไป Reclassify เพ่ือกำหนดคะแนน 

 
 

- ผลลัพธ์ที่ได้จากการ Reclassify จะได้ข้อมูลที่ทำการกำหนดค่าคะแนนใหม่แล้ว ดังภาพ 
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3.3.3.5 พื้นที่ชลประทาน 

 

รูปที่ 25 พื้นที่ชลประทาน 

ตารางท่ี 15 ความเสี่ยงพ้ืนที ่

ประเภทพื้นท่ี ระดับความเสี่ยง คะแนน 
พ้ืนที่ชลประทาน ความเสี่ยงน้อย 4 
ไม่ใช่พื้นท่ีชลประทาน ความเสี่ยงมาก 2 
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- เปิดโปรแกรม ArcGIS 10.3 เพ่ือนำเข้าข้อมูลพ้ืนที่ชลประทานและจังหวัดบริเวณลุ่มน้ำชี

 
 
- ทำการ Erase ข้อมูลพื้นที่ชลประทานและจังหวัดบริเวณลุ่มน้ำชี เพ่ือให้ได้พ้ืนที่นอกเขต 
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- จากนั้นทำการ Merge ข้อมูลที่ Erase กับ ข้อมูลพื้นที่ชลประทาน จะได้ไฟล์ข้อมูลพื้นที่ชลประทานที่ ใน 
และนอกเขตชลประทาน 

 
 

- ผลลัพธ์ที ่ได ้จะเป็นข้อมูลในรูปแบบ Polygon ทำการ Add Field และเพิ ่มข้อมูล “พื ้นที ่ในเขต 
ชลประทาน “ และ “นอกเขตชลประทาน” 
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- จากนั้นทำการแปลงชั ้นข้อมูล จากข้อมูลในรูปแบบ Vector เป็นข้อมูล Raster โดยไปที่เครื ่องมือ 
ArcTools box >> Conversion Tools >> To Raster >> Polygon to Raster ใ ส ่ ช ั ้ น ข ้ อ มู ล 
ที่ต้องการแปลงเป็น Raster ลงไป ทำการเลือก Value Field จากนั้นเลือกพื้นที่ที ่ จัดเก็บชั้นข้อมูลที่ผ่านการ
ประมวลผลแล้ว และกด OK 

 
 
- ผลลัพธ์ที่ได้จากการแปลงข้อมูลในรูปแบบ Polygon เป็นชั้นข้อมูลในรูปแบบ Raster จะได้ดังภาพ
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- จากนั้นทำการ Reclassify ชั้นข้อมูล เพื่อนำข้อมูลผลลัพธ์ที่ได้ ไปคำนวณค่า Weighting ต่อไป โดยไปที่ 
เ คร ื ่ อ งม ื อ  ArcTools box >> Spatial Analyst Tools >> Reclass >> Reclassify ใส ่ ข ้ อม ู ลท ี ่ ต ้ อ ง กา ร 
Reclassify ลงไป เลือก Field ที่ต้องการ Reclass แล้วใส่ค่าใหม่ท่ี ต้องการลงไปในช่อง New Value จากนั้นเลือก
พ้ืนที่จัดเก็บข้อมูลที่ผ่านกระบวนการ Reclassify และกด OK 

 
 

- ผลลัพธ์ที่ได้จากการ Reclassify จะได้ข้อมูลที่ทำการจัดค่าใหม่ ดังภาพ
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3.3.3.6 การระบายน้ำของดิน 

 

รูปที่ 26 การระบายน้ำของดิน 

ตารางท่ี 16 การระบายน้ำของดิน 

ประเภทดิน ระดับการระบายน้ำ คะแนน 
ดินทราย การระบายน้ำดีถึงค่อนข้างดีมาก 4 
ดินร่วนปนทราย การระบายน้ำดีปานกลาง 3 
ดินร่วน การระบายน้ำค่อนข้างเลว 2 
ดินเหนียว การระบายน้ำเลว 1 
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- เปิดโปรแกรม ArcGIS 10.3 เพ่ือนำเข้าข้อมูลการใช้ประโยชน์ที่ดิน บริเวณลุ่มน้ำชี

 

 
- เปิด Attribute ของชั้นข้อมูล เพื่อตรวจเช็ค Field ที่จะใช้ในการจัดกลุ่มข้อมูล โดยดูได้จากการคลิกขวา
บนชั้นข้อมูลที่ต้องการ >> เลือกOpen Attributeจากนั้นข้อมูลในตารางAttributeทั้งหมดจะแสดงบนหน้าจอดัง
ภาพ 
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- จากนั้นทำการแปลงชั้นข้อมูล จากข้อมูลในรูปแบบ Vector เป็นข้อมูล Raster โดยไปท่ีเครื่องมือ 
ArcTools box >> Conversion Tools >> To Raster >> Polygon to Raster จากนั้นใส่ชั้นข้อมูลที่ต้องการ
แปลงเป็น Raster ลงไป ทำการเลือก Value Field จากนั้นเลือกพ้ืนที่ที่ จัดเก็บชั้นข้อมูลที่ผ่านการประมวลผล
แล้วและกดOK 

 
 
- ผลลัพธ์ที่ได้จากการแปลงข้อมูลในรูปแบบ Polygon เป็นชั้นข้อมูลในรูปแบบ Raster จะได้ดังภาพ
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- จากนั้นทำการ Reclassify ชั้นข้อมูล เพื่อนำข้อมูลผลลัพธ์ที่ได้ ไปคำนวณค่า Weighting ต่อไป โดยไปที่ 
เครื ่องมือ ArcTools box >> Spatial Analyst Tools >> Reclass >> Reclassify จากนั ้นทำการใส่ข้อมูลที่
ต้องการ Reclassify ลงไป เลือก Field ที่ต้องการ Reclass แล้วใส่ค่าใหม่ที่ ต้องการลงไปในช่องNewValue 
จากนั้นเลือกพ้ืนที่จัดเก็บข้อมูลที่ผ่านกระบวนการ Reclassify และกด OK 

 
 
- ผลลัพธ์ที่ได้จากการ Reclassify จะได้ข้อมูลที่ทำการจัดค่าใหม่ ดังภาพ 
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3.3.3.7 สภาพการใช้ประโยชน์ที่ดิน 

 
รูปที่ 27 สภาพการใช้ประโยชน์ที่ดิน 

 
ตารางท่ี 17 สภาพการใช้ประโยชน์ที่ดิน 
สภาพการใช้ประโยชน์ที่ดินและสิ่งคลุมดิน ระดับความเสี่ยงภัยแล้ง คะแนน 
พ้ืนที่โล่งแจ้ง เสี่ยงภัยแล้งมาก 4 
พืชไร่ เสี่ยงภัยแล้งค่อนข้างมาก 3 
ข้าว เสี่ยงภัยแล้งปานกลาง 2 
พืชสวน เสี่ยงภัยแล้งค่อนน้อย 1 
ไม้ยืนต้น ป่าไม้ พ้ืนที่ชุ่มน้ำ และแหล่งน้ำ อื่นๆ เสี่ยงภัยแล้งน้อย 0 
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- เปิดโปรแกรม ArcGIS 10.3 เพ่ือนำเข้าข้อมูลการใช้ประโยชน์ที่ดิน บริเวณลุ่มน้ำชีเข้ามา ดังภาพ 

 
 
- เปิด Attribute ของชั้นข้อมูล เพ่ือตรวจเช็ค Field ที่จะใช้ในการจัดกลุ่มข้อมูล Dissolve โดยดูได้จากการ
คลิกขวาบนชั้นข้อมูลที่ต้องการ >> เลือก Open Attribute จากนั้นข้อมูลในตาราง Attribute ทั้งหมดจะแสดงบน
หน้าจอ ดังภาพ 
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- จากนั้นทำการ Dissolve ชั้นข้อมูลการใช้ประโยชน์ที่ดิน ด้วยเครื่องมือใน ArcTools box >> Data 
Management Tools >> Generalization >> Dissolve หรือไปที่แถบเครื่องมือด้านบน เลือก Geoprocessing 
>> Dissolve 

 
 
- จะแสดงหน้าต่างเครื่องมือ Dissolve ดังภาพ 
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- ใส่ชั ้นข้อมูลที่จะทำการ Dissolve ลงไป และเลือกพื้นที่ที ่จัดเก็บชั้นข้อมูลที่ผ่านการประมวลผลแล้ว 
จากนั้นเลือก Field ที่จะทำการ Dissolve และกด OK 

 
 
- ผลลัพธ์ที่ได้จะได้ชั้นข้อมูลที่ผ่านการจัดกลุ่ม Dissolve แล้ว ดังภาพ 
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- ผลลัพธ์ในตาราง Attribute ที่ได้จากกระบวนการ Dissolve แล้วจะทำให้ข้อมูลในทั้งหมดที่เหมือนกัน
รวมกลุ่มกันเป็นกลุ่มเดียวกัน ดังภาพ 

 
 
- จากนั้นทำการแปลงชั ้นข้อมูล จากข้อมูลในรูปแบบ Vector เป็นข้อมูล Raster โดยไปที่เครื ่องมือ 
ArcTools box >> Conversion Tools >> To Raster >> Polygon to Raster 
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- จะแสดงหน้าต่างเครื่องมือ Polygon to Raster ดังภาพ 

 
 
- จากนั้นใส่ชั้นข้อมูล Polygon ที่ต้องการแปลงเป็น Raster ลงไป ทำการเลือก Value Field จากนั้นเลือก
พ้ืนที่ที่จัดเก็บชั้นข้อมูลที่ผ่านการประมวลผลแล้ว และกด OK 
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- ผลลัพธ์ที่ได้จากการแปลงข้อมูลในรูปแบบ Polygon เป็นชั้นข้อมูลในรูปแบบ Raster จะได้ดังภาพ 

 
 

- จากนั้นทำการ Reclassify ชั้นข้อมูล เพื่อนำข้อมูลผลลัพธ์ที่ได้ ไปคำนวณค่า Weighting ต่อไป โดยไปที่
เครื่องมือ ArcTools box >> Spatial Analyst Tools >> Reclass >> Reclassify 
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- จะแสดงหน้าต่างเครื่องมือ Reclassify ดังภาพ 

 
 
- จากนั้นทำการใส่ข้อมูลที่ต้องการ Reclassify ลงไป เลือก Field ที่ต้องการ Reclass แล้วใส่ค่าใหม่ที่
ต้องการลงไปในช่อง New Value จากนั้นเลือกพ้ืนที่จัดเก็บข้อมูลที่ผ่านกระบวนการ Reclassify และกด OK 
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- ผลลัพธ์ที่ได้จากการ Reclassify จะได้ข้อมูลที่ทำการจัดค่าใหม่ ดังภาพ 

 
  



96 
 

3.4 การวิเคราะห์ข้อมูลเชิงพื้นที่ 
3.4.1 การซ้อนทับแบบกริด (Overlay) ข้อมูล เพ่ือวิเคราะห์ค่าดัชนีผลรวมความเสี่ยงต่อการเกิดความแล้ง

แห้ง (Drought Risk Index) โดยใช้กระบวนการถ่วงน้ำหนัก ตามแนวทางการวิเคราะห์การตัดสินใจแบบหลาย
หลักเกณฑ์ มีสูตรคำนวณดังสมการ (1) ทั้งนี้เพ่ือแปลงให้อยู่ในรูปสมการความเสี่ยงจะแสดงดังสมการ (2) 

Ai     ∑(wi xi)            (1) 
 

โดยที่ Ai   = ค่าคะแนนรวม 
Wi  = ค่าถ่วงน้ำหนัก 
Xi = ค่าคะแนน 

Drought Risk Index = (0.35×RA) + (0.24×DA) + (0.03×WD   (2) 
(0.16×NDDI) + (0.07×ST) + (0.11×LU) + 

(0.05×IA) 
เมื่อ    Drought Risk Index  =  ค่าดัชนีผลรวมความเสี่ยงต่อการเกิดภัยแล้ง 

RA  =  ปริมาณน้ำฝนเฉลี่ยรายปี  
DA  =  พ้ืนที่แล้งซ้ำซากในอดีตย้อนหลัง 
WD  =  ระยะห่างจากเส้นทางน้ำ 
NDDI  =  ค่าดัชนี NDDI 
ST  =  การระบายน้ำของดิน 
LU  =  สภาพการใช้ประโยชน์ที่ดินและสิ่งคลุมดิน 
IA  = พ้ืนที่ชลประทาน 
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3.4.2 ทำการวิเคราะห์โดยวิธีคำนวณค่าเกณฑ์น้ำหนัก Weighted  
จากเครื่องมือ ArcToolbox ไปที่คำสั่ง Spatial Analyst Tools >> Map Algebra >> Raster 

Calculator เพ่ือคำนวนการซ้อนทับหาพ้ืนที่เสี่ยงการเกิดความแห้งแล้ง (Drought Risk Index) เพ่ือเตรียมทำการ 
Reclassify  

 
 
 

- ผลลัพธ์ที่ได้จากการคำนวณ Map Algebra จะได้ข้อมูลระดับความเสี่ยง ดังภาพ 
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3.4.3 ทำการ Reclassify ผลการคำนวณค่าคะแนนรวม โดยแบ่งข้อมูลความเสี่ยงออกเป็น 6 ระดับ คือ 
เสี่ยงภัยแล้งมากที่สุด เสี่ยงภัยแล้งมาก เสี่ยงภัยแล้งค่อนข้างมาก เสี่ยงภัยแล้งปานกลาง เสี่ยงภัยแล้งน้อย และไม่
เสี่ยงภัยแล้ง ด้วยการแบ่งตามอันตรภาคชั้นแบบเปิด ชั้นสุดท้ายคือ ค่าต่ำกว่า 1.5 ลงไป หมายถึง พ้ืนที่ไม่เสี่ยงภัย
แล้ง ดังนั้น ต้องการแบ่งอีก 5 ชั้นที่เหลือเป็นแบบอันตรภาคชั้น( Interval Scale) ใช้สูตรการคํานวณความกว้าง
ของอันตรภาคชั้น ดังนี้ 
ความกว้างของอันตรภาคชั้น = (ข้อมูลที่มีค่าสูงสุด – ข้อมูลที่มีค่าต่ำสุด)/จํานวนชั้น 

                = (4.0 – 1.5)/5                                     

                = 0.5 

 หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับพื้นที่เสี่ยง
อุทกภัยน้ำท่วม 6 ระดับ ดังนี้ 

ตารางท่ี 18 แสดงการแบ่งชั้นข้อมูลความเสี่ยงภัยแล้ง 
ระดับความเสี่ยง คะแนน 
ระดับ 5 เสี่ยงภัยแล้งมากท่ีสุด 3.6 – 4.0 
ระดับ 4 เสี่ยงภัยแล้งมาก 3.1 – 3.5 
ระดับ 3 เสี่ยงภัยแล้งค่อนข้างมาก 2.6 – 3.0 
ระดับ 2 เสี่ยงภัยแล้งปานกลาง 2.1 – 2.5 
ระดับ 1 เสี่ยงภัยแล้งน้อย 1.6 – 2.0 
ระดับ 0 ไม่เสี่ยงภัยแล้ง < 1.5 

 
 
 

  



99 
 

จากเครื ่องมือ ArcToolbox ไปที ่คำสั ่ง Spatial Analyst Tools >> Reclass >> Reclassify 
เพ่ือคำนวนการซ้อนทับหาพื้นที่เสี่ยงการเกิดความแห้งแล้ง (Drought Risk Index) เพ่ือเตรียมทำการ Reclassify  

 

 
- ผลลัพธ์ที่ได้จากการ Reclassify จะได้ข้อมูลระดับความเสี่ยงตามที่เรากำหนด 6 ระดับ ดังภาพ 
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3.4.4 จัดทำแผนที่ความเสี่ยงรวมและรายตัวเกณฑ์ พร้อมทั้งวิเคราะห์ข้อมูลเนื้อที่ในแต่ละระดับความ
เสี่ยงเป็นจำนวนไร่และร้อยละ 

 
รูปที่ 28 แผนที่แสดงพื้นที่เสี่ยงภัยแล้ง บริเวณลุ่มน้ำชี 

- การหาจำนวนพื้นที่ ด้วยคำสั่ง Tabulate Area ไปที่ Spatial Analyst Tools >> Zonal >> Tabulate 
Area 
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- ใส่ข้อมูล ช่องInput data เป็น Shapefile ขอบเขตอำเภอ ที่ภายในAttribute Table มีข้อมูลขอบเขต
อำเภอ และจังหวัด, ช่องZone field เป็น field รหัสอำเภอ และ ช่องInput raster เป็น ไฟล์ผลลัพธ์พ้ืนที่เสี่ยงภัย
แล้ง, เลือกที่จัดเก็บ และใส่ Cell size เป็น 30 จากนั้นคลิก OK 

 
 

- ผลลัพธ์ที่ได้นำเข้าExcel เพ่ือคำนวณค่าเป็นไร่และร้อยละ เพ่ือนำเสนอข้อมูลในบทสรุป 
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3.4.5 การวิเคราะห์หาพ้ืนที่เสี่ยงภัยแล้งจากดาวเทียม โดยการศึกษาดัชนีที่มีผลต่อการเกิดพ้ืนที่เสี่ยงภัยแล้ง  
ตารางที ่ 19 การวิเคราะห์หาพื ้นที ่เสี ่ยงภัยแล้งจากดาวเทียม โดยการศึกษาดัชนีที ่มีผลต่อการเกิดพื ้นที่  
เสี่ยงภัยแล้ง  
ชื่อย่อดัชนี ชื่อเต็มของดัชนี กลุ่มของดัชนี 
NDVI Normalized Difference Vegetation Index กลุ ่มด ัชน ีอ ิงตามความเป็นพืช

พรรณ SAVI Soil-Adjusted Vegetation Index 
VCI Vegetation Condition Index 
NDWI Normalized Difference Water Index กลุ่มดัชนีอิงตามความเป็นน้ำ 
LST Land Surface Temperature กลุ่มดัชนีอิงตามอุณหภูมิ 
TCI Temperature Condition lndex 
NDDI Normalized Difference Drought Index กลุ่มดัชนีรวม 
VHI Vegetation Health Index 

ที่มา งานวิจัย ธีรภัทร์ ถิระพล 2562 การคำนวณหาดัชนีความแห้งแล้งและพืชพรรณจากอุณหภูมิพื้นผิวของข้อมูลดาวเทียมแลนด์
แซท 8 และ เปรียบเทียบกับผลผลิตข้าวในจังหวัดอุบลราชธานี 
 

1) ด ัชน ี NDVI (Normalized Difference Vegetation Index) ค่าด ัชน ีความแตกต่างพืช
พรรณ 

ดัชนีที่ใช้แสดงลักษณะของพืชพรรณ โดยดัชนี NDVI ถูกนำเสนอโดยRouse et al. (1974) ดัชนี NDVI 
อาศัยคุณสมบัติการตอบสนองต่อช่วงคลื่นที่ตามองเห็นกับการตอบสนองต่อช่วงคลื่นอินฟราเรดใกล้ที่แตกต่างกัน 
เนื่องจากคุณสมบัติที่สำคัญประการหนึ่งของพืชคือ พืชสีเขียวที่อุดมสมบูรณ์จะตอบสนองต่อช่วงคลื่นที่ตามองเห็น
ได้ต่ำกว่าการตอบสนองต่อช่วงคลื่นอินฟราเรดใกล้มาก แต่เมื่อพืชอยู่ในภาวะที่ถูกผลกระทบจากสภาพแวดล้อมจน
ความอุดมสมบูรณ์ลคลง การตอบสนองต่อช่วงคลื่นที่ตามองเห็นจะมีค่าสูงขึ้น ในขณะที่การตอบสนองต่อช่วงคลื่น
อ ิ น ฟ ร า เ ร ด ใ ก ล ้ จ ะ ม ี ก า ร ต อ บ ส น อ ง ล ด ล ง  จ า ก ค ุ ณ ส ม บ ั ต ิ ข ้ อ นี้   
เมื่อนำข้อมูลการสะท้อนของช่วงคลื่นที่ตามองเห็น โดยฉพาะในช่วงคลื่นสีแดง และข้อมูลการสะท้อนของช่วงคลื่น
อินฟราเรดใกล้ มาสร้างเป็นอัตราส่วนซึ่งกันและกันแล้ว จะช่วยให้ประสิทธิภาพในการจำแนกพืชเพ่ิมสูงขึ้น 
ซึ่งวิธีการในการคำนวณค่าดัชนี NDVI แสดงในสมการดังนี้ 
 

NDVI = (ρ0.86 – ρ0.64) / ( ρ0.86 + ρ0.64) 
 

 
Ρ0.36 = ค่าการสะท้อนกลับจากพ้ืนผิวในช่วงคลื่นอินฟาเรดใกล้ ที่มีศูนย์กลาง 0.86 ไมโครเมตร 
ρ 0.64 - ค่าการสะท้อนกลับจากพ้ืนผิวในช่วงคลื่นสีแดง ที่มีศูนย์กลาง 0.64ไมโครเมตร 
การใช้ NDVI มีประโยชน์ในหลายงาน เช่น การตรวจสอบสภาพการเจริญเติบโตของพืช, การวิเคราะห์การใช้ที่ดิน, 
การตรวจจับการเปลี่ยนแปลงทางพืช, การจัดการทรัพยากรน้ำ, และการประเมินสภาพน้ำในท่าเรือ 
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NDWI = (ρ0.86 – ρ1.24) / ( ρ0.86 + 

ρ1.24) 
 

2) ดัชนี NDWI (Normalized Difference Water Index) ค่าดัชนีความแตกต่างน้ำ 
ค ่าด ัชน ี  NDWI (Gao, 1996) เป ็นด ัชน ีท ี ่ ใช ้ เพ ื ่อต ิดตามตรวจสอบสภาพความช ื ้นในพ ืชพรรณ  

โดยใช้คุณสมบัติของช่วงคลื่นที่ตอบสนองต่อพืชสีเขียว พืชที่แห้ง และดิน รามทั้งคุณสมบัติการดูดซับและการ
กระเจิงของก๊าซและอนุภาคในบรรยากาศ โดยช่วงคลื่นที่ใช้ประกอบด้วย 2 ช่วงคลื่น คือ ช่วงคลื่นที่มีศูนย์กลางอยู่
ที่ 0.86 ไมโครเมตร และ 1.24ไมโครเมตร ช่วงคลื่นทั้งสองช่วงคลื่นมีความสามารถที่เหนือกว่าช่วงคลื่นที่นำมาใช้
ในการประเมินดัชนี NDWI ตรงที่สามารถทะลุทะลวงผ่านชั้นบรรยากาศและเรือนยอดพืชได้ในระดับเดียวกัน ช่วง
คลื ่น 1.24 ไมโครเมตร ซึ ่งเป็นอินฟราเรดคลื ่นสั ้นใช้สำหรับตรวจวัดปริมาณน้ำในพืช ส่วนช่วงคลื ่น 0.86 
ไมโครเมตร เป็นช่วงคลื่นอินฟราเรดใกล้ซึ่งมีคุณสมบัติในการตรวจวัดการเปลี่ยนแปลงของปริมาณสารอินทรีย์แห้ง
และโครงสร้างภายในของใบพืช ดังนั้น ดัชนี NDWI จึงมีความสมบูรณ์สำหรับใช้ในการตรวจวัดโมเลกุลของน้ำใน
เรือนยอดพืชซึ่งมีปฏิกิริยากับรังสีความร้อนจากแสงอาทิตย์ที่ผ่านเข้ามาในบรรยากาศโลก และมีความไวต่อชั้น
บรรยากาศน้อยกว่าดัชนี NDWI เนื่องจากช่วงคลื่น 0.86ไมโครเมตร และ 1.24 ไมโครเมตร ที่ใช้ในการคำนวณ
ดัชนี NDWI นั้น มีการดูดซับของไอน้ำในบรรยากาศน้อยมาก ผลการศึกษาพบว่า ปริมาณ ไอน้ำในบรรยากาศที่มี
ผลมากที่สุดต่อค่า NDWI คือ 1.50, 0.74, 0.37 และ 0.22 เปอร์เซ็นต์ สำหรับอนุภาคน้ำขนาด 0.05, 0.1, 0.2 
และ 0.4 เซนติเมตรตามลำดับ สำหรับค่าดัชนี NDWI สามารถประเมินได้โดยใช้สมการ ดังนี้ 

 
 

 
ρ0.36 = ค่าการสะท้อนกลับจากพ้ืนผิวในช่วงคลื่นอินฟาเรดใกล้ ที่มีศูนย์กลาง 0.86 ไมโครเมตร 
ρ1.24 – ค่าการสะท้อนกลับจากพ้ืนผิวในช่วงคลื่นอินฟาเรดคลื่นสั้น ที่มีศูนย์กลาง 1.24ไมโครเมตร 
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3) .ดัชนี NDDI (Normalized Difference Drought Index)  ดัชนีความแตกต่างแล้ง 

ดัชนีที่ใช้ในการประเมินสภาพแล้งในพื้นที่ โดยการใช้ค่าดัชนี NDVI และ NDWI พบว่าดัชนีทั้งสองมีความ
สอดคล้องกันทั้งในช่วงแล้งและช่วงชุ่มชื้น โดยดัชนีNDWI มีความไวต่อการเปลี่ยนแปลงความแห้งแล้ง หรือ
ความชื้นมากกว่า และเม่ือนำดัชนีทั้งสองมาหาอัตราส่วนระหว่างกัน สามารถช่วยเพิ่มประสิทธิภาพในด้านความไว
ต่อสภาพความแห้งแล้งดีกว่าใช้ดัชนีเพียงตัวใดตัวหนึ่ง จึงได้เสนอแนะให้ใช้วิธีดังกล่าวเป็นดัชนี NDDI ดังแสดงใน
สมการดังนี ้
 

NDDI = (NDVI – NDWI)/ (NDVI + NDWI) 
NDVI คือ Normalized Difference Vegetation Index (ค่าดัชนีความแตกต่างพืชพรรณ) 
NDWI คือ Normalized Difference Water Index (ค่าดัชนีความแตกต่างน้ำ) 

 
NDDI มีความสามารถในการตรวจจับการเปลี ่ยนแปลงในสภาพแดดและการมีน้ำในพื้นที่ ทำให้เป็น

เครื ่องมือที ่มีประโยชน์ในการติดตามสภาพอากาศแล้งหรือสภาพน้ำในพื้นที ่ ซึ ่งสามารถช่วยในการจัดการ
ทรัพยากรน้ำและการเกษตร ค่าของ NDDI ที่ได้จะมีค่าอยู่ในช่วง -1 ถึง 1, โดยค่าที่เป็นบวกมากแสดงถึงสภาพ
แดดมากและน้ำน้อย (การแห้ง), ค่าเป็นศูนย์แสดงถึงสภาพปกติ, และค่าที่เป็นลบมากแสดงถึงสภาพน้ำมากและ
แดดน้อย (การน้ำท่วม) 

4). ดัชนี VHI (Vegetation Health Index) ดัชนีความสมบูรณ์ของพืชพรรณ 
ดัชนีที ่ใช้ในการประเมินสุขภาพของพืชหรือพื ้นที ่เพาะปลูก. ดัชนีนี ้สามารถใช้ในการติดตามการ

เจริญเติบโตของพืชและความสมดุลของน้ำในพ้ืนที่. Vegetation Health Index ถูกพัฒนาขึ้นมาเพ่ือทำนายปัญหา
ที่เกี่ยวข้องกับพืช เช่น การขาดน้ำ , การเจริญเติบโตที่ไม่ปกติ, หรือปัญหาที่เกี่ยวข้องกับสภาพอากาศที่ส่งผล
กระทบต่อพืช สามารถใช้ข้อมูล NDVI และ LST ได้สร้างดัชนีสำหรับการตรวจสอบความแห้งแล้ง VCI แสดงให้เห็น
ถึงภาวะปกติของค่า NDVI เทียบกับค่าสูงสุดและต่ำสุดของ NDVI TCI ใช้ค่าความสว่างเพื่อประเมินความแห้งแล้ง
แทนของระดับอุณหภูมิของพืช ค่า VHI คำนวณโดยการรวม VCI และ TCI คำนวณ VCI, TCI และ VHI ด้วยสมา
การดังนี ้
 

VCI = (NDVI – NDVI)min / (NDVI – NDVI)max   สมการที่ 1 
TCI = (LST-LST)min / (LST-LST)max        สมการที่ 2 
VHI = a*VCI+b*TC           สมการที่ 3 

 

NDVIminและ NDVImax เป ็นค ่าต ่ำส ุดและส ูงส ุดของNDVI ตามลำด ับ ส ่วน LSTmin และ  LSTmax  
มีค่าต่ำสุดและสูงสุด ค่า LST ตามลำดับ a และ b เป็นค่าสัมประสิทธิ์น้ำหนักของ VCI และ TCI เนื่องจากมีส่วน
ร่วมของความชื้นและอุณหภูมิในช่วงพืชที่ไม่ทราบแน่ชัดจึงต้องสมมติว่า  ค่าของ VCI และ TCI เท่ากับ (a = b = 
0.5) VHI ที่ได้จะสามารถให้ข้อมูลเกี่ยวกับสถานะการเจริญเติบโตของพืชโดยคำนวณมีความสัมพันธ์กับสภาพ
อากาศและปริมาณน้ำในพื้นที่นั้น แต่อย่างไรก็ตาม , การใช้ VHI ขึ้นอยู่กับข้อมูลที่ใช้ในการคำนวณ และการปรับ
สภาพภูมิอากาศที่มีผลต่อการอ่านของดัชนีนี้  
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5). ดัชนี SAVI (Soil-Adjusted Vegetation Index) ดัชนีพืชพรรณปรับแก้หน้าดิน 

ดัชนีทางดาวเทียมที่ถูกพัฒนาขึ้นเพื่อปรับปรุง NDVI (Normalized Difference Vegetation Index) ใน
กรณีพื้นที่มีการเปลี่ยนแปลงของลักษณะทางดิน ดัชนี SAVI ใช้สูตรที่มีการปรับค่าเพื่อลดผลกระทบที่เกิดจาก
ความแตกต่างในลักษณะทางดินและพืช วิธีนี้มักใช้ในดินแดนแห้งแล้งที่มีพืชปกคลุมอยู่ในระดับต่ำ มีสูตร การ
คำนวณคล้ายๆ กับ NDVI แต่มีการให้ค่าคงที่ (L) เพิ่มขึ้นเพื่อลดอิทธิพลของค่าการสะท้อนจากดินที่เป็นพื้น ล่าง
ของพืชพรรณ ดังแสดงในสมการดังนี้ 
 

SAVI= (1+L)× (NIR-RED)/(NIR+RED+L) 
L คือ factor ปรับค่า (ลดความบางบอบชั้น) ซึ่งมักมีค่าที่ตั้งไว้ในช่วง 0.5 ถึง 1.0 

 
 

การปรับปรุงด้วย L ช่วยลดผลกระทบจากการเปลี่ยนแปลงของลักษณะทางดินที่ส่งผลต่อการวัดค่า NDVI ในพ้ืนที่
ที่มีการแตกต่างมาก SAVI มักถูกนำมาใช้ในการตรวจสอบสภาพแวดล้อมที่มีการเปลี่ยนแปลงของพื้นที่ดินหรือ
สภาพดินที่ไม่สม่ำเสมอ 

การศึกษาครั้งนี้ใช้ ผลิตภัณฑ์จากดาวเทียม MODIS โดยใช้ ผลิตภัณฑ์MOD11C3 และ MOD13C2 ที่ดาว
โหลดทางเว็บไซด์ท่ีให้ บริการที่ https://search.earthdata.nasa.gov/search 
ดาวเทียม Terra และ Aqua (MODIS) 

ระบบ MODIS มีชื่อเต็มๆ ว่า Moderate Resolution Imaging Spectroradiometer เป็น 1 ใน 5 ของ
ระบบเซนเซอร์ที่ติดตั้งบนดาวเทียม Terra และ Aqua เป็นดาวเทียมในกลุ่มดาวเทียมสำรวจโลก ดาวเทียมทั้ง 2 
ดวงมีวงโคจรอยู่ที่ระดับ 705 กิโลเมตร ระบบ MODIS มี 36 แบนด์ ตั้งแต่ความยาวคลื่น 0.4 ถึง 14.4 ไมครอน มี
ขนาดความละเอียดเชิงพื้นที่แตกต่างกัน 3 ระดับคือ ที่ขนาด 250 เมตร (แบนด์ 1 และ 2) ขนาด 500 เมตร 
(แบนด์ 3 – 7) และขนาด 1 กิโลเมตร (29 แบนด์ที่เหลือ) จากคุณลักษณะดังกล่าว ทำให้ข้อมูลที่ได้จากดาวเทียม
ระบบ MODIS จัดว่าเป็นอีกระบบหนื่งที่สามารถใช้จัดทำอนุพันธ์ภาพที่ใช้ทำดัชนีความแห้งแล้งได้  
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ตารางท่ี 20 แสดง Brand ดาวเทียม MODIS ระบบ Terra ทั้งหมด 36 Brand 
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6). ดัชนี NDVI  ค่าดัชนีความแตกต่างพืชพรรณ 

สำหรับการดาวน์โหลดข้อมูล Normalized Difference Vegetation Index จะใช้โค้ดดังต่อไปนี้
ในการดาวน์โหลดข้อมูล 

(1).เลือกชุดภาพ Dataset ของข้อมูล NDVI และกำหนดช่วงเวลาที่ต้องการ 
var dataset = ee.ImageCollection('MODIS/MYD09GA_006_NDVI') 
                  .filter(ee.Filter.date('2022-04-01', '2022-04-30')); 
var ndvi = dataset.select('NDVI'); 
var ndviVis = { 
  min: -1.0, 
  max: 1.0, 
  palette: [ 
    'ffffff', 'ce7e45', 'df923d', 'f1b555', 'fcd163', '99b718', '74a901', 
    '66a000', '529400', '3e8601', '207401', '056201', '004c00', '023b01', 
    '012e01', '011d01', '011301' 
  ], 
(2).NDVI ในพ้ืนที่ลุ่มน้ำชี 
var clippedNdviTerra = ndvi.map(function(image) { 
  return image.clip(chi); 
 
Map.setCenter(102.572487, 16.098426, 7); 
Map.addLayer(ndvi, ndviVis, 'NDVI', false); 
Map.addLayer(clippedNdviTerra, ndviVis, 'NDVI Study Area'); 
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 (3).Export ข้อมูลที่ได้จากการวิเคราะห์ 
Export.image.toDrive({ 
    folder: 'Google Earth Engine/MODIS_NDVI', 
    image: clippedNdviTerra.mosaic(),  // Use mosaic() to create a single Image from 

ImageCollection 
    description: 'NDVI_202204APR_TERRA', 
    scale: 463.313, 
    region: chi 
}); 
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7). ดัชนี NDWI ค่าดัชนีความแตกต่างน้ำ 
สำหรับการดาวน์โหลดข้อมูล Normalized Difference Water Index จะใช้โค้ดดังต่อไปนี้ใน

การดาวน์โหลดข้อมูล 
(1).เลือกชุดภาพ Dataset ของข้อมูล NDVI และกำหนดช่วงเวลาที่ต้องการ 
var dataset = ee.ImageCollection("MODIS/MYD09GA_006_NDWI") 
                  .filter(ee.Filter.date('2022-04-01', '2022-04-30')); 
var ndwi = dataset.select('NDWI'); 
var ndwiVis = { 
  min: 0.0, 
  max: 1.0, 
  palette: ['0000ff', '00ffff', 'ffff00', 'ff0000', 'ffffff'], 
}; 
 

(2).วิเคราะห์ NDWI ในพ้ืนที่ลุ่มน้ำชี 
var clippedNdwiTerra = ndwi.map(function(image) { 
  return image.clip(chi); 
}); 
 
Map.setCenter(102.572487, 16.098426, 7); 
Map.addLayer(ndwi, ndwiVis, 'NDWI', false); 
Map.addLayer(clippedNdwiTerra, ndwiVis, 'NDWI Study Area'); 
 
(3)..Export ข้อมูลที่ได้จากการวิเคราะห์ 
Export.image.toDrive({ 
    folder: 'Google Earth Engine', 
    image: clippedNdwiTerra.mosaic(),  // Use mosaic() to create a single Image from 

ImageCollection 
    description: 'NDWI_202204APR', 
    scale: 463.313, 
    region: chi 
}); 
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8).ดัชนี NDDI ดัชนีความแตกต่างแล้ง 
 

ใช้เครื่องมือในโปรแกรมทางสารสนเทศภูมิศาสตร์ ไปที่ Spatial Analyst Tools > Extraction 
>  Map  Algebra > Raster Calculator ทำการเลือกข้อมูลและคำนวณตามสูตรดัชนีที่กำหนด   
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8). ดัชนี VHI   ดัชนีความสมบูรณ์ของพืชพรรณ 
VHI = a*VCI+b*TC 

 
ใ ช้

เครื่องมือใน
โ ป ร แ ก ร ม
ท า ง
สารสนเทศ
ภ ูม ิศาสตร์  
ไ ป ที่  

Spatial 
Analyst 

Tools > 
Extraction 

>  Map  Algebra > Raster Calculator ทำการเลือกข้อมูลและคำนวณตามสูตรดัชนีที่กำหนด   

9) ดัชนี VCI ดัชนีวัดการเจริญเติบโตของพืช 
(NDVI – NDVI)min / (NDVI – NDVI)max 

 
ใ ช้

เคร ื ่ องมือ
ใ น
โปรแกรม
ท า ง
สารสนเทศ
ภูมิศาสตร์ 
ไ ป ที่  

Spatial 
Analyst 

Tools > 
Extraction >  Map  Algebra > Raster Calculator ทำการเลือกข้อมูลและคำนวณตามสูตรดัชนีที่กำหนด   
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10). ดัชนี TCI 
TCI = (LST-LST)min / (LST-LST)max  

 
 
ใช้เครื ่องมือในโปรแกรมทางสารสนเทศภูมิศาสตร์ ไปที ่ Spatial Analyst Tools > Extraction >  Map  

Algebra > Raster Calculator ทำการเลือกข้อมูลและคำนวณตามสูตรดัชนีที่กำหนด   
 

11).ดัชนี LST สำหรับการดาวน์โหลดข้อมูลอุณหภูมิพ้ืนผิว (LST) จะใช้โค้ดดังต่อไปนี้ในการแปลงค่า
จากองศาเคลวิน (°K) เป็นเซลเซียส (°C) และดาวน์โหลดข้อมูล 

(1).ข้อมูลแผนที่พ้ืนที่ศึกษาจาก FAO กรองด้วยการใช้พิกัดภูมิศาสตร์ที่ได้จาก Google 
var geometry = ee.Geometry.Point([102.8043219, 16.3566244]);  
//กรองพื้นที่จังหวัดด้วยจุดพิกัด geometry //ขอบเขตจังหวัด: 2015/level1, ขอบเขตอำเภอ: 
2015/level2 
var roi = ee.FeatureCollection('FAO/GAUL/2015/level1') 
                    .filterBounds(chi); 
Map.addLayer(chi, {},'ขอบเขตพ้ืนที่ศึกษา',false); 
Map.centerObject(roi, 7); 
 
(2).เลือกชุดภาพ Dataset ของอุณหภูมิพ้ืนผิวในช่วงเวลาที่ต้องการ 
var modis = ee.ImageCollection('MODIS/061/MOD11A2'); 
var start = ee.Date('2022-11-01'); //กำหนดช่วงเวลาวันตั้งต้น 
var dateRange = ee.DateRange(start, start.advance(1, 'month'));  
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(3).กรองข้อมูลช่วงเวลากลางวัน/กลางคืน 
var modLSTday = modis.filterDate(dateRange).select('LST_Day_1km'); // กลางคืนใช้ 
LST_Night_1km 
 
(4).แปลงข้อมูลจากจากองศาเคลวิน (°K) เป็นเซลเซียส (°C) 
var modC = modLSTday.map(function(image) { 
  return image 
    .multiply(0.02) 
    .subtract(273.15) 
    .copyProperties(image, ['system:time_start']); 
}); 
(5).วิเคราะห์ LST ในพ้ืนที่ลุ่มน้ำชี 
var LSTclip = modC.mean().clip(chi); 
Map.addLayer(LSTclip, {min: 25 , max: 35 ,  palette: ['blue', 'limegreen', 'yellow', 
'darkorange', 'red']}, 'Mean temperature'); 

(6).Export ข้อมูลที่ได้จากการวิเคราะห์ 
Export.image.toDrive({ 
    folder: 'Google Earth Engine', 
    image: LSTclip, 
    description: 'LST_Celsius_TERRA_Chi', 
    scale: 1000, 
    region: chi 
}); 
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12). ดัชนี SAVI ดัชนีพืชพรรณปรับแก้หน้าดิน  
SAVI= (1+L)* (NIR-RED)/(NIR+RED+L) 

 
ใช้เครื ่องมือในโปรแกรมทางสารสนเทศภูมิศาสตร์ ไปที ่ Spatial Analyst Tools > Extraction >  Map  

Algebra > Raster Calculator ทำการเลือกข้อมูลและคำนวณตามสูตรดัชนีที่กำหนด  
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3.4.6 การทำ Reclassify  
1) ดัชนี NDVI ดัชนีความแตกต่างพืชพรรณ 

 
ใช ้ เคร ื ่องม ือในโปรแกรมทางสารสนเทศภูม ิศาสตร ์  ไปท ี ่  Spatial Analyst Tools > Reclass >  

Reclassify ทำการกำหนดค่า Value ออกเป็น 5 ระดับสูงไปต่ำ ตามลำดับ 

 
หลังใช้คำสั่ง Reclassify จะปรากฎ Attribute เพ่ือใส่ Rankและคำอธิบายความหมายในแต่ละ Rank 
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2) ดัชนี NDWI  ดัชนีความแตกต่างน้ำ 

 

ใช ้ เคร ื ่องม ือในโปรแกรมทางสารสนเทศภูม ิศาสตร ์  ไปท ี ่  Spatial Analyst Tools > Reclass >  
Reclassify ทำการกำหนดค่า Value ออกเป็น 5 ระดับสูงไปต่ำ ตามลำดับ 

 

หลังใช้คำสั่ง Reclassify จะปรากฎ Attribute เพ่ือใส่ Rankและคำอธิบายความหมายในแต่ละ Rank 
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3) ดัชนี NDDI  ดัชนีความแตกต่างแล้ง 

 
ใช ้ เคร ื ่องม ือในโปรแกรมทางสารสนเทศภูม ิศาสตร ์  ไปท ี ่  Spatial Analyst Tools > Reclass >  

Reclassify ทำการกำหนดค่า Value ออกเป็น 5 ระดับสูงไปต่ำ ตามลำดับ 

 
หลังใช้คำสั่ง Reclassify จะปรากฎ Attribute เพ่ือใส่ Rankและคำอธิบายความหมายในแต่ละ Rank 
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4) ดัชนี VHI ดัชนีความสมบูรณ์ของพืชพรรณ 

 
ใช ้ เคร ื ่องม ือในโปรแกรมทางสารสนเทศภูม ิศาสตร ์  ไปท ี ่  Spatial Analyst Tools > Reclass >  

Reclassify ทำการกำหนดค่า Value ออกเป็น 5 ระดับสูงไปต่ำ ตามลำดับ 

 
หลังใช้คำสั่ง Reclassify จะปรากฎ Attribute เพ่ือใส่ Rank และคำอธิบายความหมายในแต่ละ Rank ลง

ใน คอล 
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5) ดัชนี VCI ดัชนีวดการเจริญโตของพืช 

 
ใช ้ เคร ื ่องม ือในโปรแกรมทางสารสนเทศภูม ิศาสตร ์  ไปท ี ่  Spatial Analyst Tools > Reclass >  

Reclassify ทำการกำหนดค่า Value ออกเป็น 5 ระดับสูงไปต่ำ ตามลำดับ 

 
หลังใช้คำสั่ง Reclassify จะปรากฎ Attribute เพ่ือใส่ Rankและคำอธิบายความหมายในแต่ละ Rank 
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6) ดัชนี TCI ดัชนีวัดอุณหภูมิ 

 
ใช ้ เคร ื ่องม ือในโปรแกรมทางสารสนเทศภูม ิศาสตร ์  ไปท ี ่  Spatial Analyst Tools > Reclass >  

Reclassify ทำการกำหนดค่า Value ออกเป็น 5 ระดับสูงไปต่ำ ตามลำดับ 

 
หลังใช้คำสั่ง Reclassify จะปรากฎ Attribute เพ่ือใส่ Rankและคำอธิบายความหมายในแต่ละ Rank 
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7) ดัชนี LST ดัชนีวัดอุณหภูมิพ้ืนผิว 

 
ใช ้ เคร ื ่องม ือในโปรแกรมทางสารสนเทศภูม ิศาสตร ์  ไปท ี ่  Spatial Analyst Tools > Reclass >  

Reclassify ทำการกำหนดค่า Value ออกเป็น 5 ระดับสูงไปต่ำ ตามลำดับ 

 
หลังใช้คำสั่ง Reclassify จะปรากฎ Attribute เพ่ือใส่ Rankและคำอธิบายความหมายในแต่ละ Rank 
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8) ดัชนี SAVI  ดัชนีพืชพรรณปรับแก้หน้าดิน 

 
ใช ้ เคร ื ่องม ือในโปรแกรมทางสารสนเทศภูม ิศาสตร ์  ไปท ี ่  Spatial Analyst Tools > Reclass >  

Reclassify ทำการกำหนดค่า Value ออกเป็น 5 ระดับสูงไปต่ำ ตามลำดับ 

 
หลังใช้คำสั่ง Reclassify จะปรากฎ Attribute เพ่ือใส่ Rankและคำอธิบายความหมายในแต่ละ Rank 
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3.5 การวิเคราะห์หาพื้นที่เสี่ยงภัยแล้ง ตามรายจังหวัด อำเภอ ตำบล 
3.5.1 ดัชนี NDVI  ดัชนีความแตกต่างพืชพรรณ 

 
1. นำชุด Data ดัชนีที่ Reclass แล้ว มาเข้าโปรแกรม Arcmap 10.3 

 

2. ใช้เครื่องมือ Tool > Conversion Tools > From Raster > Raster to Polygon เมื่อคลิกแล้วจะได้
หน้าต่างขึ้นมา ให้ใส่ข้อมูลดัชนีที่ต้องการแปลงจาก Raster เป็น polygon ในช่อง Input raster เลือก 
Field > New value (แทนเลขที่แสดงค่าแต่ละระดับในข้อมูลแต่ละดัชนี) > Save > OK 
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3. เมื่อแปลงเป็น Polygon แล้ว จะได้ผลลัพธ์ดังภาพ 

 

 
4. นำข้อมูล polygon ที่ทำการแปลงไว้ มาวิเคราะห์ต่อด้วย Tool > Tabulate Area โดยนำ shapefile 

ข้อมูลตำบล อำเภอ จังหวัด มาใส่ในช่อง Input raster ช่องแรก > Zone field เลือกเป็น T_CODE และ
ในช่อง Input raster ช่องที่สองให้นำข้อมูลที่แปลงจาก raster เป็น polygon แต่ละดัชนีมาใส่ > Class 
field เลือก gridcode > Save > OK 
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5. เมื่อเสร็จแล้ว ผลลัพธ์จะได้จะออกมาในรูปแบบข้อมูลในตาราง Attribute ดังภาพ 

 
6. เมื ่อนำ polygon มาวิเคราะห์ให้ได้ข้อมูลใน Attribute แล้ว จึงนำข้อมูล shapefile ตำบล อำเภอ 

จังหวัด มา join กับข้อมูลอีกครั้ง เพื่อเชื่อม T_Code ให้ข้อมูลสามารถเชื่อมโยงกันได้ โดยทำการ Join 
data > เลือก shapefile ตำบล จังหวัด อำเภอ > เลือกตัวเชื่อมระหว่างสองไฟล์ คือ T_Code > OK 
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7. เมื่อเสร็จแล้ว ไฟล์ข้อมูลจะเชื่อมกันและเป็นข้อมูลชุดเดียวกัน ดังภาพ  

 

 
8. จากนั้น นำข้อมูลจากตาราง Attribute ที่วิเคราะห์ข้อมูลทุกอย่างเรียบร้อยแล้ว มาใส่ใน Excel และนำ

ข้อมูลไปใช้สรุปต่อไป 
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3.5.2 ดัชนี NDWI ดัชนีความแตกต่างน้ำ  

 
1. นำชุด Data ดัชนีที่ Reclass แล้ว มาเข้าโปรแกรม Arcmap 10.3 

 
2. ใช้เครื ่องมือ Tool > Conversion Tools > From Raster > Raster to Polygon เมื ่อคลิกแล้วจะได้
หน้าต่างขึ้นมา ให้ใส่ข้อมูลดัชนีที่ต้องการแปลงจาก Raster เป็น polygon ในช่อง Input raster เลือก Field > 
New value (แทนเลขที่แสดงค่าแต่ละระดับในข้อมูลแต่ละดัชนี) > Save > OK 
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3. เมื่อแปลงเป็น Polygon แล้ว จะได้ผลลัพธ์ดังภาพ 

 

 
4. นำข้อมูล polygon ที่ทำการแปลงไว้ มาวิเคราะห์ต่อด้วย Tool > Tabulate Area โดยนำ shapefile 

ข้อมูลตำบล อำเภอ จังหวัด มาใส่ในช่อง Input raster ช่องแรก > Zone field เลือกเป็น T_CODE และ
ในช่อง Input raster ช่องที่สองให้นำข้อมูลที่แปลงจาก raster เป็น polygon แต่ละดัชนีมาใส่ > Class 
field เลือก gridcode > Save > OK 
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5. เมื่อเสร็จแล้ว ผลลัพธ์จะได้จะออกมาในรูปแบบข้อมูลในตาราง Attribute ดังภาพ 

 

 
6. เมื ่อนำ polygon มาวิเคราะห์ให้ได้ข้อมูลใน Attribute แล้ว จึงนำข้อมูล shapefile ตำบล อำเภอ 

จังหวัด มา join กับข้อมูลอีกครั้ง เพื่อเชื่อม T_Code ให้ข้อมูลสามารถเชื่อมโยงกันได้ โดยทำการ Join 
data > เลือก shapefile ตำบล จังหวัด อำเภอ > เลือกตัวเชื่อมระหว่างสองไฟล์ คือ T_Code > OK 
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7. เมื่อเสร็จแล้ว ไฟล์ข้อมูลจะเชื่อมกันและเป็นข้อมูลชุดเดียวกัน ดังภาพ  

 

 
8. จากนั้น นำข้อมูลจากตาราง Attribute ที่วิเคราะห์ข้อมูลทุกอย่างเรียบร้อยแล้ว มาใส่ใน Excel และนำ

ข้อมูลไปใช้สรุปต่อไป 
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3.5.3 ดัชนี NDDI  ดัชนีความแตกต่างแล้ง 

 
1. นำชุด Data ดัชนีที่ Reclass แล้ว มาเข้าโปรแกรม Arcmap 10.3 

 

 

2. ใช้เครื่องมือ Tool > Conversion Tools > From Raster > Raster to Polygon เมื่อคลิกแล้วจะได้
หน้าต่างขึ้นมา ให้ใส่ข้อมูลดัชนีที่ต้องการแปลงจาก Raster เป็น polygon ในช่อง Input raster เลือก 
Field > New value (แทนเลขที่แสดงค่าแต่ละระดับในข้อมูลแต่ละดัชนี) > Save > OK 
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3. เมื่อแปลงเป็น Polygon แล้ว จะได้ผลลัพธ์ดังภาพ 
 

 
4. นำข้อมูล polygon ที่ทำการแปลงไว้ มาวิเคราะห์ต่อด้วย Tool > Tabulate Area โดยนำ shapefile 

ข้อมูลตำบล อำเภอ จังหวัด มาใส่ในช่อง Input raster ช่องแรก > Zone field เลือกเป็น T_CODE และ
ในช่อง Input raster ช่องที่สองให้นำข้อมูลที่แปลงจาก raster เป็น polygon แต่ละดัชนีมาใส่ > Class 
field เลือก gridcode > Save > OK 
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5. เมื่อเสร็จแล้ว ผลลัพธ์จะได้จะออกมาในรูปแบบข้อมูลในตาราง Attribute ดังภาพ 

 

 
6. เมื ่อนำ polygon มาวิเคราะห์ให้ได้ข้อมูลใน Attribute แล้ว จึงนำข้อมูล shapefile ตำบล อำเภอ 

จังหวัด มา join กับข้อมูลอีกครั้ง เพื่อเชื่อม T_Code ให้ข้อมูลสามารถเชื่อมโยงกันได้ โดยทำการ Join 
data > เลือก shapefile ตำบล จังหวัด อำเภอ > เลือกตัวเชื่อมระหว่างสองไฟล์ คือ T_Code > OK 
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7. เมื่อเสร็จแล้ว ไฟล์ข้อมูลจะเชื่อมกันและเป็นข้อมูลชุดเดียวกัน ดังภาพ  
 

 
8. จากนั้น นำข้อมูลจากตาราง Attribute ที่วิเคราะห์ข้อมูลทุกอย่างเรียบร้อยแล้ว มาใส่ใน Excel และนำ

ข้อมูลไปใช้สรุปต่อไป 
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3.5.4 ดัชนี VH ดัชนีความสมบูรณ์ของพืชพรรณ 
 

 
1. นำชุด Data ดัชนีที่ Reclass แล้ว มาเข้าโปรแกรม Arcmap 10.3 

 

2. ใช้เครื่องมือ Tool > Conversion Tools > From Raster > Raster to Polygon เมื่อคลิกแล้วจะได้
หน้าต่างขึ้นมา ให้ใส่ข้อมูลดัชนีที่ต้องการแปลงจาก Raster เป็น polygon ในช่อง Input raster เลือก 
Field > New value (แทนเลขที่แสดงค่าแต่ละระดับในข้อมูลแต่ละดัชนี) > Save > OK 
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3. เมื่อแปลงเป็น Polygon แล้ว จะได้ผลลัพธ์ดังภาพ 
 

 
4. นำข้อมูล polygon ที่ทำการแปลงไว้ มาวิเคราะห์ต่อด้วย Tool > Tabulate Area โดยนำ shapefile 

ข ้ อ ม ู ล ต ำ บ ล  อ ำ เ ภ อ  จ ั ง ห ว ั ด  ม า ใ ส ่ ใ น ช ่ อ ง  Input raster ช ่ อ ง แ ร ก  > Zone field  
เ ล ื อก เป ็ น  T_CODE และในช ่ อง  Input raster ช ่ องท ี ่ สอง ให ้นำข ้ อม ู ลท ี ่ แปลงจาก  raster  
เป็น polygon แต่ละดัชนีมาใส่ > Class field เลือก gridcode > Save > OK 
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5. เมื่อเสร็จแล้ว ผลลัพธ์จะได้จะออกมาในรูปแบบข้อมูลในตาราง Attribute ดังภาพ 

 

 
6. เมื ่อนำ polygon มาวิเคราะห์ให้ได้ข้อมูลใน Attribute แล้ว จึงนำข้อมูล shapefile ตำบล อำเภอ 

จังหวัด มา join กับข้อมูลอีกครั้ง เพื่อเชื่อม T_Code ให้ข้อมูลสามารถเชื่อมโยงกันได้ โดยทำการ Join 
data > เลือก shapefile ตำบล จังหวัด อำเภอ > เลือกตัวเชื่อมระหว่างสองไฟล์ คือ T_Code > OK 
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7. เมื่อเสร็จแล้ว ไฟล์ข้อมูลจะเชื่อมกันและเป็นข้อมูลชุดเดียวกัน ดังภาพ  

 

 
8. จากนั้น นำข้อมูลจากตาราง Attribute ที่วิเคราะห์ข้อมูลทุกอย่างเรียบร้อยแล้ว มาใส่ใน Excel และนำ

ข้อมูลไปใช้สรุปต่อไป 
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3.5.5 ดัชนี VCI ดัชนีวัดการเจริญเติบโตของพืช 
 

 
1. นำชุด Data ดัชนีที่ Reclass แล้ว มาเข้าโปรแกรม Arcmap 10.3 

 

 

2. ใช้เครื่องมือ Tool > Conversion Tools > From Raster > Raster to Polygon เมื่อคลิกแล้วจะ
ได้หน้าต่างขึ้นมา ให้ใส่ข้อมูลดัชนีที่ต้องการแปลงจาก Raster เป็น polygon ในช่อง Input raster 
เลือก Field > New value (แทนเลขที่แสดงค่าแต่ละระดับในข้อมูลแต่ละดัชนี) > Save > OK 
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3. เมื่อแปลงเป็น Polygon แล้ว จะได้ผลลัพธ์ดังภาพ 

 

 
 

4. นำข้อมูล polygon ที ่ทำการแปลงไว้ มาวิเคราะห์ต ่อด้วย Tool > Tabulate Area โดยนำ 
shapefile ข้อมูลตำบล อำเภอ จังหวัด มาใส่ในช่อง Input raster ช่องแรก > Zone field เลือก
เป็น T_CODE และในช่อง Input raster ช่องที่สองให้นำข้อมูลที่แปลงจาก raster เป็น polygon 
แต่ละดัชนีมาใส่ > Class field เลือก gridcode > Save > OK 
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5. เมื่อเสร็จแล้ว ผลลัพธ์จะได้จะออกมาในรูปแบบข้อมูลในตาราง Attribute ดังภาพ 

 

 
6. เมื่อนำ polygon มาวิเคราะห์ให้ได้ข้อมูลใน Attribute แล้ว จึงนำข้อมูล shapefile ตำบล อำเภอ 

จังหวัด มา join กับข้อมูลอีกครั้ง เพื่อเชื่อม T_Code ให้ข้อมูลสามารถเชื่อมโยงกันได้ โดยทำการ 
Join data > เลือก shapefile ตำบล จังหวัด อำเภอ > เลือกตัวเชื่อมระหว่างสองไฟล์ คือ T_Code 
> OK 
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7. เมื่อเสร็จแล้ว ไฟล์ข้อมูลจะเชื่อมกันและเป็นข้อมูลชุดเดียวกัน ดังภาพ  

 

 
8.  จากนั้น นำข้อมูลจากตาราง Attribute ที่วิเคราะห์ข้อมูลทุกอย่างเรียบร้อยแล้ว มาใส่ใน Excel 

และนำข้อมูลไปใช้สรุปต่อไป 
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3.5.6 ดัชนี TCI ดัชนีวัดอุณหภูมิ 

 
1. นำชุด Data ดัชนีที่ Reclass แล้ว มาเข้าโปรแกรม Arcmap 10.3 

 

 

2. ใช้เครื่องมือ Tool > Conversion Tools > From Raster > Raster to Polygon เมื่อคลิกแล้วจะได้
หน้าต่างขึ้นมา ให้ใส่ข้อมูลดัชนีที่ต้องการแปลงจาก Raster เป็น polygon ในช่อง Input raster เลือก 
Field > New value (แทนเลขที่แสดงค่าแต่ละระดับในข้อมูลแต่ละดัชนี) > Save > OK 
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3. เมื่อแปลงเป็น Polygon แล้ว จะได้ผลลัพธ์ดังภาพ 
 

 
4. นำข้อมูล polygon ที่ทำการแปลงไว้ มาวิเคราะห์ต่อด้วย Tool > Tabulate Area โดยนำ shapefile 

ข้อมูลตำบล อำเภอ จังหวัด มาใส่ในช่อง Input raster ช่องแรก > Zone field เลือกเป็น T_CODE และ
ในช่อง Input raster ช่องที่สองให้นำข้อมูลที่แปลงจาก raster เป็น polygon แต่ละดัชนีมาใส่ > Class 
field เลือก gridcode > Save > OK 
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5. เมื่อเสร็จแล้ว ผลลัพธ์จะได้จะออกมาในรูปแบบข้อมูลในตาราง Attribute ดังภาพ 

 

 
6. เมื ่อนำ polygon มาวิเคราะห์ให้ได้ข้อมูลใน Attribute แล้ว จึงนำข้อมูล shapefile ตำบล อำเภอ 

จังหวัด มา join กับข้อมูลอีกครั้ง เพื่อเชื่อม T_Code ให้ข้อมูลสามารถเชื่อมโยงกันได้ โดยทำการ Join 
data > เลือก shapefile ตำบล จังหวัด อำเภอ > เลือกตัวเชื่อมระหว่างสองไฟล์ คือ T_Code > OK 
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7. เมื่อเสร็จแล้ว ไฟล์ข้อมูลจะเชื่อมกันและเป็นข้อมูลชุดเดียวกัน ดังภาพ  

 

 
8. จากนั้น นำข้อมูลจากตาราง Attribute ที่วิเคราะห์ข้อมูลทุกอย่างเรียบร้อยแล้ว มาใส่ใน Excel และนำ

ข้อมูลไปใช้สรุปต่อไป 
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3.5.7.ดัชนี LST ดัชนีวัดอุณหภูมิพ้ืนผิว 
 

 
1. นำชุด Data ดัชนีที่ Reclass แล้ว มาเข้าโปรแกรม Arcmap 10.3 

 

 

2. ใช้เครื่องมือ Tool > Conversion Tools > From Raster > Raster to Polygon เมื่อคลิกแล้วจะได้
หน้าต่างขึ้นมา ให้ใส่ข้อมูลดัชนีที่ต้องการแปลงจาก Raster เป็น polygon ในช่อง Input raster เลือก 
Field > New value (แทนเลขที่แสดงค่าแต่ละระดับในข้อมูลแต่ละดัชนี) > Save > OK 
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3. เมื่อแปลงเป็น Polygon แล้ว จะได้ผลลัพธ์ดังภาพ 

 
4. นำข้อมูล polygon ที่ทำการแปลงไว้ มาวิเคราะห์ต่อด้วย Tool > Tabulate Area โดยนำ shapefile 

ข ้ อ ม ู ล ต ำ บ ล  อ ำ เ ภ อ  จ ั ง ห ว ั ด  ม า ใ ส ่ ใ น ช ่ อ ง  Input raster ช ่ อ ง แ ร ก  > Zone field  
เ ล ื อก เป ็ น  T_CODE และในช ่ อง  Input raster ช ่ องท ี ่ สอง ให ้นำข ้ อม ู ลท ี ่ แปลงจาก  raster  
เป็น polygon แต่ละดัชนีมาใส่ > Class field เลือก gridcode > Save > OK 
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5. เมื่อเสร็จแล้ว ผลลัพธ์จะได้จะออกมาในรูปแบบข้อมูลในตาราง Attribute ดังภาพ 
 

 
6. เมื ่อนำ polygon มาวิเคราะห์ให้ได้ข้อมูลใน Attribute แล้ว จึงนำข้อมูล shapefile ตำบล อำเภอ 

จังหวัด มา join กับข้อมูลอีกครั้ง เพื่อเชื่อม T_Code ให้ข้อมูลสามารถเชื่อมโยงกันได้ โดยทำการ Join 
data > เลือก shapefile ตำบล จังหวัด อำเภอ > เลือกตัวเชื่อมระหว่างสองไฟล์ คือ T_Code > OK 
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7. เมื่อเสร็จแล้ว ไฟล์ข้อมูลจะเชื่อมกันและเป็นข้อมูลชุดเดียวกัน ดังภาพ  

 

 
8. จากนั้น นำข้อมูลจากตาราง Attribute ที่วิเคราะห์ข้อมูลทุกอย่างเรียบร้อยแล้ว มาใส่ใน Excel และนำ

ข้อมูลไปใช้สรุปต่อไป 
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3.5.8 ดัชนี SAVI ดัชนีพืชพรรณปรับแก้หน้าดิน 
 

 
1. นำชุด Data ดัชนีที่ Reclass แล้ว มาเข้าโปรแกรม Arcmap 10.3 

 

 

2. ใช้เครื่องมือ Tool > Conversion Tools > From Raster > Raster to Polygon เมื่อคลิกแล้วจะ
ได้หน้าต่างขึ้นมา ให้ใส่ข้อมูลดัชนีที่ต้องการแปลงจาก Raster เป็น polygon ในช่อง Input raster 
เ ล ื อก  Field > New value ( แทน เลขท ี ่ แสด งค ่ า แต ่ ล ะระด ั บ ในข ้ อม ู ล แต ่ ล ะด ั ชนี )  
> Save > OK 
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3. เมื่อแปลงเป็น Polygon แล้ว จะได้ผลลัพธ์ดังภาพ 

 

 
4. นำข้อมูล polygon ที ่ทำการแปลงไว้ มาวิเคราะห์ต ่อด้วย Tool > Tabulate Area โดยนำ 

shapefile ข้อมูลตำบล อำเภอ จังหวัด มาใส่ในช่อง Input raster ช่องแรก > Zone field เลือก
เป ็ น  T_CODE และ ในช ่ อ ง  Input raster ช ่ อ งท ี ่ ส อ ง ให ้ น ำข ้ อม ู ลท ี ่ แปล งจาก  raster  
เป็น polygon แต่ละดัชนีมาใส่ > Class field เลือก gridcode > Save > OK 
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5. เมื่อเสร็จแล้ว ผลลัพธ์จะได้จะออกมาในรูปแบบข้อมูลในตาราง Attribute ดังภาพ 

 

 
6. เมื่อนำ polygon มาวิเคราะห์ให้ได้ข้อมูลใน Attribute แล้ว จึงนำข้อมูล shapefile ตำบล อำเภอ 

จังหวัด มา join กับข้อมูลอีกครั้ง เพื่อเชื่อม T_Code ให้ข้อมูลสามารถเชื่อมโยงกันได้ โดยทำการ 
Join data > เลือก shapefile ตำบล จังหวัด อำเภอ > เลือกตัวเชื่อมระหว่างสองไฟล์ คือ T_Code 
> OK 
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7. เมื่อเสร็จแล้ว ไฟล์ข้อมูลจะเชื่อมกันและเป็นข้อมูลชุดเดียวกัน ดังภาพ  

 

 
8. จากน ั ้ น  นำข ้อม ูลจากตาราง  Attribute ท ี ่ ว ิ เคราะห ์ข ้ อม ูลท ุ กอย ่ าง เร ี ยบร ้ อยแล้ ว  

มาใส่ใน Excel และนำข้อมูลไปใช้สรุปต่อไป 
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บทท่ี 4  
ผลการศึกษาและวิจารณ์ 

4.1 .ผลการศึกษาโดยเทคนิคจำลองความสูงของปริมาณน้ำที่สูงข้ึนมาวิเคราะห์รวมกับแผนที่
ความสูงภูมิประเทศเชิงเลข (DEM) 

4.1.1 หาค่าท้องน้ำของเส้นแม่น้ำที่ศึกษาจากการประมาณค่าเชิงพื้นที่ด้วยวิธี  IDW (Inverse Distance 
Weight) โ ด ย ใ ช ้ โ ป ร แ ก ร ม ส า ร ส น เ ท ศ ภ ู ม ิ ศ า ส ต ร ์  ArcGIS ป ร ะ ม า ณ ค ่ า ข อ ง ข ้ อ ม ู ล ท ้ อ ง น้ ำ  
โดยการแปลงข้อมูลแบบจุดให้เป็นข้อมูลเชิงพื้นที่ มีข้อมูลต่อเนื่อง ซึ่งแสดงผลเป็นรูปแบบข้อมูลกริดหรือข้อมูล
ราสเตอร์  (Raster) ในระบบสารสนเทศภ ูม ิศาสตร ์  โดยใช ้ข ้อม ูลสารสนเทศภ ูม ิศาสตร ์ระบบพ ิกัด 
แบบกริด (Grid Coordinate System) หรือ ระบบ UTM (Universal Transverse Mercator) Datum WGS84 
Zone 48N 

1) สร้างขอบเขตที่ครอบคลุมพื้นที่ศึกษาในรูปแบบ Polygon  
2) นำเข้าข้อมูลระดับท้องน้ำที่คัดเลือกแล้ว ซึ่งเป็นข้อมูลระดับท้องน้ำของแต่ละจุดตรวจวัด 
3)ทำการรันค่าทุกจุดด้วยคำสั่ง Inverse Distance Weight (IDW) เพ่ือได้แผนที่ประมาณค่าของท้อง

น้ำของแม่น้ำที่ศึกษา 
4.1.2 วิเคราะห์ความเสี่ยงพื้นที่ที่เกิดอุทกภัยในพื้นที่ศึกษา จากแผนที่ประมาณค่าพื้นที่ท้องน้ำ (IDW) ที่

หาได้จากค่าจุดต่ำสุดของรูปตัดขวางตัดแม่น้ำ Cross-section River และข้อมูลความสูงของภูมิประเทศเชิงเลข 
พ ิจารณาระด ับน ้ ำท ี ่ เพ ิ ่ มข ึ ้นจากใต ้ท ้ องน ้ ำ โดยให ้ ระด ับความส ู งของน ้ ำเพ ิ ่ มข ึ ้ นท ีละ 0.5 เมตร  
รวม 5 ระดับ โดยเริ่มจากระดับความลึกของหน้าตัดลำน้ำที่ต่ำที่สุดในแต่ละช่วงศึกษา อาศัยการวิเคราะห์ด้วย
โปรแกรม ArcGIS 10.8 โดยใช้เครื่องมือ Raster Calculator และสมการดังต่อไปนี้ 
Flood = “ข้อมูลDEM” – (“ข้อมูล IDW ท้องน้ำ” + “ความสูงของระดับน้ำที่เพิ่มขึ้น”) 

4.1.3 การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัย 
หลังจากประมวลผลข้อมูลเรียบร้อยแล้วจะได้ผลลัพธ์เป็นข้อมูลRaster ดังนั้นจึงทำการReclassify โดย

พิจารณาระดับความเสี่ยงอุทกภัยตามการแจกแจงความถี่ แบ่งเป็น 7 ระดับ โดยคำนวณเฉพาะช่วงข้อมูลที่น้อย
กว่า 0 ส่วนบริเวณข้อมูลที่มากกว่าศูนย์จะถูกจัดเป็นชั้นข้อมูลพื้นที่ไม่เสี่ยงอุทกภัยทั้งหมด ดังนั้น ต้องการแบ่งอีก 
6 ชั้นที่เหลือเป็นแบบอันตรภาคชั้น(Interval Scale) ใช้สูตรการคํานวณความกว้างของอันตรภาคชั้น ดังนี้ 
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ความกว้างของอันตรภาคชั้น = 
ข้อมูลที่มีค่าสูงสุด – ข้อมูลที่มีค่าต่ำสุด

จํานวนช้ัน
 

เนื่องจากค่าต่ำสุดมีลักษณะเป็นค่าโดด จึงรวมชั้น 7 และ 6 ไว้ด้วยกัน เหลือ 6 ระดับ ดังนี้ 
- ระดับคะแนน 5 หมายถึง พ้ืนที่เสี่ยงอุทกภัยระดับ 5 
- ระดับคะแนน 4 หมายถึง พ้ืนที่เสี่ยงอุทกภัยระดับ 4 
- ระดับคะแนน 3 หมายถึง พ้ืนที่เสี่ยงอุทกภัยระดับ 3 
- ระดับคะแนน 2 หมายถึง พ้ืนที่เสี่ยงอุทกภัยระดับ 2 
- ระดับคะแนน 1 หมายถึง พ้ืนที่เสี่ยงอุทกภัยระดับ 1 
- ระดับคะแนน 0 หมายถึง พ้ืนที่ไม่เสี่ยงอุทกภัย 

1) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 1 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน = 5.5, 6, 6.5, 7, และ7.5 เมตร 
 

                                                         = 
76.17 – 0

6
                                     

      = 12.70 
หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ

พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 
- มีค่าคะแนนอยู่ในช่วง (-76.17) ถึง  (-50.78) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-50.78) ถึง  (-38.09) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-38.09) ถึง  (-25.39) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-25.39) ถึง  (-12.70) หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-12.70) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (762)  หมายถึง  ไม่มีความเสี่ยง 

2) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 2 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน = 5, 5.5, 6, 6.5, และ7 เมตร 
 

                                                         = 
19.55 – 0

6
                                     

      = 3.26 
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หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ
พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 

- มีค่าคะแนนอยู่ในช่วง (-19.55)  ถึง  (-13.03) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-13.03)  ถึง  (-9.77) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-9.77)  ถึง  (-6.52) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-6.52)  ถึง  (-3.26) หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-3.26)  ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (536) หมายถึง  ไม่มีความเสี่ยง 

3) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 3 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน = 6, 6.5, 7, 7.5, และ 8 เมตร 

                                                         = 
71.57 – 0

6
                                     

      = 11.93 
หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ

พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 
- มีค่าคะแนนอยู่ในช่วง (-71.57) ถึง  (-47.71) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-47.71) ถึง  (-35.79) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-35.79) ถึง  (-23.86) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-23.86) ถึง  (-11.93) หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-11.93) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (111)  หมายถึง  ไม่มีความเสี่ยง 

4) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 4 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน = 5.5, 6, 6.5, 7, และ7.5 เมตร 

                                                         = 
50.18 – 0

6
                                     

      = 8.36 
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หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ
พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 

- มีค่าคะแนนอยู่ในช่วง (-50.18) ถึง  (-33.46) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-33.46) ถึง  (-25.09) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-25.09) ถึง  (-16.73) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-16.73) ถึง  (-8.36) หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-8.36) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (82)  หมายถึง  ไม่มีความเสี่ยง 

5) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 5 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน = 3.5, 4, 4.5, 5, และ5.5 เมตร 

                                                         = 
16.82 – 0

6
                                     

      = 2.80 
หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ

พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 
- มีค่าคะแนนอยู่ในช่วง (-16.82) ถึง  (-11.21) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-11.21) ถึง  (-8.41) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-8.41) ถึง  (-5.61)  หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-5.61) ถึง  (-2.80)  หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-2.80) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (111)  หมายถึง  ไม่มีความเสี่ยง 

6) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 6 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน = 4.5, 5, 5.5, 6, และ6.5 เมตร 
 

                                                         = 
25.89 – 0

6
                                     

      = 4.32 
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หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ
พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 

- มีค่าคะแนนอยู่ในช่วง (-25.89) ถึง  (-17.26) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-17.26) ถึง  (-12.95) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-12.95) ถึง  (-8.63) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-8.63) ถึง  (-4.32)  หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-4.32) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (122)  หมายถึง  ไม่มีความเสี่ยง 

7) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 7 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน = 5, 5.5, 6, 6.5, และ7 เมตร 

                                                         = 
44.29 – 0

6
                                     

      = 7.38 
หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ

พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 
- มีค่าคะแนนอยู่ในช่วง (-44.29) ถึง  (-29.53) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-29.53) ถึง  (-22.15) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-22.15) ถึง  (-14.76) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-14.76) ถึง  (-7.38) หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-7.38) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (120)  หมายถึง  ไม่มีความเสี่ยง 
8) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 8 โดยที่ ความสูงของระดับน้ำที่

เพ่ิมข้ึน = 6, 6.5, 7, 7.5, และ 8 เมตร 
 

                                                         = 
35.24 – 0

6
                                     

      = 5.87 
  



161 
 

หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ
พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 

- มีค่าคะแนนอยู่ในช่วง (-35.24) ถึง  (-23.49) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-23.49) ถึง  (-17.62) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-17.62) ถึง  (-11.75) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-11.75) ถึง  (-5.87) หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-5.87) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (84)  หมายถึง  ไม่มีความเสี่ยง 

9) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 9 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน = 6, 6.5, 7, 7.5, และ 8 เมตร 
 

                                                         = 
32.31 – 0

6
                                     

      = 5.38 
หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ

พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 
- มีค่าคะแนนอยู่ในช่วง (-32.31) ถึง  (-21.54) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-21.54) ถึง  (-16.15) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-16.15) ถึง  (-10.77) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-10.77) ถึง  (-5.38) หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-5.38) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (106)  หมายถึง  ไม่มีความเสี่ยง 

10) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 10 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน = 6, 6.5, 7, 7.5, และ 8 เมตร 
 

                                                         = 
41.75 – 0

6
                                     

      = 6.96 
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หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ
พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 

- มีค่าคะแนนอยู่ในช่วง (-41.75) ถึง  (-27.83) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-27.83) ถึง  (-20.87) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-20.87) ถึง  (-13.92) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-13.92) ถึง  (-6.96) หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-6.96) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (57)  หมายถึง  ไม่มีความเสี่ยง 

11) การจัดลำดับพื้นที่เสียงต่อการเกิดอุทกภัยแม่น้ำชีมูล ช่วงที่ 11 โดยที่ ความสูงของระดับน้ำที่
เพ่ิมข้ึน  =  6.5, 7, 7.5, 8, และ 8.5 เมตร 
 

                                                         = 
39.69 – 0

6
                                     

      = 6.62 
หลังจากการคํานวณช่วงระดับคะแนนดังกล่าวแล้วนําค่าที่ได้จากการคํานวณมาแบ่งเป็นระดับ

พ้ืนที่เสี่ยงอุทกภัยน้ำท่วม ดังนี้ 
- มีค่าคะแนนอยู่ในช่วง (-39.69) ถึง  (-26.46) หมายถึง  ความเสี่ยงระดับ 5 
- มีค่าคะแนนอยู่ในช่วง (-26.46) ถึง  (-19.85) หมายถึง  ความเสี่ยงระดับ 4 
- มีค่าคะแนนอยู่ในช่วง (-19.85) ถึง  (-13.23) หมายถึง  ความเสี่ยงระดับ 3 
- มีค่าคะแนนอยู่ในช่วง (-13.23) ถึง  (-6.62) หมายถึง  ความเสี่ยงระดับ 2 
- มีค่าคะแนนอยู่ในช่วง (-6.62) ถึง  (0)  หมายถึง  ความเสี่ยงระดับ 1 
- มีค่าคะแนนอยู่ในช่วง (0) ถึง  (51)  หมายถึง  ไม่มีความเสี่ยง 
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4.2 ผลกรณีศึกษาวิเคราะห์ความสัมพันธ์ของปริมาณน้ำกับความต้องการใช้น้ำ 
จากการศึกษาความต้องการใช้น้ำโดยเปรียบเทียบปริมาณน้ำท่าเฉลี่ยจากสถานีวัดน้ำท่าในช่วงฤดูแล้งโดย

ใช้การฟความสัมพันธ์ระหว่างน้ำท่า-พ้ืนที่รับน้ำ ดังรูปที่ ....  

 
รูปที่ 29 การฟความสัมพันธ์ระหว่างน้ำท่า-พื้นที่รับน้ำ 

 
กับความต้องการใช้น้ำด้านต่างๆ โดยกำหนดเกณฑ์ท่ียอมให้ขาดได้ไม่เกิน ร้อยละ 20 สรุปได้ดังต่อไปนี้ 

 
  

y = 0.1211x + 2.0555
R² = 0.9682
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0 50 100 150 200 250 300 350 400

พืน้
ที่ร
บัน

 ำ้

น  ำ้ท่ำ

กำรฟควำมสมัพนัธร์ะหวำ่งน ำ้ทำ่-พืน้ท่ีรบัน ำ้

(ลา้น ลบ.ม./ปี) ปี (ลา้น ลบ.ม./ปี) ปี (ลา้น ลบ.ม./ปี) ปี (ลา้น ลบ.ม./ปี) ปี

1 E.21 6.55 62 -55.45 3 37.2 -30.65 3 24.8 -18.25 2 12.4 -5.85 1

2 E.9 9.11 6.5 2.61 0 3.9 5.21 0 2.6 6.51 0 1.3 7.81 0

3 E.91 33.34 9 24.34 0 5.4 27.94 0 3.6 29.74 0 1.8 31.54 0

4 E.66A 36.25 55.5 -19.25 1 33.3 2.95 0 22.2 14.05 0 11.1 25.15 0

5 E.18 35.90 102.5 -66.60 1 61.5 -25.60 1 41 -5.10 1 20.5 15.40 0

6 E.20A 45.30 90.5 -45.20 3 54.3 -9.00 0 36.2 9.10 0 18.1 27.20 0

CI=1.1
การขาดแคลนน ้าพืน้ที่ สถานีน ้าทา่

ปรมิาณน ้าทา่

เฉลีย่ชว่งฤดแูลง้

(ลา้น ลบ.ม./ปี)

ความตอ้งการใชน้ ้า (ลา้น ลบ.ม./ปี)

CI=1.5
การขาดแคลนน ้า

CI=1.3
การขาดแคลนน ้า

CI=1.2
การขาดแคลนน ้า
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4.2.1 พ้ืนที่ศึกษาลุ่มน้ำชี BLOCK 1 
จากผลการศึกษาพื้นที่ศึกษาลุ่มน้ำชี BLOCK 1 มีพื้นที่ชลประทาน 99,770.60 ไร่ ปริมาณน้ำท่า 6.55 

ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 50% (CI=1.5) มีความต้องการใช้น้ำ 62 ล้าน ลบ.ม./ปี มีการขาดแคลนน้ำ 
55.45 ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 30% (CI=1.3) มีความต้องการใช้น้ำ 37.2 ล้าน ลบ.ม./ปี มีการขาด
แคลนน้ำ 30.65 ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 20% (CI=1.2) มีความต้องการใช้น้ำ 24.8 ล้าน ลบ.ม./ปี มี
การขาดแคลนน้ำ 18.25 ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 10% (CI=1.1) มีความต้องการใช้น้ำ 12.4 ล้าน ลบ.
ม./ปี มีการขาดแคลนน้ำ 5.85 ล้าน ลบ.ม./ปี 

4.2.2 พ้ืนที่ศึกษาลุ่มน้ำชี BLOCK 2 
จากผลการศึกษาพื้นที่ศึกษาลุ่มน้ำชี BLOCK 2 มีพื้นที่ชลประทาน 81,329.75 ไร่ ปริมาณน้ำท่า 9.11 

ล้าน ลบ.ม./ปี คิดพ้ืนที่ชลประทาน 50% (CI=1.5) มีความต้องการใช้น้ำ 6.5 ล้าน ลบ.ม./ปี ไม่มีการขาดแคลนน้ำ 
คิดพื้นที่ชลประทาน 30% (CI=1.3) มีความต้องการใช้น้ำ 3.9 ล้าน ลบ.ม./ปี ไม่มีการขาดแคลนน้ำ คิดพื้นที่
ชลประทาน 20% (CI=1.2) มีความต้องการใช้น้ำ 2.6 ล้าน ลบ.ม./ปี มีไม่มีการขาดแคลนน้ำ พื้นที่ชลประทาน 
10% (CI=1.1) มีความต้องการใช้น้ำ 1.3 ล้าน ลบ.ม./ปี ไม่มีการขาดแคลนน้ำ  

4.2.3 พ้ืนที่ศึกษาลุ่มน้ำชี BLOCK 3 
จากผลการศึกษาพ้ืนที่ศึกษาลุ่มน้ำชี BLOCK 3 มีพ้ืนที่ชลประทาน 259.49 ไร่ ปริมาณน้ำท่า 33.34 ล้าน 

ลบ.ม./ปี คิดพื้นที่ชลประทาน 50% (CI=1.5) มีความต้องการใช้น้ำ 9 ล้าน ลบ.ม./ปี ไม่มีการขาดแคลนน้ำ คิด
พื ้นที ่ชลประทาน 30% (CI=1.3) มีความต้องการใช้น้ำ 5.4 ล้าน ลบ.ม./ปี ไม่มีการขาดแคลนน้ำ คิดพื ้นที่
ชลประทาน 20% (CI=1.2) มีความต้องการใช้น้ำ 3.6 ล้าน ลบ.ม./ปี มีไม่มีการขาดแคลนน้ำ พื้นที่ชลประทาน 
10% (CI=1.1) มีความต้องการใช้น้ำ 1.8 ล้าน ลบ.ม./ปี ไม่มีการขาดแคลนน้ำ 

4.2.4 พ้ืนที่ศึกษาลุ่มน้ำชี BLOCK 4 
จากผลการศึกษาพื้นที่ศึกษาลุ่มน้ำชี BLOCK 4 มีพื้นที่ชลประทาน 54,397.63 ไร่ ปริมาณน้ำท่า 36.25 

ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 50% (CI=1.5) มีความต้องการใช้น้ำ 55.5 ล้าน ลบ.ม./ปี มีการขาดแคลนน้ำ 
19.25 ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 30% (CI=1.3) มีความต้องการใช้น้ำ 33.3 ล้าน ลบ.ม./ปี ไม่มีการขาด
แคลนน้ำ คิดพ้ืนที่ชลประทาน 20% (CI=1.2) มีความต้องการใช้น้ำ 22.2 ล้าน ลบ.ม./ปี ไม่มีการขาดแคลนน้ำ คิด
พ้ืนที่ชลประทาน 10% (CI=1.1) มีความต้องการใช้น้ำ 11.1 ล้าน ลบ.ม./ปี ไม่มีการขาดแคลนน้ำ 

4.2.5 พ้ืนที่ศึกษาลุ่มน้ำชี BLOCK 5 
จากผลการศึกษาพ้ืนที่ศึกษาลุ่มน้ำชี BLOCK 5 มีพ้ืนที่ชลประทาน 8,749.24 ไร่ ปริมาณน้ำท่า 35.9 ล้าน 

ลบ.ม./ปี คิดพ้ืนที่ชลประทาน 50% (CI=1.5) มีความต้องการใช้น้ำ 102.5 ล้าน ลบ.ม./ปี มีการขาดแคลนน้ำ 66.6 
ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 30% (CI=1.3) มีความต้องการใช้น้ำ 61.5 ล้าน ลบ.ม./ปี มีการขาดแคลนน้ำ 
25.6 ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 20% (CI=1.2) มีความต้องการใช้น้ำ 41 ล้าน ลบ.ม./ปี มีการขาดแคลน
น้ำ 5.1 ล้าน ลบ.ม./ปี คิดพ้ืนที่ชลประทาน 10% (CI=1.1) มีความต้องการใช้น้ำ 20.5 ล้าน ลบ.ม./ปี ไม่มีการขาด
แคลนน้ำ 

4.2.6 พ้ืนที่ศึกษาลุ่มน้ำชี BLOCK 6 
จากผลการศึกษาพื้นที่ศึกษาลุ่มน้ำชี BLOCK 6 มีพื้นที่ชลประทาน 20,484.97 ไร่ ปริมาณน้ำท่า 45.3 

ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 50% (CI=1.5) มีความต้องการใช้น้ำ 90.5 ล้าน ลบ.ม./ปี มีการขาดแคลนน้ำ 
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45.2 ล้าน ลบ.ม./ปี คิดพื้นที่ชลประทาน 30% (CI=1.3) มีความต้องการใช้น้ำ 54.3 ล้าน ลบ.ม./ปี มีการขาด
แคลนน้ำ 9 ล้าน ลบ.ม./ปี คิดพ้ืนที่ชลประทาน 20% (CI=1.2) มีความต้องการใช้น้ำ 36.2 ล้าน ลบ.ม./ปี ไม่มีการ
ขาดแคลนน้ำ คิดพ้ืนที่ชลประทาน 10% (CI=1.1) มีความต้องการใช้น้ำ 18.1 ล้าน ลบ.ม./ปี ไม่มีการขาดแคลนน้ำ 
 4.2.7  การบริหารจัดการน้ำลุ่มน้ำชี และแนวทางการปรับเปลี่ยน/ปรับลดการเพาะปลูกพืชตามความ
เหมาะสม 

จากผลการศึกษาในพื้นที่ศึกษาลุ่มน้ำชี ทั้ง 6 BLOCK พบว่าเมื่อลดพื้นที่ชลประทาน 50% พื้นที่ที่ไม่พบ
ปัญหาขาดแคลนน้ำอยู่ใน BLOCK ที่ 2 และ 3 เมื่อลดพื้นที่ชลประทาน 30% พ้ืนที่ที่ไม่พบปัญหาขาดแคลนน้ำอยู่
ใน BLOCK ที่ 4 เมื่อลดพื้นที่ชลประทาน 20% พื้นที่ที่ไม่พบปัญหาขาดแคลนน้ำอยู่ใน BLOCK ที่ 6 เมื่อลดพื้นที่
ชลประทาน 10% พื้นที่ที่ไม่พบปัญหาขาดแคลนน้ำอยู่ใน BLOCK ที่ 5 และพบว่าใน BLOCK ที่ 1 เมื่อลดพื้นที่
ชลประทานลงเหลือ 10% ยังพบว่ามีการขาดแคลนน้ำอยู่ 
 
4.3 การวิเคราะห์หาพื้นที่เสี่ยงภัยแล้งจาก ทฤษฎี APH 
 ผลจากการหาพื้นที่เสี่ยงภัยแล้งในลุ่มน้ำชีมีพื้นที่ทั้งหมด  30,796,165  ไร่ พบว่าส่วนใหญ่เป็นพื้นที่เสี่ยง
ภัยแล้งปานกลาง จำนวน  10,540,984  ไร่ พ้ืนที่เสี่ยงภัยแล้งน้อย จำนวน  9,221,709  ไร่ และพ้ืนที่เสี่ยงภัยแล้ง
ค่อนข้างมาก จำนวน  6,840,382  ไร่ ตามลำดับ ดังนี้ 
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รูปที ่30 แผนทีแ่สดงพืน้ที่เส่ียงภัยแล้ง บริเวณลุ่มน ้ำชี 

 
ตารางท่ี 21 พ้ืนที่เสี่ยงภัยแล้งในลุ่มน้ำชี 6 ระดับ 

ระดับ พ้ืนที่ / ไร่ 
ระดับ 5 เสี่ยงภัยแล้งมากที่สุด  18,032  
ระดับ 4 เสี่ยงภัยแล้งมาก  2,007,836  
ระดับ 3 เสี่ยงภัยแล้งค่อนข้างมาก  6,840,382  
ระดับ 2 เสี่ยงภัยแล้งปานกลาง  10,540,984  
ระดับ 1 เสี่ยงภัยแล้งน้อย  9,221,709  
ระดับ 0 ไม่เสี่ยงภัยแล้ง  2,167,221  
รวม  30,796,165  
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  พ้ืนที่เสี่ยงภัยแล้งมากท่ีสุด (ระดับ 5) พบมากบริเวณ คือ จังหวัดชัยภูมิ จำนวน 15,377 ไร่  

จังหวัดกาฬสินธุ์ จำนวน 1,403 ไร่ และจังหวัดหนองบัวลำภู จำนวน 479 ไร่ ตามลำดับ 
  พื้นที่เสี่ยงภัยแล้งมาก (ระดับ 4) พบมากบริเวณจังหวัดชัยภูมิ จำนวน  597,562  ไร่, จังหวัด
ขอนแก่น จำนวน  572,407  ไร่ และจังหวัดหนองบัวลำภู จำนวน  286,169  ไร่ ตามลำดับ 
  พ้ืนที่เสี่ยงภัยแล้งค่อนข้างมาก (ระดับ 3) พบมากบริเวณจังหวัดขอนแก่น จำนวน 1,691,558 ไร่, 
จังหวัดชัยภูมิ จำนวน 1,411,950  ไร่ และจังหวัดร้อยเอ็ด จำนวน  797,560  ไร่ ตามลำดับ 

พื้นที่เสี่ยงภัยแล้งปานกลาง (ระดับ 2) พบมากบริเวณจังหวัดชัยภูมิ จำนวน   2,436,800 ไร่, 
จังหวัดขอนแก่น จำนวน  2,141,164  ไร่ และจังหวัดกาฬสินธุ์ จำนวน   1,642,191  ไร่ ตามลำดับ 
  พื้นที่เสี่ยงภัยแล้งน้อย (ระดับ 1) พบมากบริเวณจังหวัดชัยภูมิ จำนวน   3,230,784 ไร่, จังหวัด
ขอนแก่น จำนวน  1,392,242  ไร่ และจังหวัดกาฬสินธุ์ จำนวน  1,218,369  ไร่ ตามลำดับ 
  พื้นที่ไม่เสี่ยงภัยแล้ง (ระดับ 0) พบมากบริเวณจังหวัดกาฬสินธุ์ จำนวน   759,532  ไร่, จังหวัด
ร้อยเอ็ด จำนวน  277,522  ไร่ และจังหวัดยโสธร จำนวน  205,940  ไร่ ตามลำดับ 
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ตำรำงที ่22 พืน้ที่เสี่ยงภยัแลง้ในลุม่น ำ้ชี 6 ระดบั แยกรำยจงัหวดั 

 
ระดับ กาฬสินธุ ์ ขอนแก่น ชัยภูมิ นครราชสีมา เพชรบูรณ ์ มหาสารคาม มุกดาหาร ยโสธร 

 ระดับ 5 เสี่ยงภัยแล้งมากที่สุด   1,403   303   15,377   3   -     372   -     8  

 ระดับ 4 เสี่ยงภัยแล้งมาก   85,300   572,407   597,562   37,220   -     150,575   -     37,234  

 ร ะ ด ั บ  3 เ ส ี ่ ย ง ภ ั ย แ ล้ ง
ค่อนข้างมาก  

 615,817   
1,691,558  

 
1,411,950  

 157,924   753   631,702   34   189,507  

 ระดับ 2 เสี่ยงภัยแล้งปานกลาง   
1,642,191  

 
2,141,164  

 
2,436,800  

 290,962   87,666   641,271   3,354   315,199  

 ระดับ 1 เสี่ยงภัยแล้งน้อย   
1,218,369  

 
1,392,242  

 
3,230,784  

 59,511   458,443   311,328   7,514   327,254  

 ระดับ 0 ไม่เสี่ยงภัยแล้ง   759,532   175,621   97,739   8,072   -     120,548   20,308   205,940  

รวม  
4,322,613  

 
5,973,294  

 
7,790,213  

 553,692   546,862   1,855,795   31,210   
1,075,142  

  
ตำรำงที ่25 พืน้ที่เสี่ยงภยัแลง้ในลุม่น ำ้ชี 6 ระดบั แยกรำยจงัหวดั (ต่อ) 

ระดับ ร้อยเอ็ด  ลพบุรี  เลย   ศรีสะเกษ   สกลนคร   หนองบัวล ำภู   อุดรธำนี   อุบลรำชธำนี  

 ระดับ 5 เสีย่งภัยแล้งมำกท่ีสุด   79   -     7   -     -     479   -     -    

 ระดับ 4 เสีย่งภัยแล้งมำก   143,143   -     75,593   -     -     286,169   22,627   7  

 ระดับ 3 เสีย่งภัยแล้งค่อนข้ำงมำก   797,560   -     159,981   18,719   -     571,190   574,316   19,371  

 ระดับ 2 เสีย่งภัยแล้งปำนกลำง   1,069,366   15   293,050   66,220   221   588,227   837,571   127,709  

 ระดับ 1 เสีย่งภัยแล้งน้อย   676,811   1,189   463,318   58,113   997   348,612   531,773   135,452  

 ระดับ 0 ไมเ่สี่ยงภัยแล้ง   277,522   -     61,593   54,686   4,467   85,863   160,120   135,210  

รวม  2,964,481   1,204   1,053,543   197,739   5,685   1,880,538   2,126,406   417,749  
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ตำรำงที ่23 พืน้ที่เสี่ยงภยัแลง้ในลุม่น ำ้ชี 6 ระดบั แยกรำยอ ำเภอ 

จงัหวดั อ ำเภอ ระดบั 0 ระดบั 1 ระดบั 2 ระดบั 3 ระดบั 4 ระดบั 5 รวม (ไร)่ 
กำฬสินธุ ์ เ มื อ ง

กำฬสินธุ ์
 85,715   153,966   161,980   38,022   3,187   1   442,871  

กำฬสินธุ ์ นำมน  784   16,079   46,477   53,159   37,613   
1,056  

 155,168  

กำฬสินธุ ์ กมลำไสย  23,895   108,760   67,538   13,012   49   -     213,254  

กำฬสินธุ ์ รอ่งค ำ  1,688   16,372   15,475   16,498   60   -     50,093  

กำฬสินธุ ์ กฉิุนำรำยณ ์  
154,074  

 130,732   160,786   32,831   6,004   -     484,426  

กำฬสินธุ ์ เขำวง  35,112   32,358   69,943   693   -     -     138,106  

กำฬสินธุ ์ ยำงตลำด  76,990   105,560   113,685   128,914   3,305   -     428,454  

กำฬสินธุ ์ หว้ยเม็ก  1,604   27,669   97,436   72,449   4,534   -     203,692  

กำฬสินธุ ์ สหสัขนัธ ์  36,591   64,279   88,139   16,838   806   -     206,653  

กำฬสินธุ ์ ค ำม่วง  61,949   88,934   102,959   20,342   144   -     274,327  

กำฬสินธุ ์ ท่ำคนัโท  2,410   77,815   118,381   38,585   4,169   -     241,360  

กำฬสินธุ ์ หนองกงุศรี  17,800   110,279   206,063   44,521   4,508   -     383,172  

กำฬสินธุ ์ สมเด็จ  
103,373  

 61,591   81,163   53,166   9,399   28   308,720  

กำฬสินธุ ์ หว้ยผึง้  62,346   49,083   67,049   18,906   2,404   -     199,788  

กำฬสินธุ ์ สำมชยั  28,388   72,915   87,493   20,126   319   -     209,240  

กำฬสินธุ ์ นำค ู  49,493   26,345   58,616   493   -     -     134,948  

กำฬสินธุ ์ ดอนจำน  1,995   43,157   65,958   37,111   8,551   319   157,091  

กำฬสินธุ ์ ฆอ้งชยั  15,326   32,477   33,051   10,150   249   -     91,251  

รวม   
759,532  

 
1,218,36
9  

 
1,642,19
1  

 615,817   85,300   
1,403  

 
4,322,61
3  

ขอนแก่น เ มื อ ง
ขอนแก่น 

 32,503   141,690   230,909   175,821   36,420   20   617,362  

ขอนแก่น บำ้นฝำง  5,450   44,486   53,643   90,264   20,247   5   214,094  

ขอนแก่น พระยืน  1,626   17,175   37,742   71,255   11,959   -     139,757  

ขอนแก่น หนองเรือ  9,791   48,444   86,863   109,395   76,115   19   330,627  

ขอนแก่น ชมุแพ  7,527   135,821   133,087   96,708   46,130   74   419,347  

ขอนแก่น สีชมพ ู  1,477   72,008   109,702   81,344   64,616   25   329,172  

ขอนแก่น น ำ้พอง  23,795   115,361   222,184   91,146   12,803   -     465,288  

ขอนแก่น อบุลรตัน ์  9,187   69,570   108,447   52,108   15,975   3   255,291  

ขอนแก่น กระนวน  6,310   71,003   131,373   81,934   9,840   -     300,459  

ขอนแก่น บำ้นไผ่  7,658   35,079   122,882   101,137   22,819   -     289,575  

ขอนแก่น เปือยนอ้ย  -     166   448   130   3   -     748  
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ตำรำงที ่23 พืน้ที่เสี่ยงภยัแลง้ในลุม่น ำ้ชี 6 ระดบั แยกรำยอ ำเภอ 

จงัหวดั อ ำเภอ ระดบั 0 ระดบั 1 ระดบั 2 ระดบั 3 ระดบั 4 ระดบั 5 รวม (ไร)่ 
ขอนแก่น พล  224   3,246   9,387   22,946   1,043   -     36,846  

ขอนแก่น แวงใหญ่  1,398   14,503   50,182   58,490   18,057   30   142,661  

ขอนแก่น แวงนอ้ย  1,367   12,455   48,491   83,596   35,786   64   181,759  

ขอนแก่น หนอง ส อ ง
หอ้ง 

 -     20   62   -     -     -     82  

ขอนแก่น ภเูวียง  34,134   54,208   141,343   99,831   46,150   11   375,676  

ขอนแก่น มญัจำคีรี  9,138   102,185   164,423   118,243   29,123   1   423,114  

ขอนแก่น ชนบท  4,057   28,235   62,668   80,240   24,343   -     199,542  

ขอนแก่น เ ข ำ ส ว น
กวำง 

 1,101   61,131   113,947   39,252   7,845   3   223,279  

ขอนแก่น ภผูำม่ำน  1,208   123,954   44,312   11,188   10,214   11   190,886  

ขอนแก่น ซ ำสงู  1,563   29,323   59,637   26,524   4,779   -     121,825  

ขอนแก่น โคกโพธิ์ไชย  4,157   28,285   53,738   38,337   38,152   25   162,694  

ขอนแก่น หนองนำค ำ  5,970   27,352   31,381   29,847   15,008   8   109,566  

ขอนแก่น บำ้นแฮด  3,370   11,067   53,781   58,028   10,613   4   136,863  

ขอนแก่น โนนศิลำ  1,621   8,485   38,567   54,917   7,167   -     110,757  

ขอนแก่น เวียงเก่ำ  989   136,989   31,968   18,880   7,198   -     196,024  

รวม  175,621 1,392,24
2 

2,141,16
4 

1,691,55
8 

572,40
7 

303 5,973,29
4 
 

ชยัภมิู เมืองชยัภมิู  11,511   295,966   255,922   239,932   84,535   113   887,978  

ชยัภมิู บำ้นเขวำ้  6,809   107,701   119,756   61,502   16,226   6   312,000  

ชัยภูมิ คอนสวรรค์  8,492   47,112   81,933   113,087   39,185   21   289,830  
ชัยภูมิ เ ก ษ ต ร

สมบูรณ์ 
 9,884   278,166   178,322   112,680   69,842   14,862   663,756  

ชัยภูมิ หนองบัวแดง  3,669   902,663   234,905   145,480   48,697   111   1,335,524  
ชัยภูมิ จัตุรัส  14,194   64,223   210,371   102,815   27,523   6   419,134  
ชัยภูมิ บ ำ เ ห น็ จ

ณรงค ์
 1,989   42,919   150,245   76,064   16,777   28   288,021  

ชัยภูมิ หนองบ ั วระ
เหว 

 2,101   200,261   224,417   27,384   12,384   5   466,551  

ชัยภูมิ เทพสถิต  247   206,934   285,997   32,630   13,695   3   539,505  
ชัยภูมิ ภูเขียว  8,398   98,235   161,455   168,310   80,075   88   516,560  
ชัยภูมิ บ้านแท่น  6,221   26,216   50,563   71,077   41,295   26   195,397  
ชัยภูมิ แก้งคร้อ  4,628   81,157   112,259   111,609   96,972   52   406,676  
ชัยภูมิ คอนสาร  15,695   623,643   110,137   58,838   11,766   1   820,079  
ชัยภูมิ ภักดีชุมพล  -     195,256   76,011   24,355   12,205   18   307,843  
ชัยภูมิ เนินสง่า  3,772   14,486   72,192   52,165   23,474   -     166,088  
ชัยภูมิ ซับใหญ่  132   45,846   112,316   14,025   2,912   39   175,269  
รวม   97,739   3,230,784   2,436,800   1,411,950   597,562   15,377   7,790,213  
นครราชสีมา คง  532   6,618   52,717   33,647   9,003   -     102,518  
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ตำรำงที ่23 พืน้ที่เสี่ยงภยัแลง้ในลุม่น ำ้ชี 6 ระดบั แยกรำยอ ำเภอ 

จงัหวดั อ ำเภอ ระดบั 0 ระดบั 1 ระดบั 2 ระดบั 3 ระดบั 4 ระดบั 5 รวม (ไร)่ 
นครราชสีมา บ้านเหลื่อม  2,082   13,188   71,807   35,942   13,840   -     136,859  
นครราชสีมา ด่านขุนทด  11   6,962   20,911   3,571   1,454   3   32,913  
นครราชสีมา ขามสะแกแสง  15   552   3,736   2,694   758   -     7,755  
นครราชสีมา บัวใหญ่  133   2,236   12,471   15,000   1,627   -     31,467  
นครราชสีมา แก้งสนามนาง  5,223   21,883   97,988   63,071   8,930   -     197,095  
นครราชสีมา เทพารักษ์  -     7,491   29,078   2,684   1,599   -     40,851  
นครราชสีมา พระทองคำ  21   304   1,223   71   7   -     1,626  
นครราชสีมา บัวลาย  55   276   1,030   1,245   3   -     2,608  
รวม   8,072   59,511   290,962   157,924   37,220   3   553,692  
เพชรบูรณ์ เ ม ื อ ง

เพชรบูรณ์ 
 -     115,242   702   -     -     -     115,944  

เพชรบูรณ์ หล่มสัก  -     41,016   144   -     -     -     41,160  
เพชรบูรณ์ วิเชียรบุรี  -     730   139   1   -     -     869  
เพชรบูรณ์ หนองไผ่  -     9,819   274   -     -     -     10,093  
เพชรบูรณ์ บึงสามพัน  -     284   29   -     -     -     312  
เพชรบูรณ์ น้ำหนาว  -     291,353   86,379   753   -     -     378,484  
รวม   -     458,443   87,666   753   -     -     546,862  
มหาสารคาม เ ม ื อ ง

มหาสารคาม 
 21,742   78,557   122,220   97,223   37,523   188   357,454  

มหาสารคาม แกดำ  842   11,675   30,038   57,926   9,077   5   109,563  
มหาสารคาม โกสุมพิสัย  52,921   94,804   152,698   140,945   52,012   48   493,429  
มหาสารคาม กันทรวิชัย  21,881   42,170   83,485   108,260   1,215   -     257,011  
มหาสารคาม เชียงยืน  18,767   36,308   58,615   74,275   11,610   3   199,577  
มหาสารคาม บรบือ  2,270   17,838   69,233   59,307   26,448   123   175,218  
มหาสารคาม วาปีปทุม  271   1,799   5,372   17,418   3,422   3   28,286  
มหาสารคาม กุดรัง  311   15,628   87,889   42,636   6,869   -     153,334  
มหาสารคาม ชื่นชม  1,543   12,549   31,721   33,712   2,399   -     81,923  

รวม  120,548 311,328 641,271 631,702 150,575 372 
 

1,855,795 
 

มุกดาหาร ดงหลวง  788   14   34   -     -     -     836  
มุกดาหาร คำชะอี  3,284   376   287   -     -     -     3,947  
มุกดาหาร หนองสูง  16,236   7,124   3,033   34   -     -     26,427  
รวม   20,308   7,514   3,354   34   -     -     31,210  
ยโสธร เมืองยโสธร  36,902   104,185   106,756   88,997   12,071   -     348,910  
ยโสธร ทรายมูล  3,943   30,080   27,004   40,991   14,928   6   116,952  
ยโสธร กุดชุม  3,675   34,014   35,064   50,744   10,208   3   133,708  
ยโสธร คำเขื่อนแก้ว  40,948   40,335   52,451   5,771   7   -     139,512  
ยโสธร ป่าติ้ว  111   228   370   50   21   -     780  
ยโสธร มหาชนะชัย  92,901   85,874   36,889   683   -     -     216,348  
ยโสธร ค้อวัง  27,459   32,300   56,523   2,252   -     -     118,534  
ยโสธร เลิงนกทา  -     237   141   19   -     -     397  
รวม   205,940   327,254   315,199   189,507   37,234   8   1,075,142  
ร้อยเอ็ด เมืองร้อยเอ็ด  6,967   56,740   157,004   60,245   1,344   -     282,300  
ร้อยเอ็ด จ ต ุ ร พ ั ก ต ร

พิมาน 
 657   3,755   29,291   14,725   3,648   -     52,075  

ร้อยเอ็ด ธวัชบุรี  11,025   29,665   70,168   88,027   10,017   -     208,902  
ร้อยเอ็ด พนมไพร  26,567   49,040   44,778   14,160   483   -     135,028  
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ตำรำงที ่23 พืน้ที่เสี่ยงภยัแลง้ในลุม่น ำ้ชี 6 ระดบั แยกรำยอ ำเภอ 

จงัหวดั อ ำเภอ ระดบั 0 ระดบั 1 ระดบั 2 ระดบั 3 ระดบั 4 ระดบั 5 รวม (ไร)่ 
ร้อยเอ็ด โพนทอง  37,275   88,941   165,674   116,823   17,413   5   426,132  
ร้อยเอ็ด โพธิ์ชัย  5,538   58,171   87,179   79,151   6,614   6   236,659  
ร้อยเอ็ด หนองพอก  51,776   54,181   95,619   80,216   47,417   12   329,221  
ร้อยเอ็ด เสลภูมิ  88,758   151,378   134,523   77,593   16,045   -     468,297  
ร้อยเอ็ด สุวรรณภูมิ  1,335   5,684   10,181   19,218   310   -     36,728  
ร้อยเอ็ด เมืองสรวง  619   2,825   8,723   29,895   1,616   3   43,681  
ร้อยเอ็ด อาจสามารถ  11,450   47,273   74,867   106,827   16,092   4   256,513  
ร้อยเอ็ด เมยวดี  11,225   22,075   37,013   29,780   6,095   -     106,188  
ร้อยเอ็ด ศรีสมเด็จ  1,256   9,551   40,485   45,645   5,712   35   102,683  
ร้อยเอ็ด จังหาร  15,757   48,070   45,395   4,770   1   -     113,992  
ร้อยเอ็ด เชียงขวัญ  4,060   24,634   44,442   8,368   2   -     81,506  
ร้อยเอ็ด ทุ่งเขาหลวง  3,257   24,829   24,025   22,118   10,334   14   84,577  
รวม   277,522   676,811   1,069,366   797,560   143,143   79   2,964,481  
ลพบุรี ลำสนธิ  -     1,189   15   -     -     -     1,204  
รวม   -     1,189   15   -     -     -     1,204  
เลย นาด้วง  58,722   43,940   32,477   6,271   -     -     141,411  
เลย ปากชม  1,029   372   91   -     -     -     1,491  
เลย วังสะพุง  -     3,446   3,279   2,271   29   -     9,025  
เลย ภูกระดึง  674   298,282   131,254   42,266   7,505   -     479,981  
เลย ภูหลวง  -     205   26   -     -     -     230  
เลย ผาขาว  554   49,593   76,823   68,819   55,070   7   250,867  
เลย เอราวัณ  615   23,340   28,590   27,953   10,496   -     90,993  
เลย หนองหิน  -     44,141   20,512   12,400   2,493   -     79,545  
รวม   61,593   463,318   293,050   159,981   75,593   7   1,053,543  
ศรีสะเกษ ยางชุมน้อย  1,356   4,066   9,094   76   -     -     14,592  
ศรีสะเกษ กันทรารมย์  50,623   42,005   23,878   325   -     -     116,831  
ศรีสะเกษ ราษีไศล  2,707   12,042   33,248   18,319   -     -     66,317  
รวม   54,686   58,113   66,220   18,719   -     -     197,739 

  
สกลนคร กุดบาก  966   359   48   -     -     -     1,374  
สกลนคร วาริชภูมิ  84   353   40   -     -     -     477  
สกลนคร นิคมน้ำอูน  281   57   15   -     -     -     352  
สกลนคร เต่างอย  600   87   20   -     -     -     707  
สกลนคร ภูพาน  2,536   142   97   -     -     -     2,775  
รวม   4,467   997   221   -     -     -     5,685  

 
หนองบัวลำ
ภู 

เ ม ื อ ง
หนองบัวลำภู 

 5,145   86,131   155,718   209,830   48,102   72   504,996  

หนองบัวลำ
ภู 

นากลาง  17,903   30,312   75,783   85,398   16,064   1   225,461  

หนองบัวลำ
ภู 

โนนสัง  18,478   117,843   153,071   114,203   8,434   -     412,029  

หนองบัวลำ
ภู 

ศรีบุญเรือง  6,404   63,312   137,370   135,244   204,721   406   547,456  

หนองบัวลำ
ภู 

นาวัง  37,933   51,015   66,285   26,515   8,848   -     190,595  

รวม   85,863   348,612   588,227   571,190   286,169   479   1,880,538  
อุดรธานี เมืองอุดรธานี  4,018   18,638   23,539   5,254   217   -     51,665  
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ตำรำงที ่23 พืน้ที่เสี่ยงภยัแลง้ในลุม่น ำ้ชี 6 ระดบั แยกรำยอ ำเภอ 

จงัหวดั อ ำเภอ ระดบั 0 ระดบั 1 ระดบั 2 ระดบั 3 ระดบั 4 ระดบั 5 รวม (ไร)่ 
อุดรธานี หนองวัวซอ  72   9,171   1,871   51   2   -     11,166  
อุดรธานี กุมภวาปี  43,405   84,821   164,809   128,246   2,702   -     423,982  
อุดรธานี โนนสะอาด  1,118   47,784   89,468   130,397   3,960   -     272,726  
อุดรธานี หนองหาน  2,359   9,313   23,293   12,574   80   -     47,619  
อุดรธานี ไชยวาน  11,195   34,939   64,910   18,689   26   -     129,759  
อุดรธานี ศรีธาตุ  17,008   67,714   163,639   77,927   3,077   -     329,366  
อุดรธานี วังสามหมอ  51,137   128,862   170,979   105,508   8,372   -     464,859  
อุดรธานี หนองแสง  1,920   87,733   54,311   71,118   4,165   -     219,247  
อุดรธานี กู่แก้ว  14,498   26,456   43,384   10,421   -     -     94,758  
อุดรธานี ป ร ะ จ ั ก ษ์

ศิลปาคม 
 13,389   16,343   37,367   14,133   26   -     81,259  

รวม   160,120   531,773   837,571   574,316   22,627   -     2,126,406  
อุบลราชธานี เ ม ื อ ง

อุบลราชธานี 
 18,179   5,556   523   -     -     -     24,259  

อุบลราชธานี เขื่องใน  117,031   129,896   127,185   19,371   7   -     393,491  
รวม   135,210   135,452   127,709   19,371   7   -     417,749  

 
 
4.4 ผลการวิเคราะห์หาพื้นที่เสี่ยงภัยแล้งจากดาวเทียม โดยการศึกษาดัชนีที่มีผลต่อการเกิดพื้นที่เสี่ยงภัยแล้ง  

4.4.1 ดัชนี NDVI ดัชนีความแตกต่างพืชพรรณ 

 
รูปที่ 31 แผนที่แสดงค่าดัชนีความแตกต่างพืชพรรณ (NDVI) 
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ตารางท่ี 24 ค่าดัชนีความแตกต่างพืชพรรณ ( NDVI) แยกตามรายจังหวัด อำเภอ ตำบล 
ตารางแสดงดัชนี NDVI  ดัชนีความแตกต่างพืชพรรณ 
ระดับท่ี 1 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ หนองบัวแดง นางแดด 312,782.31 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 305,393.75 
ชัยภูมิ หนองบัวแดง หนองบัวแดง 135,456.91 
ระดับท่ี 2 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
เลย ภูกระดึง ศรีฐาน 142,024.51 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 128,889.30 
อุดรธานี วังสามหมอ ผาสุก 89,483.65 
ระดับท่ี 3 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ หนองบัวระเหว วังตะเฆ่ 160,085.44 
ชัยภูมิ เทพสถิต นายางกลัก 117,395.99 
อุดรธานี วังสามหมอ บะยาว 106,723.62 
ระดับท่ี 4 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
อุดรธานี ศรีธาตุ หัวนาคำ 52,540.86 
อุดรธานี โนนสะอาด ทมนางาม 37,763.74 
เลย ภูกระดึง ศรีฐาน 33,658.99 
ระดับท่ี 5 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ขอนแก่น ภูเวียง นาหว้า 35,300.89 
กาฬสินธุ์ หนองกุงศรี เสาเล้า 21,344.72 
หนองบัวลำภู โนนสัง หนองเรือ 10,672.36 

ผลการสำรวจพบว่า  ดัชนีความแตกต่างพืชพรรณ (Normalized Difference Vegetation Index : 
NDVI) ในพื้นที่ศึกษาลุ่มน้ำชี จำนวนทั้งหมด 30,788,944.54 ไร่ โดยสามารถแบ่งตามรายจังหวัด อำเภอ และ
ตำบล ดังนี้ 

พื้นที่ระดับที่ 1 แสดงความสมบูรณ์ของพืชพรรณมากที่สุด พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอหนอง
บัวแดง ตำบลนางแดด จำนวน 312,782.31 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่งลุยลาย 
จำนวน 305,393.75 ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลหนองบัวแดง จำนวน 135,456.91 ไร่ 
ตามลำดับ 
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พ้ืนที่ระดับท่ี 2 แสดงความสมบูรณ์ของพืชพรรณมาก พบมากที่สุด คือ จังหวัดเลย อำเภอภูกระดึง ตำบล
ศรีฐาน จำนวน 142,024.51 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่งลุยลาย จำนวน 128,889.30 
ไร่ และจังหวัดอุดรธานี อำเภอวังสามหมอ ตำบลผาสุก จำนวน 894,83.65 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 3 แสดงความสมบูรณ์ของพืชพรรณปานกลาง พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอหนอง
บัวระเหว ตำบลวังตะเฆ่ จำนวน 160,085.44 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอเทพสถิต ตำบลนายางกลัก 
จำนวน 117,395.99 ไร่ และจังหวัดอุดรธานี อำเภอวังสามหมอ ตำบลบะยาว จำนวน 106,723.62 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 4 แสดงความสมบูรณ์ของพืชพรรณต่ำ พบมากที่สุด คือ จังหวัดอุดรธานี อำเภอศรีธาตุ 
ตำบลหัวนาคำ จำนวน 52,540.86 ไร่ รองลงมา คือ จังหวัดอุดรธานี อำเภอโนนสะอาด ตำบลทมนางาม จำนวน 
37,763.74 ไร่ และจังหวัดเลย อำเภอภูกระดึง ตำบลศรีฐาน จำนวน 33,658.99 ไร่ ตามลำดับ  

พ้ืนที่ระดับท่ี 5 แสดงความสมบูรณ์ของพืชพรรณต่ำที่สุด พบมากที่สุด คือ จังหวัดขอนแก่น อำเภอภูเวียง 
ตำบลนาหว้า จำนวน 35,300.89 ไร่ รองลงมา คือ จังหวัดกาฬสินธุ์ อำเภอหนองกุงศรี ตำบลเสาเล้า จำนวน 
21,344.72 ไร่ และจังหวัดหนองบัวลำภู อำเภอโนนสัง ตำบลหนองเรือไร่ จำนวน 10,672.36 ไร่ ตามลำดับ 

4.4.2 ดัชนี NDWI ดัชนีผลต่างความชื้นของน้ำ 

 
รูปที่ 32 แผนที่แสดงค่าดัชนีผลต่างความชื้นของน้ำ (NDWI) 
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ตารางท่ี 25 ค่าดัชนีผลต่างความชื้นของน้ำ (NDWI) แยกตามรายจังหวัด อำเภอ ตำบล 
ตารางแสดงดัชนี NDWI ดัชนีผลต่างความชื้นของน้ำ 
ระดับท่ี 1 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 199,413.08 
ชัยภูมิ หนองบัวแดง นางแดด 193,668.67 
ชัยภูมิ หนองบัวแดง หนองบัวแดง 90,269.29 
ระดับท่ี 2 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 242,085.83 
ชัยภูมิ หนองบัวแดง นางแดด 213,363.78 
เลย ภูกระดึง ศรีฐาน 199,413.08 
ระดับท่ี 3 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ เทพสถิต นายางกลัก 100,937.48 
อุดรธานี ศรีธาตุ หัวนาคำ 83,704.25 
ชัยภูมิ หนองบัวระเหว วังตะเฆ ่ 80,421.73 
ระดับท่ี 4 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ขอนแก่น มัญจาคีร ี นางาม 65,650.40 
หนองบัวลำภู ศรีบุญเรือง โนนสะอาด 59,085.36 
หนองบัวลำภู เมือหนองบัวลำภู หัวนา 55,802.84 
ระดับท่ี 5 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ เมืองชัยภูม ิ กุดตุ้ม 36,928.35 
ยโสธร มหาชนะชัย บึงแก 28,722.05 
ชัยภูมิ เมืองชัยภูม ิ หนองไผ่ 27,901.42 
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 ผลการสำรวจพบว่า ดัชนีผลต่างความชื ้นของน้ำ (Normalized Difference Water Index : 
NDWI) ในพื้นที่ศึกษาลุ่มน้ำชี จำนวนทั้งหมด 30,784,291.02 ไร่ โดยสามารถแบ่งตามรายจังหวัด อำเภอ และ
ตำบล ดังนี้ 

พ้ืนที่ระดับท่ี 1 แสดงความชุ่มน้ำของพืชสูงที่สุด พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่ง
ลุยลาย จำนวน 199,413.08 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนางแดด จำนวน 
193,668.67 ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลหนองบัวแดง จำนวน 90,269.29 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 2 แสดงความชุ่มน้ำของพืชสูง พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่งลุย
ลาย จำนวน 242,085.83 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนางแดด จำนวน 213,363.78 
ไร่ และจังหวัดเลย อำเภอภูกระดึง ตำบลศรีฐาน จำนวน 199,413.08 ไร่ ตามลำดับ  

พ้ืนที่ระดับท่ี 3 แสดงความชุ่มน้ำของพืชปานกลาง พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอเทพสถิต ตำบล
นายางกลัก จำนวน  100,937.48  ไร่ รองลงมา คือ จังหวัดอุดรธานี อำเภอศรีธาตุ ตำบลหัวนาคำ จำนวน 
83,704.25 ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวระเหว ตำบลวังตะเฆ่ จำนวน  80,421.73 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 4 แสดงความชุ่มน้ำของพืชต่ำ พบมากที่สุด คือ จังหวัดขอนแก่น อำเภอมัญจาคีรี ตำบลนา
งาม จำนวน 65,650.40 ไร่ รองลงมา คือ จังหวัดหนองบัวลำภู อำเภอศรีบุญเรือง ตำบลโนนสะอาด จำนวน 
59,085.36 ไร่ และจังหวัดหนองบัวลำภู อำเภอเมืองหนองบัวลำภู ตำบลหัวนา จำนวน 55,802.84 ไร่ ตามลำดับ  

พ้ืนที่ระดับท่ี 5 แสดงความชุ่มน้ำของพืชต่ำที่สุด พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอเมืองชัยภูมิ ตำบล
กุดตุ้ม จำนวน 36,928.35 ไร่ รองลงมา คือ จังหวัดยโสธร อำเภอมหาชนะชัย ตำบลบึงแก จำนวน 28,722.05 ไร่ 
และจังหวัดชัยภูมิ อำเภอเมืองชัยภูมิ ตำบลหนองไผ่ จำนวน 27,901.42 ไร่ ตามลำดับ 
 

4.4.3 ดัชนี NDDI ดัชนีความแตกต่างความแห้งแล้ง 

 
รูปที่ 33 แผนที่แสดงค่าดัชนีความแตกต่างความแห้งแล้ง (NDDI) 
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ตารางท่ี 26 ค่าดัชนีความแตกต่างแล้ง (NDDI) แยกตามรายจังหวัด อำเภอ ตำบล 

ตารางแสดงดัชนี NDDI ดัชนีความแตกต่างแล้ง 
ระดับท่ี 1 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ หนองบัวแดง นางแดด 323,466.84 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 321,824.87 
ชัยภูมิ หนองบัวแดง หนองบัวแดง 136,282.98 
ระดับท่ี 2 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
เลย ภูกระดึง ศรีฐาน 114,116.47 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 102,622.73 
อุดรธานี วังสามหมอ ผาสุก 70,604.44 
ระดับท่ี 3 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ หนองบัวระเหว วังตะเฆ ่ 132,999.06 
ชัยภูมิ เทพสถิต นายางกลัก 110,832.55 
ชัยภูมิ หนองบัวระเหว ห้วยแย้ 96,054.87 
ระดับท่ี 4 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
อุดรธานี ศรีธาตุ หัวนาคำ 74,709.35 
อุดรธานี วังสามหมอ บะยาว 45,154.00 
กาฬสินธุ์ คำม่วง นาทัน 37,765.16 
ระดับท่ี 5 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ขอนแก่น ภูเวียง นาหว้า 36,944.18 
เพชรบูรณ์ น้ำหนาว โคกมน 27,913.38 
เลย ภูกระดึง ศรีฐาน 25,450.44 

 
ผลการสำรวจพบว่า ดัชนีผลต่างความแห้งแล้ง (The Normalized Different Drought Index : NDDI) 

ในพ้ืนที่ศึกษาลุ่มน้ำชี จำนวนทั้งหมด 30,766,293.81 ไร่ โดยสามารถแบ่งตามรายจังหวัด อำเภอ และตำบล ดังนี้ 
พ้ืนที่ระดับท่ี 1 แสดงความแห้งแล้งสูงที่สุด พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนาง

แดด จำนวน 323,466.84 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่งลุยลาย จำนวน 321,824.87 
ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลหนองบัวแดง จำนวน 136,282.98 ไร่ ตามลำดับ  
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พ้ืนที่ระดับท่ี 2 แสดงความแห้งแล้งสูง พบมากที่สุด คือ จังหวัดเลย อำเภอภูกระดึง ตำบลศรีฐาน จำนวน 
114,116.47 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่งลุยลาย จำนวน 102,622.73 ไร่ และจังหวัด
อุดรธานี อำเภอวังสามหมอ ตำบลผาสุก จำนวน 70,604.44 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 3 แสดงความแห้งแล้งปานกลาง พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอหนองบัวระเหว 
ตำบลวังตะเฆ่ จำนวน  132,999.06 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอเทพสถิต ตำบลนายางกลัก จำนวน 
110,832.55 ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวระเหว ตำบลห้วยแย้ จำนวน 96,054.87 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 4 แสดงความแห้งแล้งต่ำ พบมากที่สุด คือ จังหวัดอุดรธานี อำเภอศรีธาตุ ตำบลหัวนาคำ 
จำนวน 74,709.35 ไร่ รองลงมา คือ จังหวัดอุดรธานี อำเภอวังสามหมอ ตำบลบะยาว จำนวน 45,154.00 ไร่ และ
จังหวัดกาฬสินธุ์ อำเภอคำม่วง ตำบลนาทัน จำนวน 37,765.16 ไร่ ตามลำดับ 

พ้ืนที่ระดับท่ี 5 แสดงความแห้งแล้งต่ำที่สุด พบมากที่สุด คือ จังหวัดขอนแก่น อำเภอภูเวียง ตำบลนาหว้า 
จำนวน 36,944.18 ไร่ รองลงมา คือ จังหวัดเพชรบูรณ์ อำเภอน้ำหนาว ตำบลโคกมน จำนวน 27,913.38 ไร่ และ
จังหวัดเลย อำเภอเมืองภูกระดึง ตำบลศรีฐาน จำนวน 25,450.44 ไร่ ตามลำดับ 
 
4.4.4 ดัชนี VHI ดัชนีความสมบูรณ์ของพืชพรรณ 

 
รูปที่ 34 แผนที่แสดงค่าดัชนีความสมบูรณ์ของพืชพรรณ (VHI) 
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ตารางท่ี 27 ค่าดัชนีความสมบูรณ์ของพืชพรรณ (VHI) แยกตามรายจังหวัด อำเภอ ตำบล 
ตารางแสดงดัชนี VHI ดัชนีความสมบูรณ์ของพืชพรรณ 
ระดับท่ี 1 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 316,429.92 
ชัยภูมิ หนองบัวแดง นางแดด 304,101.48 
ชัยภูมิ หนองบัวแดง หนองบัวแดง 90,408.55 
ระดับท่ี 2 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
เพชรบูรณ์ น้ำหนาว น้ำหนาว 142,187.99 
เลย ภูกระดึง ศรีฐาน 128,215.76 
ชัยภูมิ หนองบัวแดง นางแดด 115,887.32 
ระดับท่ี 3 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
เลย ภูกระดึง ศรีฐาน 120,818.70 
หนองบัวลำภู ศรีบุญเรือง โนนสะอาด 96,161.82 
เพชรบูรณ์ น้ำหนาว วังกวาง 87,942.86 
ระดับท่ี 4 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ เทพสถิต นายางกลัก 78,902.01 
อุดรธานี ศรีธาตุ หัวนาคำ 69,861.15 
หนองบัวลำภู ศรีบุญเรือง โนนม่วง 68,217.36 
ระดับท่ี 5 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
อุดรธานี วังสามหมอ ผาสุก 92,052.34 
เลย นาด้วง นาดอกคำ 73,970.63 
กาฬสินธุ์ กุฉินารายณ์ กุดหว้า 72,326.84 
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ผลการสำรวจพบว่า ดัชนีความสมบูรณ์ของพืชพรรณ (Vegetation Health Index : VHI) ในพื้นที่ศึกษา
ลุ่มน้ำชี จำนวนทั้งหมด 31,036,432.74 ไร่ โดยสามารถแบ่งตามรายจังหวัด อำเภอ และตำบล ดังนี้ 

พื้นที่ระดับที่ 1 แสดงสุขภาพพืชพรรณสูงที่สุด พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่ง
ลุยลาย จำนวน 316,429.92 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนางแดด จำนวน 
304,101.48 ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลหนองบัวแดง จำนวน 90,408.55 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 2 แสดงสุขภาพพืชพรรณสูง พบมากที่สุด คือ จังหวัดเพชรบูรณ์ อำเภอน้ำหนาว ตำบลน้ำ
หนาว จำนวน 142,187.99 ไร่ รองลงมา คือ จังหวัดเลย อำเภอเมืองภูกระดึง ตำบลศรีฐาน จำนวน  128,215.76 
ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนางแดด จำนวน 115,887.32 ไร่ ตามลำดับ  

พ้ืนที่ระดับท่ี 3 แสดงสุขภาพพืชพรรณปานกลาง พบมากที่สุด คือ จังหวัดเลย อำเภอเมืองภูกระดึง ตำบล
ศรีฐาน จำนวน  120,818.70 ไร่ รองลงมา คือ จังหวัดหนองบัวลำภู อำเภอศรีบุญเรือง ตำบลโนนสะอาด จำนวน 
96,161.82 ไร่ และจังหวัดเพชรบูรณ์ อำเภอน้ำหนาว ตำบลวังกวาง จำนวน 87,942.86 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 4 แสดงสุขภาพพืชพรรณต่ำ พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอเทพสถิต ตำบลนายาง
กลัก จำนวน 78,902.01 ไร่ รองลงมา คือ จังหวัดอุดรธานี อำเภอศรีธาตุ ตำบลหัวนาคำ จำนวน 69,861.15 ไร่ 
และจังหวัดหนองบัวลำภู อำเภอศรีบุญเรือง ตำบลโนนม่วง จำนวน 68,217.36 ไร่ ตามลำดับ 
พื้นที่ระดับที่ 5 แสดงสุขภาพพืชพรรณต่ำที่สุด พบมากที่สุด คือ จังหวัดอุดรธานี อำเภอวังสามหมอ ตำบลผาสุก 
จำนวน 92,052.34 ไร่ รองลงมา คือ จังหวัดเลย อำเภอนาด้วง ตำบลนาดอกคำ จำนวน 73 ,970.63 ไร่ และ
จังหวัดกาฬสินธุ์ อำเภอกุฉินารายณ์ ตำบลกุดหว้า จำนวน 72,326.84 ไร่ ตามลำดับ 
 

4.4.5 ดัชนี VCI ดัชนีวัดการเจริญโตของพืช 

 
รูปที่ 35 แผนที่แสดงค่าดัชนีวัดการเจริญโตของพืช (VCI) 
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ตารางท่ี 28 ค่าดัชนีการวัดการเจริญเติบโตของพืช (VCI) แยกตามรายจังหวัด อำเภอ ตำบล 

ตารางแสดงดัชนี VCI  ดัชนีวัดการเจริญเติบโตของพืช 
ระดับท่ี 1 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 308,190.70 
ชัยภูมิ หนองบัวแดง นางแดด 301,598.39 
ชัยภูมิ หนองบัวแดง หนองบัวแดง 79,931.81 
ระดับท่ี 2 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
เพชรบูรณ์ น้ำหนาว น้ำหนาว 151,623.23 
เลย ภูกระดึง ศรีฐาน 143,382.84 
ชัยภูมิ หนองบัวแดง นางแดด 122,781.86 
ระดับท่ี 3 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
เลย ภูกระดึง ศรีฐาน 104,652.99 
เพชรบูรณ์ น้ำหนาว วังกวาง 97,236.64 
หนองบัวลำภู ศรีบุญเรือง โนนสะอาด 95,588.56 
ระดับท่ี 4 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ เทพสถิต นายางกลัก 74,163.54 
หนองบัวลำภู ศรีบุญเรือง โนนม่วง 64,275.07 
หนองบัวลำภู นากลาง ฝั่งแดง 56,858.71 
ระดับท่ี 5 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
อุดรธานี วังสามหมอ ผาสุก 142,558.80 
อุดรธานี วังสามหมอ บะยาว 120,309.74 
อุดรธานี ศรีธาตุ หัวนาคำ 110,421.27 
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ผลการสำรวจพบว่า ดัชนีวัดการเจริญเติบโตของพืช (VCI: Vegetation Condition Index) พบในพ้ืนที่
ศึกษาลุ่มน้ำชี จำนวนทั้งหมด 31,067,930.10 ไร่ โดยสามารถแบ่งตามรายจังหวัด อำเภอ ตำบล ดังนี้ 

พ้ืนที่ระดับที่ 1 แสดงความสมบูรณ์ของพืชพรรณมากท่ีสุด พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอคอนสาร
ตำบลทุ่งลุยลาย จำนวน 308,190.70 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนางแดด จำนวน 
301,598.38 ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลหนองบัวแดง จำนวน 79,931.81  ไร่ ตามลำดับ  

พ้ืนที่ระดับที่ 2 แสดงความสมบูรณ์ของพืชพรรณมาก พบมากที่สุด คือ จังหวัดเพชรบูรณ์ อำเภอน้ำหนาว 
ตำบลน้ำหนาว จำนวน 151,623.23 ไร่ รองลงมา คือ จังหวัดเลย อำเภอภูกระดึง ตำบลศรีฐาน จำนวน 
143,382.84  ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนางแดด จำนวน 122,781.85 ไร่ ตามลำดับ  

พ้ืนที่ระดับที่ 3 แสดงความสมบูรณ์ของพืชพรรณปานกลาง พบมากท่ีสุด คือ จังหวัดเลย  อำเภอภูกระดึง 
ตำบลศรีฐาน จำนวน 30,489.45 ไร่ รองลงมา คือ จังหวัดเพชรบูรณ์ อำเภอน้ำหนาว ตำบลวังกวาง จำนวน 
9,888.47 ไร่ และจังหวัดหนองบัวลำภู อำเภอศรีบุญเรือง ตำบลโนนสะอาด จำนวน 3,296.15 ไร่ ตามลำดับ  

พ้ืนที่ระดับที่ 4 แสดงความสมบูรณ์ของพืชพรรณต่ำ พบมากท่ีสุด จังหวัดชัยภูมิ อำเภอเทพสถิต ตำบล
ยางกลัก จำนวน 74,163.53 ไร่ รองลงมา คือ จังหวัดหนองบัวลำภู อำเภอศรีบุญเรือง ตำบลโนนม่วง จำนวน 
64,275.06 ไร่ และจังหวัดหนองบัวลำภู อำเภอนากลาง ตำบลฝั่งแดง จำนวน 56,858.71 ไร่ ตามลำดับ  

พ้ืนที่ระดับท่ี 5 แสดงความสมบูรณ์ของพืชพรรณต่ำที่สุด พบมากที่สุด จังหวัดอุดรธานี อำเภอวังสามหมอ 
ตำบลผาสุก จำนวน 142,558.80 ไร่ รองลงมา คือ จังหวัดอุดรธานี อำเภอวังสามหมอ ตำบลบะยาว จำนวน 
120,309.73 ไร่ และจังหวัดอุดรธานี อำเภอศรีธาตุ ตำบลหัวนาคำ จำนวน  110,421.26 ไร่ ตามลำดับ 

4.4.6 ดัชนี TCI ดัชนีวัดอุณหภูมิ 

 
รูปที่ 36 แผนที่แสดงค่าดัชนีวัดอุณหภูมิ (TCI) 
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ตารางท่ี 29 ค่าดัชนีวัดอุณหภูมิ (TCI) แยกตามรายจังหวัด อำเภอ ตำบล 
ตารางแสดงดัชนี TCI  ดัชนีวัดอุณหภูมิ 
ระดับท่ี 1 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
กาฬสินธุ์ กมลาไสย ธัญญา 23,233.38 
ขอนแก่น น้ำพอง ท่ากระเสริม 23,233.38 
อุดรธานี วังสามหมอ บะยาว 20,744.09 
ระดับท่ี 2 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
อุดรธานี วังสามหมอ บะยาว 32,360.78 
อุดรธานี ศรีธาตุ หัวนาคำ 21,573.86 
อุดรธานี กุมภวาปี เวียงคำ 18,254.80 
ระดับท่ี 3 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
กาฬสินธุ์ กุฉินารายณ์ นาขาม 30,701.26 
กาฬสินธุ์ หนองกุงศร ี หนองบัว 29,871.49 
อุดรธานี ศรีธาตุ หัวนาคำ 27,382.20 
ระดับท่ี 4 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ หนองบัวแดง นางแดด 50,615.58 
ชัยภูมิ หนองบัวแดง หนองแวง 49,785.82 
อุดรธานี ศรีธาตุ หัวนาคำ 42,317.95 
ระดับท่ี 5 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 472,135.53 
ชัยภูมิ หนองบัวแดง นางแดด 428,158.06 
เลย ภูกระดึง ศรีฐาน 263,864.85 
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ผลการสำรวจพบว่า  ดัชนีวัดอุณหภูมิ (TCI: Temperature Condition Index) พบในพ้ืนที่ศึกษาลุ่มน้ำชี 
จำนวนทั้งหมด 31,372,534.83 ไร่ โดยสามารถแบ่งตามรายจังหวัด อำเภอ ตำบล ดังนี้ 

พ้ืนที่ระดับท่ี 1 แสดงความสมบูรณ์ของพืชพรรณมากท่ีสุด พบมากที่สุด คือ จังหวัดกาฬสินธุ์ อำเภอกมลา
ไสย ตำบลธัญญา จำนวน 23,233.38 ไร่ รองลงมา คือ จังหวัดขอนแก่น อำเภอน้ำพอง ตำบลท่ากระเสริม จำนวน 
23,233.38 ไร่ และจังหวัดอุดรธานี อำเภอวังสามหมอ ตำบลบะยาว จำนวน 20,744.09 ไร่ ตามลำดับ  

พ้ืนที่ระดับท่ี 2 แสดงความสมบูรณ์ของพืชพรรณมาก พบมากที่สุด คือ จังหวัดอุดรธานี อำ เภอว ั ง ส า ม
หมอ ตำบลบะยาว จำนวน 32,360.78 ไร่ รองลงมา คือ จังหวัดอุดรธานี อำเภอศรีธาตุ ตำบลหัวนาคำ จำนวน 
21,573.85 ไร่ และจังหวัดอุดรธานี อำเภอกุมภวาปี ตำบลเวียงคำ จำนวน 18,254.80 ไร่ ตามลำดับ 

พื้นที่ระดับที่ 3 แสดงความสมบูรณ์ของพืชพรรณปานกลาง พบมากที่สุด คือ จังหวัดกาฬสินธุ์ อำเภอกุฉิ
นารายณ์ ตำบลนาขาม จำนวน 30,701.25 ไร่ รองลงมา คือ จังหวัดกาฬสินธุ์ อำเภอหนองกุงศรี ตำบลหนองบัว 
จำนวน 29,871.49 ไร่ และจังหวัดขอนแก่น อำเภอกระนวน ตำบลหนองโก จำนวน 27,382.20 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 4 แสดงความสมบูรณ์ของพืชพรรณต่ำ พบมากที่สุด จังหวัดชัยภูมิ อำเภอหนองบัวแดง 
ตำบลนางแดด จำนวน 50,615.58 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลหนองแวง จำนวน 
49,785.82 ไร่ และจังหวัดอุดรธานี อำเภอศรีธาตุ ตำบลหัวนาคำ จำนวน 42,317.94 ไร่ ตามลำดับ  
พื้นที่ระดับที่ 5 แสดงความสมบูรณ์ของพืชพรรณต่ำที่สุด พบมากที่สุด จังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่งลุย
ลาย จำนวน 472,135.53 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลางแดด จำนวน 428,158.05 
ไร่ และจังหวัดเลย อำเภอภูกระดึง ตำบลศรีฐาน จำนวน 263,864.85 ไร่ ตามลำดับ 
 

4.4.7 ดัชนี LST ดัชนีวัดอุณหภูมิพ้ืนผิว 

 
รูปที่ 37 แผนที่แสดงค่าดัชนีวัดอุณหภูมิพื้นผิว (LST) 
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ตารางท่ี 30 ค่าดัชนีวัดอุณหภูมิพ้ืนผิว (LST) แยกตามรายจังหวัด อำเภอ ตำบล 
ตารางแสดงดัชนี LST  ดัชนีวัดอุณหภูมิพ้ืนผิว 
ระดับท่ี 1 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 391,721.13 
ชัยภูมิ หนองบัวแดง นางแดด 324,662.39 
ชัยภูมิ หนองบัวแดง หนองบัวแดง 163,557.88 
ระดับท่ี 2 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
เลย ภูกระดึง ศรีฐาน 154,562.20 
ชัยภูมิ เมืองชัยภูม ิ ซับสีทอง 100,588.10 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 89,956.83 
ระดับท่ี 3 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ เทพสถิต นายางกลัก 107,130.41 
ชัยภูมิ หนองบัวระเหว วังตะเฆ ่ 77,689.99 
อุดรธานี วังสามหมอ ผาสุก 71,965.47 
ระดับท่ี 4 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ หนองบัวระเหว วังตะเฆ ่ 78,507.78 
ชัยภูมิ บ้านเขว้า ตลาดแร้ง 66,240.94 
อุดรธานี ศรีธาตุ หัวนาคำ 62,969.78 
ระดับท่ี 5 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
นครราชสีมา บ้านเหลื่อม โคกกระเบื้อง 67,876.52 
หนองบัวลำภู ศรีบุญเรือง โนนสะอาด 66,240.94 
หนองบัวลำภู นากลาง ฝั่งแดง 58,880.84 
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ผลการสำรวจพบว่า  ดัชนีวัดอุณหภูมิ (LST: Land Surface Temperature) พบในพื้นที่ศึกษาลุ่มน้ำชี 
จำนวนทั้งหมด 30,788,135.56 ไร่ โดยสามารถแบ่งตามรายจังหวัด อำเภอ ตำบล ดังนี้ 

พ้ืนที่ระดับท่ี 1 แสดงความสมบูรณ์ของพืชพรรณมากท่ีสุด พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอคอนสาร 
ตำบลทุ่งลุยลาย จำนวน 391,721.13 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนางแดด จำนวน 
324,662.39 ไร่ จำนวน 23,233.38 ไร่ และจังหวัดชัยภูมิ อำเภอหนองบั วแดง ตำบลหนองบัวแดง จำนวน 
163,557.88 ไร่ ตามลำดับ  

พ้ืนที่ระดับท่ี 2 แสดงความสมบูรณ์ของพืชพรรณมาก พบมากที่สุด คือ จังหวัดเลย อำเภอภูกระดึง ตำบล
ศรีฐาน จำนวน 154,562.19 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอเมืองชัยภูมิ ตำบลซับสีทอง จำนวน 
100,588.09 ไร่ และจังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่งลุยลาย จำนวน 89,956.83 ไร่ ตามลำดับ 

พื้นที่ระดับที่ 3 แสดงความสมบูรณ์ของพืชพรรณปานกลาง พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอเทพ
สถิต ตำบลนายางกลัก จำนวน 107,130.41 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอหนองบัวระเหว ตำบลวังตะเฆ่ 
จำนวน 77,689.99 ไร่ และจังหวัดอุดรธานี อำเภอวังสามหมอ ตำบลบะยาว จำนวน 71,965.46 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 4 แสดงความสมบูรณ์ของพืชพรรณต่ำ พบมากที่สุด จังหวัดชัยภูมิ อำเภอหนองบัวระเหว 
ตำบลวังตะเฆ่ จำนวน 78,507.78 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอบ้านเขว้า ตำบลตลาดแร้ง จำนวน 
66,240.94 ไร่ และจังหวัดอุดรธานี อำเภอศรีธาตุ ตำบลหัวนาคำ จำนวน 62,969.78 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 5 แสดงความสมบูรณ์ของพืชพรรณต่ำที่สุด พบมากที่สุด จังหวัดนครราชสีมา อำเภอบ้าน
เหลื่อม ตำบลโคกกระเบื้อง จำนวน 67,876.52 ไร่ รองลงมา คือ จังหวัดหนองบัวลำภู อำเภอศรีบุญเรือง ตำบล
โนนสะอาด จำนวน 66,240.94 ไร่ และจังหวัดหนองบัวลำภู อำเภอนากลาง ตำบลฝั่งแดง จำนวน 58 ,880.83 ไร่
ตามลำดับ 

4.4.8 ดัชนี SAVI ดัชนีพืชพรรณปรับแก้หน้าดิน 

 
รูปที่ 38 แผนที่แสดงค่าดัชนีพืชพรรณปรับแก้หน้าดิน (SAVI) 
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ตารางท่ี 31 ค่าดัชนีพืชพรรณปรับแก้หน้าดิน (SAVI) แยกตามรายจังหวัด อำเภอ ตำบล 

ตารางแสดงดัชนี SAVI  ดัชนีพืชพรรณปรับแก้หน้าดิน 
ระดับท่ี 1 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
อุดรธานี วังสามหมอ ผาสุก 92,052.34 
เลย นาด้วง นาดอกคำ 73,970.63 
กาฬสินธุ์ กุฉินารายณ์ กุดหว้า 72,326.84 
ระดับท่ี 2 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ เทพสถิต นายางกลัก 78,902.01 
อุดรธานี ศรีธาตุ หัวนาคำ 69,861.15 
หนองบัวลำภู ศรีบุญเรือง โนนม่วง 68,217.36 
ระดับท่ี 3 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
เลย ภูกระดึง ศรีฐาน 120,818.70 
หนองบัวลำภู ศรีบุญเรือง โนนสะอาด 96,161.82 
เพชรบูรณ์ น้ำหนาว วังกวาง 87,942.86 
ระดับท่ี 4 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
เพชรบูรณ์ น้ำหนาว น้ำหนาว 142,187.99 
เลย ภูกระดึง ศรีฐาน 128,215.76 
ชัยภูมิ หนองบัวแดง นางแดด 115,887.32 
ระดับท่ี 5 
จังหวัด อำเภอ ตำบล พ้ืนที่ (ไร่) 
ชัยภูมิ คอนสาร ทุ่งลุยลาย 316,429.92 
ชัยภูมิ หนองบัวแดง นางแดด 304,101.48 
ชัยภูมิ หนองบัวแดง หนองบัวแดง 90,408.55 
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ผลการสำรวจพบว่า  ดัชนีวัดอุณหภูมิ (SAVI: Soil Adjusted Vegetation Index) พบในพื้นที่ศึกษาลุ่ม
น้ำชี จำนวนทั้งหมด 31,036,432.74 ไร่ โดยสามารถแบ่งตามรายจังหวัด อำเภอ ตำบล ดังนี้ 

พื้นที่ระดับที่ 1 แสดงความสมบูรณ์ของพืชพรรณมากที่สุด พบมากที่สุด คือ จังหวัดอุดรธานี อำเภอวัง
สามหมอ ตำบลผาสุก จำนวน 92,052.34 ไร่ รองลงมา คือ จังหวัดเลย อำเภอนาด้วง ตำบลนาดอกค จำนวน 
73,970.63 ไร่ และจังหวัดกาฬสินธุ์ อำเภอกุฉินารายณ์ ตำบลกุดหว้า จำนวน 72,326.83 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 2 แสดงความสมบูรณ์ของพืชพรรณมาก พบมากที่สุด คือ จังหวัดชัยภูมิ อำเภอเทพสถิต 
ตำบลนายางกลัก จำนวน 78,902.01 ไร่ รองลงมา คือ จังหวัดอุดรธานี อำเภอศรีธาตุ ตำบลหัวนาคำ จำนวน 
69,861.15 ไร่ และจังหวัดหนองบัวลำภู อำเภอศรีบุญเรือง ตำบลโนนม่วง จำนวน 68,217.36 ไร่ ตามลำดับ 

พื้นที่ระดับที่ 3 แสดงความสมบูรณ์ของพืชพรรณปานกลาง พบมากที่สุด คือ จังหวัดเลย อำเภอภูกระดึง 
ตำบลศรีฐาน จำนวน 120,818.69 ไร่ รองลงมา คือ จังหวัดหนองบัวลำภู อำเภอศรีบุญเรือง ตำบลโนนสะอาด 
จำนวน 96,161.81 ไร่ จังหวัดชัยภูมิ อำเภอหนองบัวระเหว ตำบลวังตะเฆ่ จำนวน  77,689.99 ไร่ และจังหวัด
เพชรบูรณ์ อำเภอน้ำหนาว ตำบลวังกวาง จำนวน 87,942.86 ไร่ ตามลำดับ  

พื้นที่ระดับที่ 4 แสดงความสมบูรณ์ของพืชพรรณต่ำ พบมากที่สุด จังหวัดเพชรบูรณ์ อำเภอน้ำหนาว 
ตำบลน้ำหนาว จำนวน 142,187.98 ไร่ รองลงมา คือ จังหวัดเลย อำเภอภูกระดึง ตำบลศรีฐาน จำนวน 
128,215.76 ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนางแดด จำนวน 115,887.32 ไร่ ตามลำดับ  
พื้นที่ระดับที่ 5 แสดงความสมบูรณ์ของพืชพรรณต่ำที่สุด พบมากที่สุด จังหวัดชัยภูมิ อำเภอคอนสาร ตำบลทุ่งลุย
ลาย จำนวน 316,429.91 ไร่ รองลงมา คือ จังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลนางแดด จำนวน 304,101.48 
ไร่ และจังหวัดชัยภูมิ อำเภอหนองบัวแดง ตำบลหนองบัวแดง จำนวน 90,408.54 ไร่ตามลำดับ 
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